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INTRODUCTION 

HOPEX Business Process Analysis is software edited by   MEGA International to  assist:

 Organizers in improving and redesigning enterprise business processes. 
 Quality engineers describing the business processes of their organization.

This is used to

 Description of the detailed organization of operations during execution of 
organizational processes, and the participation of each of the enterprise org-units 
in these processes. 

 Description of product or service offerings proposed by enterprise business 
processes.

 Description of enterprise value streams.
 Description of the business capabilities of the company and possibilities for their 

implementation.
 Description of the enterprise organizational chart.
 Identification of the risks linked to the enterprise processes.
 Detailing of information system requirements involved in these application 

business processes. It is then possible to draw a map of the enterprise 
organization and information system (in conjunction with HOPEX IT 
Architecture).

 The description of processes with HOPEX Business Process 
Analysis is based on the Business Process and Notation (BPMN) 
maintained by the Object Management Group (OMG).
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The following points are covered in HOPEX Business Process Analysis:

 Organizational Processes
 Business processes
 Value streams
 Business Capability Maps
 System Processes
 Organizational Charts and Responsibilities
 The customer journey
 Conversations
 Assessments With HOPEX Business Process Analysis
 Action Plans with HOPEX Business Process Analysis
 HOPEX Business Process Analysis Reports.
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Introduction
Presentation of HOPEX Business Process Analysis

PRESENTATION OF HOPEX BUSINESS PROCESS ANALYSIS

Combined with the products of HOPEX suite, HOPEX Business Process Analysis
supports a methodology and the tools used to describe your business organization
and manage change.

Because business modeling helps you:
• Explaining how your enterprise operates,
• Considering changes in the organization,
• Defining IT requirements,
• Identification of the risks linked to the enterprise processes,
• Specify collaborations with partners.

Modeling with HOPEX Business Process Analysis
HOPEX Business Process Analysis  offers tools enabling enterprise organization
description.

Describing processes
You can write comments for each process element directly from the diagram. This
offers many advantages:

• Description of each element is simpler and faster than writing the 
complete process.

• Reports can be built automatically.
• Easy retrieval of process descriptions for insertion into other processes. 
• The volume of text is significantly reduced.

Producing documents
Documents are automatically generated from the elements entered when describing
the diagram.

• The general structure is independent of the writer.
• Document generation is automatic.
• Documents have a standard layout and consistent style.
• Descriptions are automatically reused in the different documents.
• Document consistency is assured.

 You can modify the layout and formatting of documents generated 
by HOPEX Business Process Analysis and create new ones. For more 
information, see HOPEX Power Studio.

HOPEX Business Process Analysis  allows you to automatically generate an
Intranet site describing the processes used in the enterprise.
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Upgrading and maintaining your processes
As your organization evolves, so do your processes.

HOPEX Business Process Analysis allows you  to make your changes in one
location, and have them propagated to all processes involving those elements. This
allows:

• Rapid access to the elements that you want to modify.
• You can analyze impacts of modification of a process in other processes 

in which this element appears.
• You can ask for the automatic regeneration of all documents concerned.

This User Guide is designed to help you quickly discover the power of HOPEX
Business Process Analysis.

Positioning of the HOPEX Business Process Analysis solution
HOPEX Business Process Analysis can be used with other products in the
HOPEX suite.

HOPEX IT Architecture

The HOPEX IT Architecture solution provides HOPEX Business Process
Analysis with the possibilities to model the information system architecture
according to a number of analysis perspectives:

• Description of application architecture offers a detailed view of 
information exchanges between applications, services, databases and 
organizational.

• Description of information system technical infrastructure enables 
monitoring of applications deployment on the different enterprise.

• Description of complex systems involving different types of resources.

HOPEX IT Business Management 

The HOPEX IT Business Management  solution, including  HOPEX IT Portfolio
Management Product, provides  with the possibilities to support the description,
analysis and transformation projects of the IT system.

The HOPEX IT Portfolio Management Product provides  HOPEX Business
Process Analysis with:

• Aligning the application assets with business requirements;
• Reducing IS operating costs by removing applications no longer used;
• Managing technologies relating to applications;
• Identifying the business services covered by applications or application 

versions;
• Deciding on investments for maximum profits.
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THE HOPEX BUSINESS PROCESS ANALYSIS METHOD

The method embedded in the HOPEX Business Process Analysis solution is used
to perform the following tasks:

• Preparing the Work Environment
• Describing the existing organization
• Describing the existing organization
• Managing Organizational Transformation

Preparing the Work Environment

 Libraries are collections of objects used to split repository content 
into several independent parts. They allow creation of virtual partitions 
of the repository. In particular, two objects owned by different libraries 
can have the same name.

In the context of the HOPEX Business Process Analysis solution, a library can
hold all the elements of your project: processes and org-units, for example.

 For more details on managing libraries, see the "Enterprises and 
Libraries" chapter in the HOPEX Common Features guide.

To access the list of libraries from the Environment navigation pane:
 Select Standard Navigation in the navigation menu.

The repository library tree appears.

Describing the existing organization
The purpose of this step is to describe the org-units in the enterprise, its different
processes, the risks encountered as well as the associated controls. 

 An org-unit represents a person or a group of persons that 
intervenes in the enterprise business processes or information system. 
An org-unit can be internal or external to the enterprise. An internal 
org-unit is an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
org-unit is an external entity that exchanges flows with the enterprise. 
Example: customer, supplier, government office.

 A risk is a hazard of greater or lesser probability to which an 
organization is exposed.

 A control is a set of rules and means enabling the assurance that a 
legal, regulatory, internal or strategic requirement is respected.
 For further information on handling of Controls, see the HOPEX 
Risk Mapper guide.
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This consists of the following tasks:
• Describing the organization,
• Describing processes,
• Describing controls and risks.

 For more details on controls and risks, see the Managing Risks and 
Controls chapter.

Describing the organization
With HOPEX Business Process Analysis the organizational chart shows the
hierarchy of the org-units in the enterprise, their responsibilities with respect to the
processes and specifies the persons associated with each org-unit and on which site. 

Example of organizational chart:

 For more information on describing enterprise org-units, see 
Organizational Charts and Responsibilities.

Describing processes

Describing organizational processes
 An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is 
depicted as a sequence of operations, controlled by events and 
conditions.
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With HOPEX Business Process Analysis, organizational processes are described
in the form of diagrams.

In the example of the purchase request process, the 
organization is represented by the following diagram.

 For more details describing an organizational process, see 
Organizational Processes.

Business process modeling
 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
implementation of the business process in the organization. A business 
process can also be detailed by a functional view.
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The business process diagram enables representation of product or service offerings
proposed by the enterprise to each of its markets, as well as the processes that
produce these.

 For more details describing an organizational process, see Business 
processes.

Describing value streams (option)
 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.
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The following diagram presents an example of a value stream:

 For more details on value stream description, see Value streams.

Describing business capabilities and associated skills
 .A business capability is a set of features that can be made 
available by a system (an enterprise or an automated system).

 A business skill is a capability acquired by a person or an 
organization through a specific training.

This step consists, on the one hand, in defining what the enterprise can deliver
(business capabilities), and on the other hand, how to it delivers it. For each
business capability, you must define the necessary skills and required
functionalities.

 For more details on the use of business capabilities, see Business 
Capability Maps.

Risk Management

The HOPEX Risk Mapper product provides HOPEX Business Process Analysis
with the possibility to manage risks and controls with the processes described.

 For more details on controls and risks, see the Managing Risks and 
Controls chapter.
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Building customer journeys
The  HOPEX Customer Journey Product is used to represent the acquisition
process of a product or a service by a specific customer. Mapping a customer
journey provides an overview of customer expectations, painpoints encountered,
and the resources used at each step of the journey. Last but not least, touchpoints,
which are the points of interaction between the customer and the company, are
used to measure and improve overall customer satisfaction.

 A customer journey is used to describe and organize all interactions 
between the enterprise and a persona for a given result.

 A persona corresponds to a customer segment targeted by the 
experience of the client journey. The resources implemented to give 
customers the ability to interact with the enterprise and its 
environment, to acquire the expected results, are supported by the 
interaction channels.

Representing a customer journey will allow you to easily identify these critical
points. HOPEX Customer Journey is used to describe solutions for improvement
and to assess them at different dates.

 For more details on the description of workspaces, see The 
customer journey.

Simulating BPMN Processes
Complementing HOPEX Business Process Analysis, HOPEX Process
Simulation product assists organizers and decision-makers in:

• Analyzing enterprise process performances.
• Improving existing processes or evolving processes.

HOPEX Process Simulation is used to:
• Describe the detailed organization of operations during execution of 

organizational or system processes, and the use of company resources 
by these processes.

• Associate quantitative information (processing time, costs) with 
operations executed and resources used.

• Creation of several optimization scenarios to build a comparative 
performance analysis of the different configurations.

 Simulation of processes described using BPMN formalism is only 
available with HOPEX Process Simulation.
 For more details on the use of simulation functionalities, see 
Simulating a BPMN process.

Using the Process Mining
Process Mining is an approach that consists of analyzing files that trace the
execution of a process: start and end dates of completed tasks, identification of
resources used, identification of the activity in progress, routing of steps.
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Depending on the quality of the trace files, this analysis can provide information
such as:

• The list of executed tasks and the average duration of each execution,
• Routing information: probability of activation of a task from another task.

From a trace file, a Process Mining tool is thus able to provide the BPMN
representation of the executed process as well as information about routing
probabilities and execution times. This information can be imported and analyzed
by HOPEX Process Simulation.

 For more details, see Using the Process Mining with HOPEX Process 
Simulation.

Managing Organizational Transformation
The purpose of this step is to prepare for the transformation of your enterprise.

Given the products in the Suite HOPEX available to you, you can manage the
transformation of your enterprise in a number of different ways:

• Using process portfolios.
• Managing Action Plans.
• Describing the project portfolios
• Documenting projects implemented in SAP

Using process portfolios
 A portfolio enables representation of all investments of an 
enterprise (or department) necessary to carry out changes required to 
achieve strategic objectives. It comprises a set of initiatives to be 
compared based on comparison criteria associated with the portfolio.

Through the management of process portfolios, the HOPEX Portfolio & Planning
product makes it possible to plan the evolution of the company's organizations over
time as described with HOPEX Business Process Analysis. 

From Projects > Process Portfolios, you can access the features available with
HOPEX Business Process Analysis to manage portfolios.

 For more details, see Describing a Process Portfolio.

Managing Action Plans
 An action plan comprises a series of actions, its objective being to 
reduce risks and events that have a negative impact on company 
activities.

HOPEX Business Process Analysis allows you to specify, implement and follow
up action plans defined for remediating, for example, a process or a customer
journey.

From Projects > Corrective Action Plans, you can access the facilities to describe
and manage action plans.

 For more information on use of action plans, see Action Plans with 
HOPEX Business Process Analysis.
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Describing the project portfolios
Project portfolio management is an approach used by an organization to analyze the
potential return of a set of projects. Its primary aims are to:

• Control the suitability of projects with respect to the strategic objectives 
of the organization;

• Ensure consistency between the projects and the organization's 
capability.

From Projects > Project Portfolios, you can access the project list.
 For further information on handling projects, see the HOPEX IT 
Business Management  guide.

Documenting projects implemented in SAP
From Projects > Solution Manager 7.2, you can access the features proposed
with the HOPEX for SAP Solution Manager 7.2 product.

 For more information, see HOPEX for SAP Solution Manager 
7.2.

Using Workflows
With HOPEX Business Process Analysis you can use standard workflows to
manage:

• Requests For Change;
 For more details on Requests For Change workflows, see “Using 
Requests For Change” in  HOPEX Common Features guide.

• Review requests.
 For more details on the review process, see Appendix - HOPEX 
Business Process Analysis Workflow.
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CONNECTING TO HOPEX BUSINESS PROCESS ANALYSIS

The menus and commands available in HOPEX Business Process Analysis
depend on the profile with which you are connected.

Connecting to HOPEX Business Process Analysis
To connect to HOPEX Business Process Analysis, see HOPEX Web Front-End
Desktop” chapter in   HOPEX Common Features guide.

HOPEX Business Process Analysis Profiles
In HOPEX Business Process Analysis,there are profiles associated to specific
activities. 
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Presentation of the solution interface depends on the profile selected by the user on
connection to the application; the tree of menus and functions varies from one
business role to another.

 For more details on the Desktops connected to each of the profiles, 
see HOPEX Business Process Analysis Desktop Presentation.

 The digital transformation architect is the business user profile 
of the HOPEX Digital Transformation Desktop. 

Profiles Tasks

Process Functional Administrator In addition to the functional rights of the Process Manager, the 
Process Functional Administrator has rights to all objects, 
methods, projects and workflows.
Prepares the work environment and creates elements required 
for management of process.
He manages:
- Users, assignment of roles and access rights to the different 
project steps.
- All environment objects (processes, customer journeys, 
reports, etc.),
- Workflows.
For more details, see Presenting the Process Functional Admin-
istrator space.

Process Manager The Process Manager has rights to all objects, methods, proj-
ects and assessments.
She/he is responsible for identifying the risks associated with 
the organizational process models entrusted to him/her. She/
he has the same rights as the risk designer.
For more details, see Presenting the Process Manager space. 

Process Viewer Lite The Process Viewer Lite has read-only rights on objects in the 
repository. She/he limited to the use of collaborative tools.
For more details, see Presenting the Process Observer Lite 
space.

Process Contributor Lite The Process Contributor Lite has the same rights as the Process 
Viewer Lite. In addition to the Process Viewer, the Process Con-
tributor is allowed to create objects and tabular entry dia-
grams.
For more details, see Presenting the Process Contributor Lite 
space.
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Business Roles of HOPEX Business Process Analysis
In HOPEX Business Process Analysis, there are, by default, business roles that
can be assigned to certain users. These roles are:

• Org-Unit Designer to assign a user to org-units of the organization. 
The Org-Unit Designer is responsible for managing the processes 
assigned to him/her.

• Organizational Process Designer to assign a user to organizational 
processes. The Organization Process Designer is responsible for 
designing the processes assigned to him/her.

• Business Process Designer to assign a user to functional processes. 
The Business Process Designer is responsible for designing the processes 
assigned to him/her.

• Value streams Designer to assign a user to value streams. The Value 
streams Designer is responsible for designing the value streams assigned 
to him/her.

• Process Portfolio Manager to assign a user to process portfolios. The 
Portfolio Manager is responsible for managing the portfolios assigned to 
him/her.

• Organizational Process Owner to assign a user to organizational 
processes. The Organization Process Owner is responsible for the 
following tasks:
• Identifies risks
• Responding to Questionnaires
• Defining and implementing action plans,
• Validating the modifications made by the organizational process 

designer in the context review workflows.
• Business Process Owner to assign a user to functional processes. The 

Business Process Owner is responsible for the following tasks:
• Identifies risks
• Responding to Questionnaires
• Defining and implementing action plans,
• Validating modifications made by the Business Process Designer the 

context review workflows.

HOPEX Business Process Analysis Desktop Presentation
The menus and commands available in HOPEX Business Process Analysis
depend on the profile with which you are connected.

 For more details on using the Web platform for HOPEX solutions, 
see the HOPEX Common Features guide.
 HOPEX Business Process Analysis is mainly intended for web 
users. Desktops described in this guide are accessible to Web desktop 
users.
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Presentation of space common to all profiles
All users have access to the HOPEX Business Process Analysis desktop and
access to the following panes:

• Home: presents the main tiles useful for the user.
• Dashboards: displays the list of indicators required to steer objects 

such as processes, applications or org-units.
• Bold BI Dashboards: displays the list of dashboards build with the 

Bold BI application.
 For more details, see Customizing Bold BI dashboards.

• Capabilities access to all business capabilities and functionalities.
• Processes: gives access to all the process models described.
• Simulation : gives access to the facilities for simulation and process 

mining, iIf you have the HOPEX Process Simulation product.
 For more details, see Simulating a BPMN process.

• Customer Journey: gives access to the mapping of the customer 
journey if you have the HOPEX Customer Journey product.

 For more details, see The customer journey.

• Reports: accesses all reports, improving understanding of terms and 
their use.

 For more details on the use of these reports, see "Generating 
Reports” chapter in HOPEX Common Features guide.
 For more details, see HOPEX Business Process Analysis Reports.

• Collaboration, which enables access to all collaborative tools provided 
by HOPEX.

 For more details on the use of collaborative tools, see  "Accessing 
collaboration in HOPEX" chapter in the HOPEX Common Features 
guide .

The tiles of the Home space of HOPEX Business Process Analysis are:

• Help  to access the HOPEX documentation.

• Option  to access to HOPEX options.

 For more details, see Summary of HOPEX Business Process Analysis 
options.

• A add tile button .

 See “Adding a tile to your home page” chapter in HOPEX Common 
Features guide.
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Presenting the Process Functional Administrator space 
In addition to the panes offered in standard mode to all HOPEX Business Process
Analysis desktop users, the users connected with the Process Manager profile
have access to the following panes:

The Home pane

The Home pane enabling access to specific functions.

The New Diagram tile is used to create a new organizational Process and its
diagram.

 For more details, see Managing an Organizational Process Diagram.
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New Idea  tile helps to create a new idea.

 For more details on managing ideas and projects, see "Submitting 
and evaluating ideas” in HOPEX Common Features guide.

The Capabilities pane

The Capabilities pane provides access to the following menus.
• Hierarchy View, to access all the elements  to describe and manage the 

Business Capabilities of the enterprise.
 For more details, see Business Capability Maps.

• Business Capability Maps, to detail the company's business 
capabilities.

 For more details, see Describing Business Capabilities with HOPEX 
Business Process Analysis.

• Business Skill Maps, to detail the company's business skills.
 For more details, see Describing the business skill map.

• Functionality Maps, to detail the company's functionalities.
 For more details, see Describing the Functionality Map.

The Processes pane

The Processes pane provides access to the following menus.
• Hierarchy , to access to the follwing elements:

• the enterprise org_units, see Organizational Charts and 
Responsibilities,

• business and organizational processes, see Organizational Processes 
and Business processes.

• applications,
• sites

• Controls & Risks, for accessing the risk management features offered 
with the HOPEX Risk Mapper product.

 For more details on controls and risks, see the Managing Risks and 
Controls chapter.

• Data Management to access the management functionalities for 
business data offered with the HOPEX Information Architecture 
product.
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The Simulation pane

The Simulation pane gives access to the process simulation functionalities
proposed with the HOPEX Process Simulation product . This pane proposes the
following menus:

• Simulation Scenarios, to access the list of the results of the 
simulations performed in different configurations.

• Schedules, to access resource load and availability schedules.
 For an introduction to simulation functionalities, see Simulating 
BPMN Processes.

The Customer Journey pane

If you have the HOPEX Customer Journey product, the Customer Journey pane
gives access to the mapping of the customer journey.

 For more details, see The customer journey.

The Projects pane

The Project pane provides access to transformation project management
functionalities. Depending on the products that you possess, this pane provides
access to the following menus.

• Process Portfolios, to access the portfolio management features 
offered with product HOPEX Portfolio & Planning.

 For more details on portfolio, see Using process portfolios.

• Corrective Action Plans, to describe and manage the action plans 
linked to the transformation of processes.

 For more details, see Action Plans with HOPEX Business Process 
Analysis.

• Projects, to access and manage transformation projects.
 For further information on handling transformation projects 
transformation, see the HOPEX IT Business Management  guide.

• Project Portfolios, to access the project portfolio management 
functionalities offered with the HOPEX IT Portfolio Management 
product.

 For more information, see HOPEX IT Business Management .

• Solution Manager , to access the features offered with the HOPEX for 
SAP Solution Manager 7.2 product.

 For more information, see HOPEX for SAP Solution Manager 
7.2.

The Continuity pane

The Continuity pane, available with the HOPEX BCM product,  provides access to
the following Business Continuity Management facilities.

 For more information on Business Continuity Management, see the 
HOPEX BCM guide.
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The Assessment pane

The Assessment pane provides access to the creation and management of
assessment campaigns.

 For more details on on managing assessment Campaigns, see 
“Evaluation By Campaign assessment sessions” chapter in  guide 
HOPEX Common Features.
 For more details on process assessment, see Assessments With 
HOPEX Business Process Analysis.

The Environment pane

The Environment pane provides access to the following menus.
• Standard Navigation, to access the main objects processed with the 

HOPEX Business Process Analysis solution.
 For more details, see Preparing the Work Environment.

• Indicators, to access to the key indicators of your repository.
 For more information on key indicators, see HOPEX IRM.

The Administration pane

The Administration pane provides access to the user management features. The
rights of different users on objects of imported libraries depend on their assigned
profiles.

 For more details on the management users, see "Managing users" 
chapter in  guide HOPEX Common Features.

Presenting the Process Manager space
Excepted the Administration pane, users connected with the Process Manager
profile have access to the same functionalities as users connected with the Process
Functional Administrator profile.

 For more details, see Presenting the Process Functional 
Administrator space.
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Presenting the Process Contributor Lite space
Users connected with the Process Contributor Lite profile have access to the
panes offered in standard mode to all users of the HOPEX Business Process
Analysis desktop.

The Process contributor Lite works in the simplified desktop of , she/he is
responsible for validating the design of the processes entrusted to him/her.

Presenting the Process Observer Lite space
Users connected with the Applications Viewer Lite profile have access to the
panes offered in standard mode to all users of the HOPEX Business Process
Analysis desktop.
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The Process Viewer Lite works in the simplified desktop of HOPEX Explorer, she/
he has read-only rights on objects in the repository.

Prerequisites to using APQC libraries
If you want to use APQC business processes for the different activity sectors, you
must import the dedicated modules in your environment.

 A report allows you to view APQC value chains. For more details, 
see APQC Value Chain Analysis.

For import a module in HOPEX, see “Importing a module in HOPEX” chapter in the
HOPEX Administration guide.

Customizing Bold BI dashboards
The Bold BI Dashboard navigation pane is used to display the dashboards of your
environment that have been customized using the Bold BI web application.

 The Bold BI web application is available in a module provided on 
the HOPEX Store. This application allows you to customize your 
dashboards.

For example, the following dashboards are provided to illustrate this feature:
• Percentage of business processes described by a diagram;
• Historic of business processes diagrams creation;
• Number of business processes by risk level;
• Treemaps about:

• Number of risks per business process,
• Number of applications per business process,
• Business process hierarchy.

• Assessment heatmap.

Standard Bold BI dashboards provided with HOPEX Business Process Analysis
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Summary of HOPEX Business Process Analysis options
Some options enable you to manage the access to different types of process.

To activate these options:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Depending on features you want to do, you may select one of the 

following check boxes.
• Display of “Realized steps” tab for a participant, see Creating an 

Operation on a Participant,
• Management of RACI in BPMN and Automatic synchronization 

of RACI by means of participants, see Process responsibilities,
• Risk Modeling MEGA 2009 /Risk Modeling HOPEX, see HOPEX 

Risk Mapper guide.
• Quality Modeling, see Managing Quality,
• Business Function modeling and Value streams modeling, see 

Value streams,
• Business Process modeling, see  Business processes,
• System Process modeling, see Using a system process in a 

Business process diagram,
• Capability Visibility, see Business Capability Maps,
• Activate former BPMN data stores (HOPEX V3 and lower) / 

Activate BPMN data stores for conceptual, logical and physical 
layers (from HOPEX V3.1), see Using Data Stores.

• Use of contextualizations, see Representing Process 
Contextualization,

• Activate the menu “Implementation Projects” (Hopex V3.2 and 
lower), this menu can be accessed from the Projects navigation pane.

 For more details, see "Enterprise Architecture (EA) projects in 
HOPEX” in the HOPEX Common Features guide.
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ABOUT THIS GUIDE

This guide presents how to make best use of HOPEX Business Process Analysis
to assure efficient management of your modeling projects.

Guide Structure
The HOPEX Business Process Analysis guide comprises the following chapters:

• Organizational Processes presents how to define participants and the 
sequence flow of operations of an organizational process.

• Business processes chapter presents how to specify enterprise product 
and service offerings, and the breakdown of the processes producing 
these.

• Value streams describes the representation of enterprise value streams 
in terms of activities. It enables freeing from the existing organization to 
imagine new organization solutions for your processes.

• Business Capability Maps chapter, presents  our method for analysis of 
the business capabilities of your enterprise, checking their suitability with 
your business functions and skills.

• System Processes describes the IT process required for implementation 
of an organizational process by sequencing tasks executed.

• Organizational Charts and Responsibilitieschapter describes how to 
create an enterprise organizational chart and how to define 
responsibilities of persons and org-units.

• The Assessments With HOPEX Business Process Analysis chapter 
describes how to assess the execution and performance of business and 
organizational processes with HOPEX Business Process Analysis.

• The  The customer journey chapter is used to represent the acquisition 
process of a product or a service by a specific customer.

• The Action Plans with HOPEX Business Process Analysis chapter 
describes how to use the action plans with HOPEX Business Process 
Analysis.

• The Conversations chapter explains how to model conversations between 
process architecture components.

• Managing Quality chapter, presents functions that simplify creation and 
maintenance of a quality system conforming to ISO 9000.

• Describing a Process Portfolio chapter, presents  functionalities that 
enable planning over time the evolution of enterprise organizations.

• The chapter Simulating a BPMN process presents functionalities that 
simulate the execution of a process in order to evaluate the processing 
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time of the different tasks as well as the occupation rate of the resources 
that carry out these tasks.

• HOPEX Business Process Analysis Reports,  presents reports proposed by 
HOPEX Business Process Analysis to assist users at each step of 
architecture description and analysis projects.

• TheAppendix - HOPEX Business Process Analysis Workflow chapter 
presents the workflow diagrams of HOPEX Business Process 
Analysis.

Additional Resources
This guide is supplemented by:

• The HOPEX Common Features guide describes the basic functions 
common to HOPEX products and solutions.

 It can be useful to consult this guide for a general presentation of 
the interface.

• The  HOPEX IT Portfolio Management, guide, which describes 
functions proposed to manage all your applications;

• The HOPEX Power Supervisor administration guide.
• More advanced technical functions are described in the HOPEX Power 

Studio guide.

Conventions used in the guide

 Remark on the preceding points.

 Definition of terms used.

 A tip that may simplify things.

 Compatibility with previous versions.

 Things you must not do.

Commands are presented as seen here: File > Open.

Names of products and technical modules are presented in bold as seen here:
HOPEX.

Very important remark to avoid errors during an operation.
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ORGANIZATIONAL PROCESSES

The aim of this chapter is to familiarize you with HOPEX Business Process Analysis: it introduces
a few features of the software dedicated to organizational process modeling activities.

 For more details on management of your desktop, and of diagrams 
and objects, see the HOPEX Common Features guide.

An organizational process is a set of operations performed by org-units within a company or
organization, to produce a result. It is depicted as a sequence of operations, controlled by events
and conditions.

With HOPEX Business Process Analysis, an organizational process representation is based on
the standard BPMN (Business Process Modeling Notation) offering notation easily used by all
participants concerned. 

The points covered here are:

 Organizational Process Example
 Managing an Organizational Processes
 Defining Participants
 Creating Operations
 Describing Operations Sequence Flows
 Defining Message Flows
 Defining Process Events
 Using Shared Objects
 Using Gateways
 Import an Organizational Process from Excel
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ORGANIZATIONAL PROCESS EXAMPLE

In the example of the purchase request process, the organization is represented by
the following diagram.

The purchase request is received by a purchasing assistant, 
who enters the request and submits this for the approval of 
the purchasing manager. 
If the request is rejected, the purchasing manager informs 
the requester. 
If the request is approved, the assistant sends a completed 
request to buyers responsible for issuing the order, and 
sends a confirmation message to the requester.

This chapter explains how to use the main objects presented in this diagram.
• The frame containing the different components represents the 

organizational process described by the diagram. Its name "Process 
Purchase Request" appears in the box at top left.

 An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is 
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depicted as a sequence of operations, controlled by events and 
conditions.

• The participants in execution of this process are org-units. They are 
represented in columns for reasons of diagram readability. For more 
details, see Defining Participants.

 A participant (org-unit) enables representation of org-units 
assigned to execute a group of process operations.

 An org-unit represents a person or a group of persons that 
intervenes in the enterprise business processes or information system. 
An org-unit can be internal or external to the enterprise. An internal 
org-unit is an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
org-unit is an external entity that exchanges flows with the enterprise. 
Example: customer, supplier, government office.

• The different steps in this process are operations. Organization of these 
steps is described by sequence flows.

 An operation is an elementary step in an organizational process 
executed by an org-unit. It cannot be broken down. An operation can be 
industrial (manufacturing a component), logistical (receiving a 
delivery), or can involve information processing (entering an order).

• Message flows enable representation of data or information circulating 
between a process and the exterior.

 A message flow represents circulation of information within an 
exchange contract. A message flow transports its content.
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 MANAGING AN ORGANIZATIONAL PROCESSES

This section explains how to describe your work context and describe an
organizational process.

 An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is 
depicted as a sequence of operations, controlled by events and 
conditions.

Creating an Organizational Process
To create an organizational process from the Processes navigation pane: 

1. Select Hierarchy.
2. Select the Organizational process folder, click New > Organizational 

process.
The creation dialog box of the organizational process opens.

3. Modify the name of the organizational process.
4. Specify the Owner.
5. Click OK.

The organizational process appears in the list.

 Managing an Organizational Process Diagram 
An organizational process diagram can be created and updated in tabular input
mode.



 For more information on using tabular entry, see the "Entering a 
diagram in tabular mode" in the HOPEX Common Features guide.

Creating an Organizational Process Diagram

To create an organizational process diagram:
1. Right-click the organizational process name and select New > Diagram.

The Diagram type selection dialog box opens.
2. Select Organizational Process Diagram.
3. (Optional) Uncheck the Diagram Initialization box.
4. In the Edit Mode section, select Edit diagram with graphical entry.
5. Click OK.

The diagram opens in the edit area. You are now in the HOPEX graphic
editor. The frame of the described organizational process appears in the
diagram.
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Accessing an Organizational Process Diagram

To access an organizational process diagram:
1. Right-click the process to open its pop-up menu.
2. Select Organizational Process Diagram.

The diagram opens in the edit area.
 If the process does not have a diagram, you can create it by 
clicking New > Diagram in its pop-up menu, then by selecting 
Organizational Process Diagram.

Comparing an organizational process diagrams

You can compare several diagram versions of the same process.
 For more details on comparison of process diagrams, see 
Comparaison de diagrammes BPMN.

You can also compare the diagrams of independant processes.
 For more details on the comparison of independent processes 
diagram, see Conformité de diagrammes de processus.

Creating an organizational process from a sketch

You can create an organizational processes and its diagram from a sketch.
 For more details on the sketching use, see the HOPEX Common 
Features guide.

To create an organizational processes and its diagram from a sketch:
1. Open the Characteristics property page of the sketch that interests 

you.
2. Click the Convert in process button.

The process diagram created from the sketching diagram opens in the edit
window.

The organizational process diagram building principles are:

• A rectangle  is converted into an operation, see Creating 
Operations;

• A sketching link is converted into a sequence flow, see Describing 
Operations Sequence Flows;

• A rhombus  is converted into a gateway, see Using Gateways;

• A circle  is converted into start or end event depending on the link 
with the operation direction, see Defining Process Events;

• A barrel  is not converted;
• A folded corner rectangle  is not converted.

The name of the created organizational process is the sketch name.

The name of each organizational process component is the corresponding sketching
item name.
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Organizational Process Diagram initialization
By default, with HOPEX Business Process Analysis, the BPMN diagram is
initialized with the current process, represented by a frame; Start and End events
are added in the frame as well as input and output gates.
Example of an Organizational Process Diagram

Advanced option for Organizational Process Diagram initialization

If the organizational process is represented in a higher level diagram, the diagram
can be initialized taking into account participants and flows that are represented in
the higher level diagram. A note provides the name of the diagram from which the
new diagram has been initialized.

 After reading this note, you can remove it.

At least, if the process owns components connected by sequence flows, internal and
external participants connected by flows, systems used and data stores, each new
diagram can be initialized with these components displayed at the top of the frame
on the left of the diagram. 

To activate this advances initialization option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, Compatibility > Diagrams. 
3. Confirm that Initialization of the BPMN process diagrams as with 

MEGA 2009 SP5 box is checked.



45

Organizational Processes
Managing an Organizational Processes

Reorganizing an Organizational Process diagram
When editing an Organizational Process diagram, the following buttons help you
reorganize the diagram.

• BPMN Vertical Diagram enables to arrange vertically the diagram 

elements ( ),
• BPMN horizontal Diagram enables to arrange horizontally the diagram 

elements ( ).

Diagram Reorganization thresholds 

Diagram reorganization may take several minutes to proceed for complex diagrams. 
• By default, a warning appears if there are more than 50 Sequence Flows 

in the diagram. The user has to confirm whether he/she wants to 
proceed with diagram reorganization. 

 If need be, you can modify this value with the user option Number 
of links that requires confirmation for automatic reorganization 
via the Main Menu > Settings > Options > Diagrams > Display.

• By default, it is not possible to use automatic reorganization if there are 
more than 100 Sequence Flows in the diagram. 

 If need be, you can modify this value with the user option 
Maximum number of links for automatic reorganization via the 
Main Menu > Settings > Options > Diagrams > Display.

Accessing organizational process properties
The properties of the different business processes available in HOPEX Business
Process Analysis depend on the profile with which you are connected and the
products that you possess.
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Organizational Process characteristics
The Characteristics page of the properties of a process is divided into different
sections:

• The Identification section of the properties page for a process provides 
access to:
• its Name,
• its Owner, by default on creation of the process, it is held by the 

default library.
 For more details on libraries, see Preparing the Work Environment.

• its Code,
• its update State,

 For more details on process statuses, see Organizational Process 
review workflow.

• the text of its Description.
• The Responsibilities section enables to identify all persons concerned 

by the process description depending on their role.
• The Components section enables to access all organizational processes 

and operations that that contribute to the organizational process 
execution.

• The System Used section enables to access the list of elements used by 
the process and to create new elements.

 For more details, see Modeling the Systems Used.

• The Details section enables access to process type, for more details, see 
Task type.

• The Controls et Risks section enables business and IT managers to 
guarantee traceability of compliance controls via application layers, data 
and infrastructures. 

 A risk is a hazard of greater or lesser probability to which an 
organization is exposed.

 A control is a set of rules and means enabling the assurance that a 
legal, regulatory, internal or strategic requirement is respected.
 For more details on controls, see the HOPEX Risk Mapper guide.

• The Attachments section enables to access all documents dedicated the 
described process.

• The Word Report section enables creation of word reports of the 
described process.

 For more details, see Creating the documentation of an 
organizational process.
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The property pages of an organizational process
With HOPEX Business Process Analysis a process is described by the following
properties:

• the Assessment page that is used to access the different possibilities for 
assessing the process.

 For more details, see Assessments With HOPEX Business Process 
Analysis.

• Simulation page, used to access to simulation and Process Mining 
facilities offered by  HOPEX Process Simulation.

 For more details, see Simulating a BPMN process.

• Action Plans page, used to access the action on the process.
 For more details, see Action Plans with HOPEX Business Process 
Analysis.

• Quality page, allows to enter quality characteristics specific to the 
process.

 For more details, see Managing Quality.

• Reports page, used to access the different reports available on the 
process.

 For more details, see HOPEX Business Process Analysis Reports.

Organizational Process variations
The system of variations enables the creation of an alternative view of an object or
model. This alternative view enables follow-up of application updates over time. 

 To create variations, in the HOPEX options window, you must click 
HOPEX Solutions > Common Features, and, in the right pane of the 
window, select the Activate Variations check box.

To create the Variation of an organizational process:
1. Right-click the object and select Variation > New Variant.

A variation creation wizard appears.
By default:
• The Variation (or variant object) takes the name of the varied object, 

with extension v2.0.
• Attributes and diagrams are copied.

 For diagrams, the described object is not copied (it is a variation of 
the described object).
 You can choose to not copy attributes and diagrams. To do this, 
clear the check boxes  Attributes Initialization and/or Diagrams 
Initialization.

2. Click OK.
The variant organizational process appears in the General > Variations
property page of the organizational process.

 For more details on Variation, see chapter "Using Variations" in the 
HOPEX Common Features guide.
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Creating the documentation of an organizational process
HOPEX allows you to create MS Word documentation of organizational processes.

 For more details on the use Word Documents, see "Managing MS 
Word Reports" chapter in the  HOPEX Common Features guide.

The report (MS Word) is generated. The report appears in the Word Reports sub-
tab of Characteristics property page of the organizational process.
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DEFINING PARTICIPANTS

 A participant defines a partition of the actions of a process that will 
be assigned to a same agent.

A participant enables:
• Assignment of a group of operations to one or to several enterprise org-

units.
• Representation of a unit external to the process with which the process 

communicates by means of message flows.

Organizational process participants may be associated to different object types, but
org-units are privileged.

 An org-unit represents a person or a group of persons that 
intervenes in the enterprise business processes or information system. 
An org-unit can be internal or external to the enterprise. An internal 
org-unit is an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
org-unit is an external entity that exchanges flows with the enterprise. 
Example: customer, supplier, government office.
 You can also use the Assignment section of the Characteristic 
property page of a participant to connect new or existing objects of 
different types to the participant.

Using Participants

 A participant defines a partition of the actions of a process that will 
be assigned to a same agent.

Example of participants

The drawing of participants in diagrams is based on pools.
 For more details one the use of pools, see chapter “Using the Pools: 
Improving Graphical Presentation”  HOPEX Common Features guide.

Creating a Participant (Org-Unit )
 A participant (org-unit) enables representation of org-units 
assigned to execute a group of process operations.
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Org-units, either new or already created, can be assigned to participants of a
process.

Example: The "Analyze Purchase Request" operation in the 
"Process Purchase Request" process, handled by the 
Purchasing Manager, is assigned to the Purchasing Assistant 
when the manager is absent. To represent this, we assign 
org-units "Purchasing Manager" and "Purchasing Assistant" 
org-units to the same participant.

To create a participant (Org-Unit) in an organizational process diagram:

1. Click the arrow at the right of the participant (org-unit)  button in 
the insert toolbar. 

2. Click within the organizational process frame. 
The Creation of Participant- Assignment wizard opens.

3. In the Org-Unit field, select the org-units you wish to assign to the 
participant.

4. Click the Next button.
The Creation of Participant - Assignment wizard allows you to modify
the list of selected actors.

5. Click OK.
The participant is positioned in the diagram. If you have not specified a
name, it will carry the name of the assigned org-unit.

 To hide the name of the participant, open its pop-up menu and 
select Shapes and Details. In the tree on the left, click the "Short 
Name" folder, then in the Content tab, clear the Short Name check 
box.

Creating a Participant
To create an org-unit participating in execution of a process:

1. In the diagram insert toolbar, click the Participant (Org-Unit) > 
Participant  button.

2. Click in the diagram within the organizational process frame. 
The participant appears in the diagram.

3. Click the "Participant" name and press key <F2> to modify the name of 
the participant.

Assigning an object to a participant
You can assign an existing object to a participant, for example an org-unit.

To assign an org-unit to an existing participant:
1. Click in the participant frame.

An icon appears toAdd an assignment.

2. Click the Add an assignment icon. 
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3. Select the name of th eobjects you wish to assign to the participant.
 You can also use the participant pop-up menu and select Connect 
> Org-Unit. The connect wizard appears.
 You can also use the Assignment section of the Characteristic 
property page of to connect new or existing objects to the participant

Conditioning the assignment of an object to a participant
To condition participation of an org-unit:

1. Open the Characteristics property page of the Participant.
2. In the Assignment section, select the line of the org-unit of which you 

wish to condition assignment.
3. Click in the Conditioning column.
4. Enter the text of the condition.

The text of the condition appears between brackets alongside the name
of the org-unit in the participant title bar.
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CREATING OPERATIONS

An operation is an important step in an organizational process. For steps requiring
greater detail, organizational processes can be used.

Creating an Operation on a Participant
To create an operation and connect it to the participant responsible for its execution:

1. Click on the Operation  button of the Insert toolbar.
2. Click in the diagram within the shape of the participant concerned.

The operation is automatically created. 

To assign an operation to another participant:
 Select the operation and move it from one participant to the other.

 When  positioned, the operation is disconnected from the initial 
participant and reconnected to the new participant executing the 
operation.

Operations example
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Specifying operation behavior
Complying with BPMN standard, a process can have different behaviors. With
HOPEX Business Process Analysis, these behaviors are available for
organizational processes, operations, system processes and tasks. 

Behaviors
Behaviors proposed are:

• Transaction: a transaction is a set of coordinated activities leading to a 
consistent, and verifiable outcome.

• Loop: a loop is a process step that is repeated as long as a condition is 
true. 
• "Do while": the condition is evaluated before the first execution.
• "Do until": the condition is evaluated after the first execution. In this 

case, the process step is executed at least once.
The predicate enables specification of the loop execution condition.

• Ad hoc: steps of an ad hoc process are not controlled or sequenced in a 
particular order. Their performance is determined by the performers of 
the process.

• Multiple: the process is repeated a predefined number of times, 
evaluated only once before it is carried out. Execution type can be 
specified:
• "Parallel": all executions carried out simultaneously. 
• "Sequential": executions carried out one after the other.

• Compensation: a compensation defines the set of activities that are 
performed during the roll-back of a transaction to compensate for 
activities that were performed during the normal flow of the process.

To describe for example that a system process is executed by a loop:
1. Open the Characteristics property page of the process.
2. In the Details section, in the Loop field, select the loop type 

corresponding to the process behavior and add the condition text.
Shape of the process is modified to display the symbol of the loop.

Task type
To specify the type of a task:

1. Open the Characteristics property page of the process.
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2. In the Details section, click the arrow at the right of the Task Type box.
A list of task types appears.
• Call Process: task used to call a second process while executing the 

current process.
• Receive: elementary task which waits for arrival of a message from a 

participant external to the process. When the message has been 
received, the task is completed.

• Send: task that sends a message to a participant external to the 
process. When the message has been sent, the task is completed.

• Manual: task executed without the help of a automatic execution 
engine of a process or IT application.

• Business Rule: execution task of a business rule with a rules engine 
which processes input data and returns calculation results.

• Script: task executed by a process execution engine. The designer 
defines a script in a language that the engine is able to interpret. 
When the task is ready to start, the engine executes the script. The 
task is completed when script execution is completed.

 Shape of the process is modified to display the symbol associated 
with the task type.

Calling an Organizational Process in an Operation
You can create an operation that calls an organizational process. This functionality
enables, for example, replacement of the process called by another process without
disturbing description of the main process.

To create an operation that calls an organizational process:

1. Click the arrow at the right of the Operation  button and select 
Called Organizational Process.

2. Click in the diagram within the shape of the participant responsible for its 
execution.
A creation dialog box opens.

3. In the Organizational Process field, select the name of the called 
process.

In our example, "Process Purchase Request" could be 
replaced by "Process Urgent Purchase Request".

 By default, the operation carries the same name as the 
organization process called.

4. Click OK.
The operation appears in the diagram with the name of the organizational
process.
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Modeling the Systems Used

 A system used during the execution of a step of a process 
represents what is necessary to realize this step. It can be an 
application or an IT service, or any other non IT resource, or more 
generally a functionality.

A System Used can be of several types:
• An IT service,

 An IT service is a software component of an application, that can’t 
be deployed alone and that realizes a sub-set of the functionalities of 
this application either for end users of this application or inside the 
application (or another application). This includes batch programs.

• An application,

 An application is a software component that can be deployed and 
provides users with a set of functionalities.

• A functionality,

 A technical functionality is a capability expected from an equipment 
item (hardware or software) to ensure the operation of a technical 
element or an application.

• A resource.

 A resource is a means used to perform certain actions.

System used Example
We can define a new organizational process for processing of urgent purchase
requests, in which responsibilities of the purchasing assistant are extended.
However, the assistant is using an application.

"Process Purchase Request" Organizational Process

The purchasing department begins by analyzing the purchase 
request. Is product in stock? A request for availability is 
put forth.
To analyze the purchase request and send the order, the 
purchasing assistant requires data on stock levels. He will 
have access to the "Equipment Purchasing" application.
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Creating a System Used in an organizational process diagram
 You can see the systems used by the operations by selecting 
"System used" in the window opened from the "Views and Details”   
button.

To create a system used representing the use of the application by the
organizational process:

1. Click the arrow at the right of the System Used button and select 
Application Used.

2. Click in the diagram.
A creation dialog box opens.

3. In the Application field, select the applications you want to use.
4. Click OK.

The system used is positioned in the diagram. 
5. Use the link button to connect the system used you have created to an 

organizational process or an operation.
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DESCRIBING OPERATIONS SEQUENCE FLOWS

A sequence flow is a directional link that represents the chronological organization
of the different processing steps.

 A sequence flow is used to show the order in which steps of an 
exchange contract will be performed. A sequence flow has only one 
source and only one target.

Creating Sequence Flows
To create a sequence flow between two operations::

1. Click the Sequence Flow  button.
2. Click the sender operation and draw a link to the recipient operation.

A dotted line link indicates the path taken by the graphic link.

 Several paths are possible: you need only move the cursor in the 
recipient operation frame.

Moving Sequence Flows
You may need to change the predecessor or successor of a sequence flow. 

To move a sequence flow:
1. Click the sequence flow.

The two link ends are marked by squares.
2. Click the square you want to move and, holding the mouse button down, 

drop it to its new predecessor or successor.
A dotted line link is displayed.
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3. Release the mouse button.
The link appears in its new position in the diagram.

Inserting an element in a sequence flow
You may need to insert an operation or an organizational process between two
elements linked by a sequence flow. Rather than move the links, you can insert the
operation, or the organizational process, directly on the sequence flow.

To insert an operation in a sequence Flow:
1. Click the Operation button of the insert toolbar.
2. Position the mouse on the sequence flow that interests you.

The pointer shape changes to a double-headed arrow.

3. Click when the operation is correctly placed.
The operation is automatically created. 
The sequence flow is broken down into two sequence flows linking the new
operation at each end of the initial sequence flow.

Defining a Condition on a Sequence Flow

Specifying that a sequence flow is conditionned
To define that a sequence flow is conditioned:

1. Right-click the sequence flow and select Sequence Type >  
Conditioned.
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2. Click the sequence flow and press key <F2> to add a comment if 
necessary.
The text associated with the condition appears on the link which then
takes form .

 You can also access to the conditions of the sequence flow from the 
Characteristics property pages of the sequence flow. The comment 
appears in the Predicate field.

Defining a Sequence Flow
If several conditioned sequence flows are from the same operation, you can specify
that one of these should be used as default. For example, having completed the
"Enter Purchase Request" operation, the assistant always executes the "Finalize
Request" operation, except if the request is not acceptable and is below a given
amount.

To define that a sequence flow is used by default:
 Right-click the sequence flow and select  Sequence Type > Default.

The link then takes form .
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The content of message flows exchanged with the exterior can be specified.

Creating a Message Flow With Content
You can specify the content of message flows exchanged between a process and its
environment directly at flow creation.

 A message flow represents circulation of information within an 
exchange contract. A message flow transports its content.

To create a message flow and its content:
1. In the diagram insert toolbar, click the Message Flow button arrow, 

option Message Flow With Content

2. Click the first object representing the start step, and, holding the mouse 
button down, draw a line to the object representing the next step.
The Creation of Message Flows With Content dialog box opens.

3. In the Content drop-down list, select the content you wish to associate 
with the flow. 
The message flow is displayed with its content in the diagram.

 You can associate several contents with the message flow. For 
more details, see Creating a Message Flow With Content.



61

Organizational Processes
Defining Message Flows

Defining Message Flow Content

 A message flow represents circulation of information within an 
exchange contract. A message flow transports its content.

To define content of a message flow:
1. Open the Characteristics property page of the Message Flow.
2. Click the arrow at the right of the Content field and select Connect 

Content.
The selection dialog box appears, with a list of contents proposed for the
message flow. 

3. Select the content name and click OK.
 A content can be used by several message flows since it is not 
associated with a sender or recipient.

The name of the content appears in the diagram. 

Managing the Consistency of the Flows of a Process
The flows, and associated content, exchanged by a process with the outside must
be described in the process diagram.

To check the consistency of the flows of a process, you have two functionalities:
• Modeling regulations that allow a global validation of the consistency.
• A specific report that provides a detailed view of the inconsistencies on 

the exchanged flows. For more details, see Inconsistency of Message 
Flows in a Process.

To activate the modeling regulation regarding flow consistency:
1. Open the options window.
2. In the options tree, select Workspace > Modeling and Methods 

Regulations.
3. In the right section, in the Active modeling regulation field, click the 

arrow and select Select a regulation.
4. Select Message Flows Top-Down Consistency and click OK.
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To view the result of the modeling regulation:
 Open the General > Rules Application property page of the process.
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DEFINING PROCESS EVENTS

The events enabling representation of facts occurring during process execution.
 An event represents a fact or an action occurring in the system, 
such as updating client information. It is managed by a broker. An 
application indicates that it can produce the event by declaring that it 
publishes it. If an application is interested in an event, it declares that it 
subscribes to the event.

Events can be used:
• Within a process to define facts internal to the process.
• Outside a process to describe causes and effects of events of the process 

depending on its use context.

The different event types are presented in this section.
 Defining an event
 Connecting Events to Sequence Flows
 Accessing Preceding or Succeeding Processes

Defining an event

Event natures
The nature of the event enables specification of its position in the processing.

• Start: start of the processing sequence
• Catching: awaiting an event (arrival of a message, signal, etc.) before 

continuation of processing
• Throw: triggering an event (message, signal, etc.) and continuation of 

processing
• End: end of processing
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Event types
Event type enables specification of what will trigger the event and what will be
triggered by the event.

• None  the trigger is not specified, generally at the start or end of a 
process

• Message: the event is receiving or sending messages
• Timer: the event is triggered by a timer
• Error: the event is triggered by errors or throws errors that cause 

interrupt of the process
• Escalation: the event is triggered by an error or throws a non-critical 

error
• Cancel: the event reacts to cancellation of a process step or triggers 

cancellation
• Compensation:  the event handles or triggers compensation of a failed 

process
• Conditional: the event is triggered by a condition
• Link: the event is used to connect two sections of a process
• Signal: the event waits for a signal or throws a signal. One signal 

thrown can be caught multiple times
• Finish: the event indicates that all process steps should be immediately 

ended without compensation or event processing
• Multiple: the event has multiple triggers
• Multiple: the event has several simultaneous triggers
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Event type and nature combinations
The following table presents valid combinations of event type and nature.

Current process interruption
The current process may be interrupted when an event occurs. This characteristic
of the event is specified in Interruption which can be one of the following values:

• Interruption 
• Non interruption 

 By default the event interrupts the current process.
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Creating Events
You can directly create the most frequently used events: 

1. Click the Event button in the toolbar and select from the predefined 
nature events the nature that interests you.

2. Click in the diagram.
The new event appears in the diagram.

To create an event with a specific nature or type:

1. Click the Event button  in the insert toolbar.
2. Click in the diagram.

The Create Event dialog box opens.
3. Enter the name you want to give the event.
4. Select the nature of new event.

 By default, the nature is Catching.
5. Click Next and select the type of event you wish to create.

 By default the type is None.
6. Click OK.

The new event appears in the diagram. The shape of the event respects
conventions linked to its type and nature.

 By default the event is interruption.

Connecting Events to Sequence Flows
In a given context, a process can be connected to another process by a sequence
flow.

In the example above, the "Process Purchase Request" 
process precedes the "Process Purchase Order" process.
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Displaying external processes

In the diagram describing the process, the preceding process can be displayed.

In the diagram that describes the "Process Purchase Order" 
process, the "Process Purchase Request" process that 
precedes it is shown.

To do this, it is necessary to specify the event involved in the sequence flow:
1. Open the Characteristics property page of the sequence flow.
2. In the Triggered Event section, click the Connect button.

The query dialog box appears.
3. Find Possible Triggered Events.

The list displayed proposes start events or catching events of the
successor process. 

 The successor process is generally triggered at its start and 
normally has only a single start event. This start event is therefore 
generally the event that interests you.

4. Select the event corresponding to the sequence flow.
5. Click Connect.

If you open the organizational process diagram containing this event, you can view
the process that precedes it. For more details, see Accessing Preceding or
Succeeding Processes.

You can similarly select the triggering event of the previous process. In this case,
end events or throw events from the preceding process will be proposed.

Accessing Preceding or Succeeding Processes
In the following example, the "Process Purchase Order" organizational process is
activated after processing of the purchase request, and itself activates the "Make
Available" process.
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To show, at events level, the processes preceding and succeeding the described
process, you must: 

• Specify the sequence flows in which the events are involved. For more 
details, see Connecting Events to Sequence Flows.

• Activate the views enabling access to context-sensitive information.

To activate the context-sensitive view:

1. Click the Views and Details   button in the diagram toolbar.
2. Select the View External Processes check box.
3. Click OK.

Attaching an Event to a Process
To attach an event to a process:

1. Click the event and hold the mouse button down.
2. Position the event on the border of the process.

To detach the event from the process border:
 Right-click the event and select Detach.
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USING SHARED OBJECTS

In an organizational process diagram, a data object can be used to represent the
fact that data or objects (correspondence, raw materials, finished products, etc.)
are in stock awaiting use. 

 A data object is used to explain how documents, data, and other 
objects are used and updated during the process. A data object can 
represent an electronic document, or any other type of object, 
electronic or physical.

In this example, the shared object "Stock Data" is 
represented with an open head arrow since it is used by the 
"Analyze Purchase Request" process without having been 
produced by one of the processes represented in the 
repository.

Creating a Data Object
To create a data object:

1. Click the Data Insertion   button in the diagram insert toolbar.
2. Click in the diagram to position the object.

The Create Data Object dialog box appears. 
3. Click the arrow at the right of the Content field and select the content 

that interests you.
 A content can be used by several data objects.

4. Enter Data Object State if required.
 By default the data object carries the same name as its content. 
The state appears between brackets.

5. Click OK.
The data object appears in the diagram. 

Describing a Data Object
To specify that a shared object corresponds to an object collection: 

1. Open the Characteristics properties page of the data object.
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2. Click the arrow  at the right of the Collection box, and select Yes.
The shared object then takes the following form:

Information necessary for execution of operations can be consulted or updated in
the data objects.

To indicate that information was obtained from a data object, for example that stock
data used by the "Analyze Purchase Request" operation was obtained from the
"Stock Data" data object: 

 Click the link  button in the insert tool bar to link the "Stock Data" to 

the "Analyze Purchase Request" operation.
 A data object is represented by an open head arrow if it is read by a 
process without having been updated by one of the processes in the 
repository. 
 A data object is represented with a solid head arrow if it is updated 
by a process and not read by any of the processes in the repository. 

Associating a data object with Sequence Flow
You can specify that the content of a shared object is sent at sequencing of two
operations.

For example, a shared object "Purchase Request" can be sent 
between the operations "Enter Purchase Request" and 
"Finalize Request".

To simultaneously create a sequence flow and a data object:
1. Click the Sequence Flow button arrow, option Sequence Flow With 

Data Object.

2. Click the operation representing the start step, and, holding the mouse 
button down, draw a line to the operation representing the next step.
The Creation of Sequence Flow -Data Object dialog box opens.

3. In the Content drop-down list, select the content you wish to associate 
with the flow.

The sequence flow and its content are displayed in the diagram.
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Using Data Stores
Objects that are shared, supplied or used in processing can be stored in a data store. 

 A data store provides a mechanism to update or consult data that 
will persist beyond the scope of the current process. It enables storage 
of input message flows, and their retransmission via one or several 
output message flows.

Prerequisites to using data stores
HOPEX Business Process Analysis provides several types of data store:

• Process data store, associated to a business information area.

 A business information area is a sub-set of elements of a subject 
area that reduces the scope of a field. For more information, see the 
HOPEX Information Architecture guide.

• Process logical data store, associated to a logical data area.

 A logical data area is used to define a logical data structure made 
up of classes and data views. For more information, see HOPEX 
Information Architecture.

To activate these options:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Select the check boxes that interest you in the following fields:

• Activate former BPMN data stores (HOPEX V3 and lower) 
 If the Data Store button is not visible by default, click the diagram 
Views and Details button and select the "Data Stores" view.

• Activate BPMN data stores for conceptual, logical and physical 
layers (from HOPEX V3.1)

 If the Process Data Store and Logical Process Data Store 
buttons are not visible in your organizational process diagram, click the 
diagram Views and Details button and select the “Process Data Stores 
view”.

Creating a process data store
To create a process data store:

1. Click the Process Data Store  button in the insert toolbar.
 If the button is not visible by default, click the diagram Views and 
Details button and select the "Data Stores" view.

2. Click in the diagram to position the object.
The Add Business Information Area dialog box appears. 

3. Select the name of the Business Information Area connected to the 
process data store.

4. Click OK.
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In the same way you can create:
• Process data stores, associated to a business information area.

 A business information area is a sub-set of elements of a subject 
area that reduces the scope of a field. For more information, see the 
HOPEX Information Architecture guide.

• Process logical data stores, associated to logical data area.

 A logical data area is used to define a logical data structure made 
up of classes and data views. For more information, see HOPEX 
Information Architecture.

Describing exchanges with a Process data store
You can specify that informations are exchange between a process data store and
an operation.

For example, to describe that an organizational process reads informations from a
process data store using an operation:

1. Click the link button .

2. Click on the Data Store and, keeping the mouse button pressed down, 
draw a line to the operation.
The link appears in the diagram.

 The reading or writing access is determined by the direction of the 
link.
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Using Gateways

USING GATEWAYS

The following example presents a case where continuation of processing is
conditioned: following analysis of a purchase request, the process either ends, or an
order is sent to a supplier.

To specify that several processing steps are accessible following a particular
processing step, you can use a gateway.

 Gateways are modeling elements that are used to control how 
sequence flows interact as they converge and diverge within a process.
 Conversely, you can also use a gateway to indicate that a particular 
processing step is available from several processing steps of a process. 

In compliance with the BPMN standard, in the insertion toolbar, several gateway
types are available to you.

To better understand the main use cases, we distinguish output gateways of a
processing step from input gateways.

Processing Step Output Gateways
In the case of an Exclusive gateway, only one output branch can be selected from
those available. The branch can be selected as a function of the Data available for
the process, or of the Events occurring during its execution.

In the case of a Parallel gateway, all output branches are processed
simultaneously.
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In the case of a Complex gateway, one or several output branches can be selected
from those available.

A Complex gateway represents a combination of those above.

When the gateway has been created, its type can be modified in its properties page. 

At output of a step, a gateway represents a point of divergence of sequence flows
of a process. 

Step Input Gateways
At input of a step, a gateway represents a point of convergence of sequence flows
of a process. 

In the case of an Exclusive gateway, the process step is triggered when one of
these branches is active.

In the case of a Parallel gateway, all input branches are processed simultaneously.

Creating gateways
To create a gateway:

1. Click the arrow at the right of the Gateway button in the diagram insert 
toolbar and select the gateway type you wish to create.

2. Click in the diagram.
The gateway appears in the diagram with the shape appropriate to its
type.

 You can specify the name of the gateway from its Characteristics 
property page.
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Modifying gateway type
To modify gateway type:

 Right-click the gateway and select Gateway Type.
The Gateway Types proposed are:
• Complex: the process can take a complex combination of paths.
• Exclusive : the process can take a single path from several possible 

paths depending on the value of the data available. This is the default 
gateway type.

• Exclusive (Start): the process is triggered by the first event 
occurring; others are ignored.

• Exclusive (Event): the process can take a single path from several 
possible paths depending on the events occurring.

• Inclusive: the process can take one or several paths simultaneously.
• Parallel: the process takes several parallel paths simultaneously.
• Parallel (Start): the process is triggered by the first event occurring. 

The other events occurring during progress of the process are also 
taken into account.

 You can also access to the gateway type from the Characteristics 
property pages of the gateway.
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 IMPORT AN ORGANIZATIONAL PROCESS FROM EXCEL

HOPEX Business Process Analysis enables creation of organizational processes
with their components form Excel in order to import these in a library.

 For more details on Excel data exchange wizards, see the 
“Exchanging Data with Excel” chapter in the HOPEX Common 
Features guide.


Structure of the import Excel template of HOPEX Business Process 
Analysis

The HOPEX Business Process Analysis Excel template enables import of
organizational processes components. 

 For more details on the way to build the Excel template, see 
Building the import file for HOPEX Business Process Analysis.

The information contained in the Excel template delivered with HOPEX Business
Process Analysis is presented as follows: 

• Only one sheet for the components of the set of the imported 
organizational processes.

• Each Excel line is dedicated to the description of the component whose 
name is specified in the Process Name column.

 The Excel file template is available only in English language.

• Organizational Process: Owner organizational process HOPEX 
identifier.

• Process Name: Owner organizational process Name.
• What: Described component Name.
• Type: Described component type (Operation, Event or Gateway).
• Event Nature: Nature of component whose Type is Event. For more 

details on an event nature, see Event natures.
• Who: Name of the Org_Unit associated to the participant executing 

the described component. For more details on participants(Org-Unit), 
see Creating a Participant (Org-Unit ).

• Comment: Described component comment.
• Previous Item: Name of the component preceding the described 

component.
• Previous Item Type: Type of the component preceding the described 

component(Operation, Event or Gateway).
• Sequence Label: Predicate of the sequence flow between the 

component preceding the described component and the described 
component itself. For more details, see Defining a Condition on a 
Sequence Flow.

• Sequence Type: specifies a condition on a sequence flow. Possible 
values are: conditioned and default. For more details, see Defining a 
Condition on a Sequence Flow.



77

Organizational Processes
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Importing organizational processes description with HOPEX 
Business Process Analysis

 For more information on the structure of the Excel template, see 
Structure of the import Excel template of HOPEX Business Process 
Analysis.

Several steps must be followed in order for the Excel import of a organizational
process description to be performed correctly:

1. Checking the Excel Import/Export Options,
2. Importing the description of organizational process into the current 

library,
 For more information on the structure of the Excel template to be 
imported, see Building the import file for HOPEX Business Process 
Analysis.

Importing the description of organizational process into the current library
To import objects using the Excel file of HOPEX Business Process Analysis:

1. Click the Main menu and select Import > Excel (*.xls, *.xlsx).
The import wizard appears in the edit window.

2. At the right of the Excel Import File field, click the Browse button.
3. Select the file to be imported.

 For more information on the creation of the Excel file to be 
imported, see Building the import file for HOPEX Business Process 
Analysis.

4. Click Import.
The wizard provides a report of import results. 

5. To obtain a detailed report of import errors, click the Open Report 
button.
The .xls (or .xlsx) file opens indicating in color red the problem data. 

6. To have the data imported into the current library, click Done.
7. To modify the imported file or the import parameters, click Previous.
8. To discard import, click Cancel.

Building the import file for HOPEX Business Process Analysis
To access to the Excel file template that can be imported with  HOPEX Business
Process Analysis :

1. Check that your export options are correct. See Checking the Excel 
Import/Export Options.

2. Click the Main menu and select Export > Excel (*.xls, *.xlsx).
The export wizard appears in the edit window.

3. Select From a template.
4. Click Next.
5. In the Predefined Template File field select Organizational Process 

Template.
6. Click twice on Next.

The export report dialog box is displayed.
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7. Click Open the Export file to view the export file.
8. Click OK to finish.

The generated xlsx file is in the format expected for later import. To be
able to import organizational processes components, you must fulfill the
Excel file.

 For more details on establishing this Excel file, see  Structure of the 
import Excel template of HOPEX Business Process Analysis.
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ORGANIZATIONAL CHARTS AND 
RESPONSIBILITIES

HOPEX enables representation of enterprise structure It indicates the hierarchy of org-units in the
enterprise, specifies the persons that play the role of these org-units, and shows at which site the
org-unit is located. 

HOPEX also enables definition of organizational process responsibilities by means of the RACI
matrix (Responsible, Accountable, Consulted, Informed) as well as business processes.

 Managing a organizational chart
 Process responsibilities
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MANAGING A ORGANIZATIONAL CHART

An organizational chart provides an overview of the enterprise structure. HOPEX
Business Process Analysis allows you to design your organizational charts using
the same tools and methods as applied to processes.

HOPEX Business Process Analysis organizational charts contain the following
descriptive objects:

• Org-Units, which are generally elements defining the enterprise 
structure, such as Sales Department.

• Sites that are geographical locations pivotal to the organization, such as 
headquarters, plants, etc.

Organizational chart example

Creating an Organizational Chart
To create an Organizational Chart from the Processes navigation pane: 

1. Select Hierarchy.
2. Expand the Org-Units folder.

The list of existing actors appears.
3. Right-click an org-unit and select 
4. New > Diagram.

The Diagram type selection dialog box opens.
5. Select Org-Unit Organizational Chart.

The corresponding organizational chart opens. It is automatically
initialized with the component org-units of the described org-unit.
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Drawing an Organizational Chart

Searching for objects
To simultaneously add all the org-units involved in your processes that were not
automatically inserted at diagram initialization:

1. In the query tool, select the Org-Unit object and click the Find button .

The result dialog box appears.
2. Select the desired org-units holding the <Shift> key down.

 When you click on an object while holding down the Ctrl key, you 
add it to the list of selected objects if it was not previously selected, or 
you remove it from the selection if it was. 

3. Drag-and-drop the selected objects from the result dialog box into the 
diagram.

 When an org-unit appears in a diagram, you can describe it with a 
new organizational chart using its pop-up menu.

4. Draw the links between these org-units.
 Note that certain links might already exist.

When you create a link between two org-units, always drag from the org-unit higher
in the hierarchy down to the subordinate. Once the link is drawn, an arrowhead
indicates the direction of the hierarchy.

Specifying org-unit properties
To specify the properties of an org-unit:

1. Open the Characteristics property page of the Org-Unit.
2. In the Org-Unit-Type list box, select the org-unit type. 

There are several types of org-units:
• “Vendor"
• “Institution”
• “Company”
• “Public Department”
• "Structure" (for example, Sales Management).
• “Function” (for example, Sales Engineer)
• “Accountable” (for example, Sales Manager)
• “Generic”: corresponds to a role to be played during a project (Writer, 

Requester,...).
 You can also specify its details (company name, e-mail address, 
telephone number, etc.).
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Associating a person with an actor
You can connect Person (System) with an Org-Unit.

 A person (System) represents a person in the enterprise. This 
person can be assigned a login and a role (or a profile depending on the 
connection mode). The login provides access to the HOPEX Application. 
The role (or the profile) defines the access to product functions and 
repositories. A system person, if assigned a login, has a specific desktop 
in each database, and can connect to this desktop from any workstation 
in a given environment.

The name of the persons linked to the org-unit appear in the org-unit frame.

To associate a Person (System) with an Org-Unit: 
1. Expand the Responsibility section of the Characteristics property 

page of the Org-Unit.
 To display the  Responsibility section, open the Options window 
and check that HOPEX Solution > Common Features > System 
Person Management is activated.

2. In the Org-Unit member tab, select the Person (System) concerned.

Associating a site with an org-unit

You can also add sites  where the org-units are located.
 A site is a geographical location of an enterprise. Examples: Boston 
subsidiary, Seattle plant, and more generally the headquarters, 
subsidiaries, plants, warehouses, etc.

Consulting reports associated with org-units
HOPEX Business Process Analysis provides several reports about org-units. 

To view these reports:
 Open the Report property page of the Org-Unit.

The list of available reports is proposed.

Consulting the Org-Unit Structure report
HOPEX Business Process Analysis proposes a report in the form of a matrix
which presents:

• The selected org-unit, its type and the associated persons
• The selected org-unit, its parent Org-Unit and the associated persons

To consult the Org-Unit Structure report
 Open the Report > Structure  property page of the Org-Unit.
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Consulting the RACI Matrix of Org-Units
 RACI is the acronym of Responsible, Accountable, Consulted, 
Informed.

HOPEX Business Process Analysis proposes a report in the form of a matrix
which presents:

• The selected org-unit and sub-org-units
• The organizational processes and operations in which these org-units 

intervene. 
 RACI is the acronym of Responsible, Accountable, Consulted, 
Informed.

To consult the RACI matrix:
 Open the Report > RACI property page of the Org-Unit.

 For more details on the use of RACI, see Process responsibilities.
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PROCESS RESPONSIBILITIES

From an organizational process or a business process, you can:
• Define process control responsibilities
• View org-units concerned by the organizational processes connected to 

this process

Defining process control responsibilities
Business processes are managed by persons. The business process steering team
therefore comprises a list of persons whose individual roles in the team can be
indicated.

To specify organizational process control responsibilities:
1. Open the Characteristics property page of a process and expand the 

Responsibility section.
2. Select one of the following tabs to create or connect the persons 

(system) involved in process control:
• “Organizational process Designer”
• “Organizational Process Contributor”

3. Select Organizational Process Owner .

Using RACI
 RACI is the acronym of Responsible, Accountable, Consulted, 
Informed.

HOPEX Business Process Analysis specifies the responsibility level of the various
org-units:

• On an operation
• On an organizational process. 

The proposed levels of responsibility are described in the table below.

Responsibility Explanation

Responsible Org-unit responsible for the operation or process

Responsible Org-unit monitoring progress of the operation or process and 
taking decisions. 
There is only one "Accountable" org-unit for each action. 
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Process responsibilities

Prerequisites to using RACI

One option is used to display the  information about RACI.

To activate this option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Select the Managing RACI (BPMN) and Automatic synchronization 

of RACI by means of participants check boxes. 

Defining RACI responsibilities

Org-units displayed in a participant
The list of org-units displayed in the header of the shape of a participant groups the
org-units declared in the participant's properties. 

• Org-units attached to the participant but with a responsibility in the 
process or operations executed by the participant. The name of the 
org-units is followed by a letter corresponding to their responsibility. 
These org-units are declared in the properties of the participant.

 For more details on org-units connected to a participant, see 
Creating a Participant.

Defining the RACI of an org-unit for an operation or a process
To indicate the responsibility of an org-unit in an operation, for example:

1. In the operation Characteristics property page, expand the Actors  
section.

2. Click the Connect button.
3. In the dialog box that opens, select Candidate Org-Units (RACI) and 

click the Find button .
A dialog box proposes the list of org-units that execute the operation or
the process via a participant.

 An org-unit can be connected directly to an operation or process or 
indirectly via a participant. An RACI candidate org-unit is an org-unit 
assigned to a participant.

Responsible/Accountable Org-unit executing the operation or process, informs on 
progress and takes decisions. 
There is only one "Accountable" org-unit for each action. 

Consulted Org-unit consulted as first priority before an action or deci-
sion.

Informed Must be informed after an action or decision.

Responsibility Explanation
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4. Select the org-units that interest you and click Relier.
The org-units appear in the properties dialog box of the operation or
process.

5. For each of these, in the RACI drop-down list, select a responsibility 
level from the four proposed.
• Consulted (C)
• Responsible (R)
• Responsible/Accountable (R/A)
• Informed (I)
• Accountable (A)

The selected responsibility level appears with an icon corresponding to context: 

Icon Meaning

Indicates that responsibility is deduced from the participant.
The icon appears when the selected org-unit is:
- assigned to the participant, and
- declared with Responsible responsibility (default responsibil-
ity).

No icon There is no icon when the selected org-unit is:
- assigned to the participant, and
- declared with responsibility other than Responsible (default 
responsibility).
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To indicate responsibility of each of the org-units attached to a participant in the
different operations or organizational processes it executes:

1. Open the RACI property page of the participant.
The analysis report is displayed carrying the letter representing the
responsibility of the org-unit in the process or operation:
• (A) for Accountable
• (R) for Responsible
• (R/A) for Responsible/Accountable
• (C) for Consulted
• (I) for Informed

In the example above, the "Purchasing Department" assigned 
to the participant to which the analysis relates, executes 
the "Process Purchase Request" process and is Accountable 
for "Process Purchase Order".
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2. Click .
The context of responsibility of the org-unit is indicated. You can view: 
• the name of the participant to which the org-unit is assigned
• the name of the process that is owner of the participant

 For more details on reports relating to the RACI or an org-unit, see 
Org-Unit RACI Matrix (BPMN).

Generating a RACI Matrix of an Organizational Process
From an organizational process you can generate a matrix presenting:

• Organizational processes connected to current process or to its sub-
processes,

• Operations of these organizational sub-processes,
• Org-units concerned by these organizational processes and operations.

 For more details on reports relating to the RACI, see Managing 
RACI (BPMN).
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Process responsibilities

To generate an RACI matrix from an organizational process, for example: 
1. Open the Reporting > RACI property page of the process.

The analysis report is displayed carrying the letter representing the
responsibility of the org-unit in the process or operation:
You obtain a result like this:
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VALUE STREAMS

Value streams of the enterprise can be described in the form of functional processes. For example,
when an enterprise operates out of numerous geographical locations, organization of business
process operations can vary significantly between regions.

It is therefore useful to have a summary view, independent of organizational structure, to represent
steps in the value stream connected to enterprise business and common to all organizational
variants.

A functional representation of the value stream also facilitates improvement in enterprise operation.

Indeed, when the operation of each organizational process is represented, this enables local
optimization of each process.

This structure however remains partitioned by existing organizational structures. More significant
changes require a broader view of the value stream, independent of organization. This global view
is represented by the value stream  diagram.

HOPEX Business Process Analysis enables the creation and description of enterprise value
streams. 

 Value streams management
 Representing a Value Stream
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REPRESENTING A VALUE STREAM

 To display the Value streams, open the Options window and 
check that HOPEX Solutions > Business Process Analysis > Value 
Stream Modeling is activated.

Value Stream Example
The following diagram presents an example of a value stream:

"Purchase reception" value stream

The purchase request is recorded and must then be approved. 
The requester is informed of the approval or rejection of 
the request. If the request is validated, an analysis of the 
required order is carried out. 
If stock is lower than a given threshold, an order is 
prepared and sent to the supplier for resupply.
If the product is available, or as soon as it is received 
from the supplier, it is made available to the requester.
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Representing a Value Stream

In this example, the business functions concerned are represented in columns.
 A business function is a conceptual unit of the division of 
responsibilities in an enterprise. It is used to structure the management 
of information processing, energy, and equipment produced or used. 
Business functions define the skills and the functionalities necessary to 
the enterprise to fulfill its mission.

In the organization previously presented, three org-units: purchasing assistant,
purchasing manager and buyer, systematically participate to execute the first four
steps: record and approve the request, analyze and send the order.

Optimization of the organized process "Process Purchase Requests" has saved one
step: when amount of the order is not significant, the purchasing assistant can
himself approve or refuse the purchase request.

In the case of urgent orders, you can again save steps by authorizing the purchasing
assistant to send the order when the amount is not significant.

We obtain the following value stream for processing of urgent orders:

"Purchase reception" value stream

The first step consists of analyzing the purchase request. 
If the total amount is large, normal processing is carried 
out.
Otherwise, the availability request and a restock request 
are sent, if necessary. Continuation of this value stream is 
identical to the previous one: when the order has been 
received, it is made available to the requester.
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Value Stream representation principles

Highlighting organizational choices
Each enterprise has activities related to its business that must be performed
whatever the organization in place. These activities can be purchasing, sales, sales
administration, manufacturing, etc.

Defining their organization consists of assigning these activities to the org-units that
will perform them.

We can distinguish between:
• Processes relating to the business of the enterprise: these are difficult to 

change unless the enterprise decides to totally review its business.
• Processing depending on organizational choices.

Number of steps
Certain steps in an organizational process are exclusively linked to the chosen
organization. In such cases, it is useful to check whether these steps provide any
real added value to clients or only concern the way things are done.

Delivery times can also be reduced by restructuring the order of these steps.

To highlight possible improvements, you can represent a value streams by flows
exchanged between enterprise value stage.

 A value stage is a distinct, identifiable phase or step within a value 
stream that has a unique entrance criteria, exit criteria, and identifiable 
participating business function or business functional area.
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 VALUE STREAMS MANAGEMENT

 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.

Prerequisites to using value streams
One option is used to display the  value streams.

To activate this option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Click Value Stream Modeling and Business Functions Modeling.

Accessing Value Streams with HOPEX Business Process Analysis
To access the list of Value Streams from the processes navigation pane: 

1. Select Hierarchy.
2. Expand the Value Streams folder.

The list of value streams appears.

Creating a value stream
To create a Value stream from the Processes  navigation pane: 

1. Select Hierarchy.
2. Select the Value Streams folder and click New > Value Stream.

The value stream creation window appears.
3. Modify the name of the Value Stream.
4. Specify the Owner.
5. Click OK.

The value chain is created and added to the list of value chains.

Creating a value stream diagram
To create a value stream diagram

1. Select the value stream that interests you and click Create Diagram.
A window opens and prompts you to choose the Diagram Type that you
wish to use:

2. Select the diagram type you want to create.
• a value stream diagram, see The value stream diagram;
• a value stream to capability diagram, see The value stream to capability 

diagram;
 For more information on a Value Stream diagram initialization with  
HOPEX Business Process Analysis, see Organizational Process 
Diagram initialization.
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The value stream diagram
 The value stream diagram shows the sequence of the value 
creation steps performed, the events that occur and the conditions 
under which they are sequenced. It also makes it possible to assign the 
participants who carry out these value-creation steps to the business 
skills needed to implement them. This representation of a Value Stream 
helps to answer the following question: "What are the skills needed to 
implement the Value Stream?".

This type of diagram makes it possible to describe precisely the company's value
streams as presented in paragraph : Value Stream Example.

If the value stream is already connected to components, it is possible to initialize a
new diagram by inserting the existing components.

 For more information on a Value Stream diagram initialization with  
HOPEX Business Process Analysis, see Organizational Process 
Diagram initialization.

The value stream to capability diagram

The value stream to capability diagram can only be used in tabular input mode.
 Tabular input is available with this diagram. For more information 
on using tabular input, see the "Entering a diagram in tabular mode" in 
the HOPEX Common Features guide.

This diagram makes it easy to initialize a value stream diagram by creating the value
stream steps and the links they have with the different business capabilities.

 For more information on business capabilities see Business 
Capability Maps.
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Representing the value stream fulfillment with HOPEX Business Process 
Analysis

You can represent the fulfillment of a value stream by an organizational process
from the organizational process concerned

To access the list of Value Streams from the Processes navigation pane: 
1. Select Hierarchy.
2. Expand the Organizational Processes folder.
3. Open the Value Stream Fulfillments property page of the 

organizational process that interests you.
4. In the Fulfilled Value Streams section, click the New button.
5. In the creation window that opens, select the fulfilled value stream.

 To represent the implementation of a value stream by an 
organizational process in the context of a business process, you can also 
use the concept of contextualization. For more details, see Representing 
Process Contextualization.
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BUSINESS CAPABILITY MAPS

HOPEX Business Process Analysis offers a methodological framework established from
international standards (BIZBOK and other architectural frameworks of NAF/DoDAF and TOGAF
type), as well as our experience in this area. Our method consists of analyzing the business
capabilities of your enterprise and checking their suitability with your business functions and skills.
This work leads to a better understanding of the current state of your organization ('As-Is').

Business Architecture helps managers define the operating architecture of their enterprise to remain
in compliance with its business model and to adapt to changes in the enterprise and in its economic
and regulatory environment. Thus the analysis of the company's business capabilities makes it
possible to identify and implement the services that the company plans to offer.

 A business capability map is a set of business capabilities with their 
dependencies that, together, define a framework for an enterprise 
stage.

 .A business capability is a set of features that can be made 
available by a system (an enterprise or an automated system).



100

DESCRIBING BUSINESS CAPABILITIES WITH HOPEX 
BUSINESS PROCESS ANALYSIS

This step consists, on the one hand, in describing what the company is able to
deliver (the business capabilities) and, on the other hand, in describing how it
delivers it (functionalities covered, skills and business functions). 

Prerequisites to use of business capabilities
An option is used to display the business capabilities and the business skills.

To activate this option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Select the check box Capability visibility.

Building the Capability Maps and Business Function Elements
The goal of this work is to check the suitability between the business capabilities of
the enterprise, the business functions delivering this capabilities as well as the
required functionalities and business skills. 

This consists of the following tasks:
• Describing the Existing Architecture of Business Capabilities,
• Accessing business capability components.

Describing the Existing Architecture of Business Capabilities

Building the business capability map

A business capability map describes what the enterprise is capable of producing for
its internal needs or for meeting the needs of its clients.

 A business capability map is a set of business capabilities with their 
dependencies that, together, define a framework for an enterprise 
stage.

 .A business capability is a set of features that can be made 
available by a system (an enterprise or an automated system).
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The capability map thus presents the business capabilities of the highest level for
one of the stages of the enterprise.

In this example, the business capability to deliver pizzas 
is based on the business capability to cook them. 

 For more details on business capability map diagrams, see Creating 
a business capability map diagram.

Describing the business capability breakdown

Business capabilities are then described more precisely to identify:
• a more detailed granularity capability breakdown;
• the expected effects of the capability;
• the business skills or functionalities required for each of them;
• the dependencies between capabilities (expected effect of one dependent 

from the result of the other).
For example, the business capability that consists of 
managing operations is broken down into a number of business 
capabilities such as: “Handle customer complaints”, “Manage 
travel reservations”. 
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Defining the business skills and functionalities associated with 
business functions

To be able to subsequently check that each business capability is implemented by a
suitable component, you must define the required business skills and functionalities,
for each business function.

 A technical functionality is a capability expected from an equipment 
item (hardware or software) to ensure the operation of a technical 
element or an application.
 For more details on skills and the business capability functionalities, 
see Defining the business skills and functionalities associated with 
business capabilities.

HOPEX Business Process Analysis provides a report available detailing the
breakdown of capabilities.

 For more details on breakdown maps, see Breakdown Report of 
Business Capabilities.

Accessing business capability components
To access the list of business capability maps from Capabilities navigation pane:

 Select Business Capability Maps in the navigation menu.
The list of business capability maps appears in the edit area.

To access the list of business skills maps from the Capabilities navigation pane:
 Select Business Skills Maps in the navigation menu.

The list of business skill maps appears in the edit area.

To access the list of Functionality maps from Capabilities navigation pane:
 Select Functionality Maps in the navigation menu.

The list of functionality maps appears in the edit area.
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DESCRIBING A BUSINESS CAPABILITY MAP

 To display business capabilities, business capabilities maps and 
business skills, vérifier que l’option HOPEX Solutions > Business 
Process Analysis > Capability visibility is activitated.

Building the Business Capability Map
A business capability map is used to represent the main business capabilities that
interact with an enterprise.

The properties of a business capability map
The Characteristics property page of the business capability map provides access
to:

• its Owner, by default on creation of the business capability map, the 
current enterprise.

• its Name,
• the text of its Description.

With HOPEX IT Business Management , a business capability map is described
by the following pages:

• the Structure page is used to specify on the one hand the list of 
business capability components that constitute the business capability 
map described, and on the other hand, the dependencies between these 
components,

 For more details on business capacity structure, see Using the 
capability compositions and Defining business capability dependencies.

• The Capability Usage page provides access to the enterprise stages 
that use the capability map.

 A Business Transformation Stage is a kind of Enterprise 
Transformation Stage aiming at the alignment of the enterprise 
business operating model to its business strategy and corresponding 
exhibited business capabilities (business model).

Creating a business capability map diagram
To create a business capability map diagram:

1. Select the business capability map that interests you and click New > 
Diagram.
The Diagram type selection dialog box opens.

2. Select Business Capability Map Diagram.
3. (Optional) Uncheck the Diagram Initialization box.
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4. Click OK.
The diagram opens in the edit area. The frame of the business capability
map described appears in the diagram.
You can construct this diagram in tabular input mode.

 Tabular input is available with this diagram. For more information 
on using tabular input, see the "Entering a diagram in tabular mode" in 
the HOPEX Common Features guide.

Using the capability compositions
The components represented in a business capability map diagram are Capability
Compositions. Each capability composition is associated with a business capability.

 A Business capability component is the involvement of a 
business capability in the context of a business capability map (one and 
only one) linked to an enterprise.

To add a business capability composition to a business capability map diagram:
1. In the diagram insert toolbar, click Capability Composition.
2. Click in the frame of the business capability map.

The creation window for a capability composition opens.
3. Click on the arrow associated with the Name field and select the 

business capability that interests you.

4. Click OK.
The capability composition appears in the diagram.

 If the business capability is associated with functionalities, they 
also appear. For more details on business Skills and functionalities 
associated with business capabilities, see Defining the business skills 
and functionalities associated with business capabilities.

Defining business capability dependencies
A dependency link between one capability composition and another is used to
specify the elements on which this dependency is based. 

For example, “Billing” uses “Order Management”. Note that 
the expected result (business effect) of "Billing" is an 
"Invoice" and the expected result (business effect) of 
"Order Management" is a "Order to be delivered". 
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Dependent Business Effect and Desired Business Effect are the business
capability results.

 For more details on the results of business capabilities, see 
Describing the outcomes.
 A single capability composition can have more than one 
dependency within a single diagram.

To create dependency links between two capability compositions:
1. In the insert toolbar, click Business Capability Dependency.
2. Click the user component, and keeping the left mouse button pressed, 

move the cursor to the assembly used.
3. Release the mouse button.

The capability composition appears in the diagram.

To enter the results concerned by a dependency between two business capability
components:

1. Open the Characteristics properties dialog box.
2. Enter the user component result in the Dependent Business Effect 

field.
For example, “Invoice”.

3. Enter the user assembly result in the Desired Business Effect field.
For example, “Order to be delivered”.

Describing a business capability
A business capability can be based on business sub-capabilities. The capabilities
expected by the business capabilities described are the capabilities associated with
each business sub-capability.

For example, the business capability that consists of 
managing operations is broken down into a number of business 
capabilities such as: “Handle customer complaints”, “Manage 
travel reservations”. 
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The capability structure diagram describes the composition of a business capability.

Creating a business capability
You can create a new business capability in several ways:

• From the business capability map diagram,
• From the properties page of a business capability map,
• From the navigation pane.

To create a Business Capability from a business capability map diagram:
1. Click the Capability Composition button.

The Add Business Capability window appears.
2. Enter the name of the new capability and click Next.
3. Specify the Owner of your business capability and click OK.

The new business capability appears in the diagram. 
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The properties of a business capability
The Characteristics property page of the business capability map provides access
to:

• its Owner, by default on creation of the business capability, the current 
enterprise.

• its Name,
• the text of its Description.
• the Desired Capability Effect is an Outcome.

For example, the desired capability effect of "Manage 
operations" is a "Contract acceptance"

 For more details on results, see Describing the outcomes.

 For more details on the use of results, see Defining business 
capability dependencies.

An business capability is described by the following pages:
• the Structure page specifies a part of the list of components that 

constitute the business capability described, as well as the dependencies 
between these components,

 For more details on the structures of a business capability, see 
Defining the structure of a business capability.

• the Expected Capabilities property page is used to specify a list of 
business skills and functionalities that are expected from the business 
capability.

 For more details on the skills and functionalities associated with a 
business capability, see Defining the business skills and functionalities 
associated with business capabilities.

• In the Capability Usage page: 
• he Capability Component section provides access to the capacity 

maps that use the described capability.
 For more details on the components of a business capability, see 
Using the capability compositions.

Creating a capability structure diagram
To create a capability structure diagram:

1. Right-click the business capability that interests you and select New > 
Diagram.
The Diagram type selection dialog box opens.

2. Select Business Capability Map Diagram.
3. (Optional) Uncheck the Diagram Initialization box.
4. In the Edit Mode section, select Edit diagram with graphical entry.
5. Click OK.

The diagram opens in the edit area. The frame of the business capability
described appears in the diagram.
You can construct this diagram in tabular input mode.

 For more information on using tabular input, see the "Entering a 
diagram in tabular mode" in the HOPEX Common Features guide.
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Defining the structure of a business capability
The components represented in a business capability structure diagram are
Capability Composition. Each capability composition is associated with a business
capability.

 A Business capability component is the involvement of a 
business capability in the context of a business capability map (one and 
only one) linked to an enterprise.
 For more details on how to use business components in a diagram, 
see Using the capability compositions.

A dependency link between one capability composition and another is used to
specify the elements on which this dependency is based, that is, the effect of one
required by the effect of the other. 

 For more details on creating dependency links between two 
capability compositions, see Using the capability compositions: 

The capability compositions and their dependencies appear in the Structure
property page of the business capability described.

Defining the business skills and functionalities associated with business 
capabilities

 A technical functionality is a capability expected from an equipment 
item (hardware or software) to ensure the operation of a technical 
element or an application.

 A value stream is an end-to-end collection of Value Stages that 
creates an outcome for a customer, who may be the ultimate customer 
or an internal end-user of the value stream.

Each business capability is associated with functionalities that it is able to provide
and that it needs to ensure its functionalities.

To associate a skill with a business capability:
1. Open the Expected Capabilities properties window of the business 

capability.
2. In the Expected Business Skill section, click New.

An Expected Business Skill creation dialog box opens.
3. Click, for the  Connect a Business Skill check box.
4. Specify the name of the skill.
5. Click OK.

The business skill appears in the list of skills associated with the business
capability.

 For more information on enterprise skills, see Describing Business 
Skills. 

To associate a functionality with a business capability:
1. Open the property pages of the business capability concerned and select 

the Expected Capabilities page.
2. In the Expected Functionality section, click New.

An Add functionality window appears:
3. Click the down arrow.
4. Select a functionality.
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5. Click OK.
The functionality appears in the list of functionalities associated with the
business capability.

 For more information on enterprise functionalities, see Describing 
functionalities. 

The business skills, functionalities and the expected effects appear in the diagrams,
at the bottom of the frame of the capability described.

A report is available to check the suitability between the business capability map and
the operational environment, for more details, see Breakdown Report of Business
Capabilities.

Describing the outcomes
The outcomes of a business capability, a functionality, or a skill are represented by
a content.

 The content designates the content of a message or an event, 
independent of its structure. This structure is represented by an XML 
schema linked to the content. A content may be used by several 
messages, since it is not associated with a sender and a destination. 
There can be only one content per message or event, but the same 
content can be used by several messages or events.

The contents associated with the outcomes are used to describe the content of flows
exchanged in the value streams, see Value streams.

The outcomes are used to define the dependencies between:
• The business capabilities in the business capability maps, see Defining 

business capability dependencies.
• The sub-functionalities in the functionality maps, see Defining 

Functionality dependencies.
• The sub-skills in the skill maps, see Defining the business skill 

dependencies.

The properties of an outcome
The Characteristics property page of the outcome provides access to:

• its Owner, by default on creation of the result, the current enterprise.
• its Name,
• the text of its Description.
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Connecting an outcome to a business capability
An outcome can be used by a business capability or by an exhibited business
capability. It appears in the Desired Capability Effect section of the
Characteristics page of the capability property pages.

For example, the desired capability effect of "Billing" is 
an "Invoice"

To connect an existing outcome to a business capability, for example:
1. Open the property pages of the business capability that interests you.
2. Select the Characteristics page. 
3. In the Desired Capability Effect section, click New. 

The Creating a Desired Business Effect window opens.
4. Select Reusing an existing content.
5. Select the content that interests you and click OK.

The content appears in the list of Desired Capability Effects. 

Breakdown Report of Business Capabilities
You can use this breakdown report to display the realization coverage of business
capability elements by operational elements such as business skills, functionalities
or organizational processes, according to different approaches: Organizational,
Business/Data, Logical/Physical Application, etc.

 For more details on how to associate a business capability with 
operational elements, see Describing Fulfillment of a Business 
Capability.
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Report example
The example below enables viewing of the coverage rate of 
the business capability map specified as parameters by 
organizational processes. 

 For more details on business capability maps, see Building the 
Business Capability Map.

Example of a business capability map breakdown report

 For more details on use of a breakdown report, see the, chapter 
"Handling a Breakdown Report" in the HOPEX Common Features 
guide.
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DESCRIBING THE BUSINESS SKILL MAP

 A business skill map is a set of business skill with their 
dependencies that, together, define a framework for an enterprise 
stage.
 To display business capabilities, business capabilities maps and 
business skills, check option HOPEX Solutions > Business Process 
Analysis > Capability visibility is activated.

The properties of a business skill map
The Characteristics properties page of the business skill map provides access to:

• its Owner, by default during creation of the business skill map, the 
current enterprise.

• its Name,
• the text of its Description.

With HOPEX Business Process Analysis a business skill map is described by:
• the Structure page that specifies the list of business skill components 

owned and the dependencies between them.
 For more information on the components of business skills, see 
Creating a business skill component in a diagramand Defining the 
business skill dependencies.

Creating a skill map diagram
To create a business skill map diagram:

 Right-click the business skill map that interests you and select New > 
Skill Map.
The diagram opens in the edit area. The frame of the business skill map
described appears in the diagram.

Creating a business skill component in a diagram
The components represented in a business skill map are Business skills.

 A business skill is a capability acquired by a person or an 
organization through a specific training.

To add a sub-skill to the business skill map diagram:
1. In the diagram insert toolbar, click Business skill component.
2. Click in the frame of the business skill map.

The business skill component creation window opens.
3. Select the business skill that interests you.
4. Click OK.

The business skill component appears in the diagram.
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Defining the business skill dependencies
You can create a dependency link between two business skills to specify that one
business skill is required for the other in the context of a skill map.

To create dependency links between two business skills:
1. In the insert toolbar, click Business Skill Dependency.
2. Click the main business skill, and keeping the left mouse button pressed, 

move the cursor to the business skill required.
3. Release the mouse button.

The link appears in the diagram.

Describing Business Skills
To be able to subsequently check that each business capability is implemented by a
suitable business skill, you must define the required business skills and
functionalities, for each business function.

The Characteristics property page of the business skill provides access to:
• its Owner, by default during creation of the business skill map, the 

current enterprise.
• its Name,
• the text of its Description.

With HOPEX Business Process Analysis a business skill is described by the
following pages:

• the Structure page specifies a list of business skill held and the 
dependencies between them.

 For more details on business skill diagrams, see Creating a 
Business Skill Diagram.

• the Fulfillments page provides access to the list of architecture 
elements that implement the business skill.

• the Usage page, Skill Component section, provides access to the 
business skills that use the described business skill.

 For more details on skills used, see Creating a business skill 
component in a diagram.

• the Usage page, Business Capability section, provides access to the 
business capabilities that require the described business skill.

 For more details on the skills associated with business capabilities, 
see Defining the business skills and functionalities associated with 
business capabilities.

• the Usage page, Business Function section, provides access to the 
business functions that require the described business skill.

Creating a Business Skill Diagram
To create a business skill diagram:

1. Right-click the business skill that interests you and click New > 
Diagram.
The Diagram type selection dialog box opens.

2. Select Skill Diagram.
3. (Optional) Uncheck the Diagram Initialization box.
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4. Click OK.
The diagram opens in the edit area. The frame of the business skill
described appears in the diagram.

To create a business skill component in a diagram, see Creating a business skill
component in a diagram.

To define the dependencies of business skills, see Defining the business skill
dependencies
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DESCRIBING THE FUNCTIONALITY MAP

 A technical functionality map is a set of functionalities with their 
dependencies that, jointly, define the scope of an architecture.

The properties of a functionality map
The Characteristics properties page of a functionality map provides access to:

• its Owner, by default on creation of the business function, the current 
enterprise.

• its Name,
• the text of its Description.

With HOPEX Business Process Analysis a Functionality map is described by:
• the Structure page is used to specify a list of components owned by the 

functionality map and the dependencies between them.
 For more information on the components of a functionality map, 
see Creating a functionality component in a functionality map diagram 
and Defining Functionality dependencies.

Creating a functionality map
To create a functionality map diagram:

 Right-click the functionality map that interests you and select New > 
Functionality Map Diagram.
The diagram opens in the edit area. The frame of the functionality map
described appears in the diagram.

Creating a functionality component in a functionality map diagram
The components represented in a functionality map are Functionality
components.

 A technical functionality is a capability expected from an equipment 
item (hardware or software) to ensure the operation of a technical 
element or an application.

To add a functionality component in the functionality map diagram:
1. In the diagram insert toolbar, click Functionality Component.
2. Click the functionality map frame.

The functionality component creation window opens.
3. Select the functionality that interests you.
4. Click OK.

The functionality component appears in the diagram.
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Defining Functionality dependencies
A dependency link between one functionality and another is used to specify the
elements on which this dependency is based. 

For example, for a "Pizza delivery" functionality, there 
must first be a "Prepare pizzas" functionality. Note that 
the effect of the "Deliver pizzas" functionality is a "Pizza 
delivered" functionality and the effect of the "Prepare the 
pizzas" functionality is a "Cooked pizza".

To create dependency links between two functionalities in a functionality map
diagram:

1. In the insert toolbar, click Functionality Dependency.
2. Click the functionality component, and keeping the left mouse button 

pressed, move the cursor to the functionality component used.
3. Release the mouse button.

The creation window for the functionality dependency opens.
4. Enter the user component result of the user functionality in the 

Dependent Application Effect field.
5. Enter the content result of the functionality used in the Necessary 

Application Effect field.
6. Click OK.

The link appears in the diagram.
 A single sub-functionality can have more than one dependency 
within a single diagram.

Describing functionalities
 A technical functionality is a capability expected from an equipment 
item (hardware or software) to ensure the operation of a technical 
element or an application.

The Characteristics property page of the functionality provides access to:
• its Owner, by default during creation of the functionality, the current 

enterprise.
• its Name,
• the text of its Description.
• its Desired capability effects.
• the Desired Capability Effect is an Outcome.

For example, the desired capability effect of "Displaying 
the status of a reservation" is a "Reservation status"

 For more details on results, see Describing the outcomes.

 For more information on the use of expected functionality effects, 
see Defining Functionality dependencies.
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With HOPEX Business Process Analysis, a functionality is described in the
following pages:

• the Structure page is used to specify a list of functionalities owned and 
the dependencies between them.

 For more information on the structure of functionalities, see 
Creating a Functionality Diagram.

• the Fulfillments page provides access to the list of architecture 
elements that implement the functionality.

• In the Usage page, the Capability Component section provides access 
to the functionality maps that use the described functionality.

 For more details on the relationship between functionalities, see 
Creating a functionality component in a functionality map diagram.

• In the Usage page, the Business Capability section provides access to 
the business capabilities that require the described functionality.

 For more details on the functionalities associated with business 
capabilities, see Defining the business skills and functionalities 
associated with business capabilities.

Creating a Functionality Diagram
To create a functionality diagram:

1. Right-click the functionality that interests you and select New > 
Diagram.
The Diagram type selection dialog box opens.

2. Select Functionality Diagram.
3. (Optional) Uncheck the Diagram Initialization box.
4. Click OK.

The diagram opens in the edit area. The frame of the functionality
described appears in the diagram.

To create a functionality in a diagram, see Creating a functionality component in a
functionality map diagram.

To define the dependencies of sub-functionalities, see Defining Functionality
dependencies
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DESCRIBING COMPONENT FULFILLMENT

To represent the implementation of a component such as a business capability or
functionality you must create a Fulfillment of the component.

Describing Fulfillment of a Business Capability

Creating a business capability realization
A business capability can be achieved either by an application or an application
system, or by an org-unit or an organizational process.

To associate an organizational process with a business capability, you must create
a business capability fulfillment.

 An implementation describes the relationship between a logical 
entity and a physical entity that implements it. The physical entity gives 
the list of logical entities that it implements.

To specify that a business capability is fulfilled by an organizational process:
1. Open the Fulfillments property page of the business capability that 

interests you.
2. Click New.

The creation window for a business capability realization opens.
3. Select Reusing an existing Organizational Process, Application....
4. Select the object type Organizational Process for example.
5. Select the desired Business process and click OK.

The capability fulfillment appears in the list with the name of the selected
process.

Analyzing business capability fulfillment
HOPEX Business Process Analysis provides reports to display fulfillment
coverage of business capability elements by operational elements such as
applications, and according to different perspectives: Organizational, Business/
Data, Logical/Physical Application, etc.

 For more details on fulfillment reports for business capabilities, see 
Breakdown Report of Business Capabilities.

Creating Fulfillment of a Business Skill
A business skill can be fulfilled by an org-unit.
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To associate an org-unit with a business skill, you must create a business skill
fulfillment.

 An implementation describes the relationship between a logical 
entity and a physical entity that implements it. The physical entity gives 
the list of logical entities that it implements.

To specify that a business skill is fulfilled by an org-unit:
1. Open the Fulfillments property page of the business skill that interests 

you.
2. Click New.

The creation window for a business skill realization opens.
3. Select Reusing an org-unit.
4. Select the org-unit that interests you and click OK.

The business skill fulfillment appears in the list with the name of the
selected org-unit.

Creating Fulfillment of a Functionality
A functionality can be achieved either by an application or application system, or at
a conceptual level, by a logical application or application system.

To associate an application with a functionality, you must create a functionality
fulfillment.

 An implementation describes the relationship between a logical 
entity and a physical entity that implements it. The physical entity gives 
the list of logical entities that it implements.

To specify that a functionality is implemented by an application:
1. Open the Fulfillments property page of the functionality that interests 

you.
2. Click New.

The creation window for a functionality realization opens.
3. Select Reusing an existing....
4. Select the Application object type.
5. Select the application that interests you and click OK.

The functionality fulfillment appears in the list with the name of the
selected application.
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BUSINESS PROCESSES

This chapter presents how to describe products or services provided by the enterprise to its
customers.

The business process diagram enables representation of product or service offerings proposed by
the enterprise to each of its markets, as well as the processes that produce these.

The points covered here are:

 Managing Business processes
 Representing Product Offerings
 Representing Process Contextualization
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MANAGING BUSINESS PROCESSES

 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
implementation of the business process in the organization. A business 
process can also be detailed by a functional view.

Prerequisites to use of business processes
One option is used to display the business processes.

To activate this option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Select the Business Process Modeling check box.

Creating a Business Process
To create a business processfrom the Processes navigation pane: 

1. Select Hierarchy.
2. Select Business process folder, click New > Business process.

The creation dialog box of a business process opens.
3. Modify the name of the business process.
4. Specify the Owner.
5. Click OK.

The business process is created and added to the list of business
processes.

With HOPEX Business Process Analysis, business processes are described by
diagrams.

Creating a Business Process Diagram
To create a business process diagram:

1. Right-click the business process name and select New > Diagram.
The Diagram type selection dialog box opens.

2. Select Business Process Diagram.
3. (Optional) Uncheck the Diagram Initialization box.
4. In the Edit Mode section, select Edit diagram with graphical entry.
5. Click OK.

The diagram opens in the edit area. You are now in the HOPEX graphic
editor. The frame of the described business process appears in the
diagram.
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For more information on a business process diagram initialization with HOPEX
Business Process Analysis, see Organizational Process Diagram initialization.

Using an Organizational rocess in a Business Process Diagram
In a business process diagram, you can create an organizational process or reusing
an existing one.

 In tabular entry mode, you can insert in your diagram an 
organizational process using the Connect button. Then you must 
specify the previous and next elements.

Using a system process in a Business process diagram
 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
implementation of the business process in the organization. A business 
process can also be detailed by a functional view.
 For more details on creating system process diagrams, see the 
HOPEX IT Architecture guide, paragraph "describe Processes".


Prerequisites to using System Processes

One option is used to display the System Processes:
1. In the workspace, open the Options navigation window.
2. In the left tree, select HOPEX Solutions > Business Process 

Analysis.
3. Select the System Process modeling box. 
4. Click Apply.

Accessing the list of System Processes with HOPEX Business Process Analysis

To access the list of system processes from the Process Design navigation pane: 
 Select System Processes > System Processes List > All System 

Processes.

Inserting a system process in a business process diagram

To display risks in a process diagram with their likelihood:
1. Select Views and Details button of the diagram.
2. In the right pane of the window, select “System Processes” view.
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REPRESENTING PRODUCT OFFERINGS

The business process diagram enables representation of product or service offerings
proposed by the enterprise to each of its markets, as well as the processes that
produce these.

In the example above, the enterprise is targeting two 
customer segments: tourists and business travelers.
In the case of vehicle rental, the enterprise also proposes 
hotel reservation.
In the case of business travelers, the enterprise also 
proposes car and hotel reservations, as well as Contract 
negotiation.

Defining Offerings
Offerings are proposed by enterprise business processes to participants outside the
enterprise.

 An offering represents the availability of a product or service 
supplied by an enterprise through a specific process.

Creating an offering
To create a offering from a Business process diagram:

1. Click the Offering button. 
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2. Click the business process and, holding the mouse button down, draw a 
link to the participant. 

3. Release the mouse button.
The link representing the offering appears in the diagram.

Defining offering products
 A product represents commodities offered for sale, either goods or 
merchandise produced as the result of manufacturing, or a service, ie. 
work done by one person or group that benefits another.

To specify the detail of offerings of products:
1. Open the Characteristics property page of the offering that interests 

you.
2. In the Product section, click the New button and enter the product 

name.
The name of the product appears in the diagram.

 A product can be broken down into component products from its 
properties page or from the navigator.

Describing offering implementation
Use the business process diagram of the process that is linked to the offering to
describe the organization and exchanges that are associated with it.

In this way, when you initialize a Business process diagram of a process, a flow
is automatically created for each offering.

 For more details on business process diagrams, see Creating a 
Business Process Diagram.
 For more details on flows, see Defining Message Flows.

Flows and contents are automatically created. 

In the example above, a flow is created to describe the 
Contents that support the car rental and the hotel 
reservation.
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Launching a Report Illustrating Product Offerings
From the property page Reporting > Products x Markets of a business process,
you can launch a report in the form of a matrix to illustrate product offerings.

This matrix presents:
• the products in columns
• the org-units in rows
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REPRESENTING PROCESS CONTEXTUALIZATION

Contextualization enables to represent, in a business process diagram, the context
in which the organizational processes or value chains that make up a business
process are used.

 To represent the implementation of a value chain by an 
organizational process using fulfillments, see Representing the value 
stream fulfillment with HOPEX Business Process Analysis.

“Provide  Vacation Service“ Business Process Diagram

Dedicated organizational processes are associated to the 
business process value streams

Prerequisites to using contextualizations
An option is used to display the Contextualizations.

To activate this option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Select the Use of Contextualizations check box.
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Defining Contextualizations
Contextualizations enable the association of processes between each other.

 A contextualization allows specification of the implementation of a 
process by another process in a specific context, such as the 
geographical location on a site.

Creating a contextualization
To create a contextualization:

1. Click the Contextualization button 
2. Click the process to be implemented and, holding the left mouse button 

down, draw a link to the process describing implementation. Release the 
mouse button.
The link representing the contextualization appears in the diagram.

Defining context
To specify the context in which a process implements another process:

1. Open the Characteristics property page of the contextualization that 
interests you.

2. In the Implementation Context section, click the Connect button.
3. In the window that opens, select the context type, org-unit or site.
4. Click the Find button.
5. In the list that opens, select the org-units or sites concerned and click 

Connect.
6. Click OK.
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Launching a Report Illustrating Contextualizations
From the property page Reporting > Contextualization of a business process,
you can launch a report in the form of a matrix to illustrate product offerings.

This matrix presents:
• the value streams of the business process in columns
• the organizational processes of the business process in rows

To view a specific context (org-unit, site or product):
 Click arrow  in the cell.
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THE CUSTOMER JOURNEY

The  HOPEX Customer Journey Product is used to represent the acquisition process of a product
or a service by a specific customer. Mapping a customer journey provides an overview of customer
expectations, painpoints encountered, and the resources used at each step of the journey. Last but
not least, touchpoints, which are the points of interaction between the customer and the company,
are used to measure and improve overall customer satisfaction.

Representing a customer journey will allow you to easily identify these critical points. HOPEX
Customer Journey is used to describe solutions for improvement and to assess them at different
dates.

The points covered here are:

 HOPEX Customer Journey product presentation
 Managing the Components of a Customer Journey
 Assessment of a customer journey
 The reports available on a customer journey
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HOPEX CUSTOMER JOURNEY PRODUCT PRESENTATION

Associated with HOPEX Business Process Analysis and HOPEX IT Business
Management , HOPEX Customer Journey product supports the methodology
and the tools that are used to describe and improve the acquisition process of your
products and services.

The methodology embedded in the HOPEX Customer Journey product is based on
the features of the HOPEX Suite to describe and manage the different project
phases and steps in the customer journey.

Last but not least, the  HOPEX suite assessment tool is used to record, over time,
an assessment of the steps in the customer journey. The consolidated results of
these assessments are visible in the customer journey diagrams. Standard reports
are also available to facilitate analysis of the journey and help with identifying a
solution for improvement.

This presentation is based on the example of a travel agency 
that offers different types of holidays to different types 
of customers.

The HOPEX Customer Journey Product is introduced here by :
• Description of a Customer Journey
• Assessing a Customer Journey

Description of a Customer Journey
To be able to benefit, at the end of your customer journey representative work, from
the analysis facilities offered by HOPEX Customer Journey, we recommend you
follow the methodological steps shown in the diagram below.
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Defining persona and business lines
This consists of preparatory work identifying the different types of customers
according to their needs and what they bring to the company.

The purpose of this phase is to identify the persona as well as the business lines. 
 A persona corresponds to a customer segment targeted by the 
experience of the client journey. The resources implemented to give 
customers the ability to interact with the enterprise and its 
environment, to acquire the expected results, are supported by the 
interaction channels.

 A business line is a high level classification of main enterprise 
activities. It corresponds for example to major product segments or to 
distribution channels. It enables classification of enterprise processes, 
organizational units or applications that serve a specific product and/or 
specific market.

Using our example of the travel agency, we are interested in 
the young adult segment. The business line preferred for 
this population is "Sports holidays".

You must begin by assessing the customer expectations  for each persona.
 A customer expectation is an enterprise result expected by the 
persona at the end of the journey.

For example, a population of young adults can expect, with a 
sports holiday, a wide range of activities in an exceptional 
setting for a reasonable price.

From a methodological point of view, we suggest you proceed as follows:
1. Identify the customer segments,
2. Define, via the hierarchy, the persona groups  and the persona 

associated with each segment,
 For more details, see Defining persona hierarchy. and Creating a 
persona. 

3. Identify the org-units that correspond to the segments,
 For more details, see Creating a persona.

4. Create customer expectations for a given persona,
 For more details, see Specifying the expectations of a persona.

5. Create the business lines.
 For more details, see Creating a business line.

Defining the customer journey
Each customer journey corresponds to a specific persona . So, when the persona
are identified, you can create customer journeys.

 If you wish, you can also create the customer journey first and the 
persona second.

 A customer journey is used to describe and organize all interactions 
between the enterprise and a persona for a given result.

We can, for example, build the customer journey that 
corresponds to a "sports holiday" for a "young adult" 
persona.

 For more details, see Creating a customer journey.
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Defining the phases of a customer journey
A customer journey is described by a number of sequenced phases.

 A customer journey phase is a time or experience-bound period 
within a Customer Journey.

In the example "sports holiday", we identify three phases: 
the "selection of holidays", the "qualification of 
holidays" selected and the holiday "reservation".

 For more details, see Defining the customer journey phases in 
tabular input mode.

Defining the steps in a customer journey
The customer journey steps are closely linked to the business line. The customer
journey steps are organized to most closely represent reality. They are essential
because the assessments deal with each of the steps of a customer journey.

 A customer journey step is the basic elementary advancement unit 
of a customer via a customer journey phase.

In the "reservation" phase of the holiday, we can identify 
the following steps: "Validate the order", "Complete the 
customer information", "Proceed with payment".

Finally, the resources used at each step of the customer journey are represented by
channels . 

 A channel is used to identify the enterprise resources used by a 
persona to achieve a step. For example, a channel can be a phone or 
internet connexion.

In our example for selling sports holidays, the resources 
made available to customers are advertising brochures, web 
applications and a support service to answer customer 
questions.

To describe the steps of a customer journey, we suggest you proceed as follows:
1. Define the customer journey steps associated with each phase.

 For more details, see Creating the customer journey steps in 
tabular input mode.

2. Describe the sequences that link the steps.
 For more details, see Organizing the customer journey steps in 
tabular input mode.

3. Link the steps to the channels concerned.
 For more details, see Defining the channels in a customer journey.
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At this stage, the diagram that you are building with HOPEX Business Process
Analysis looks like the figure below.

Understanding customer expectations and painpoints
Each customer journey step can be linked to:

• One or more customer expectations.

 An external org-unit is an external entity that exchanges flows with 
the enterprise. Example: customer, supplier, government office.

The expectations of young adults for a sports holiday can 
concern the context of the holiday or activities offered.

 For more details, see Adding persona expectations to customer 
journey mapping.

• One or more Painpoints.

 A painpoint describes the difficulties encountered by a persona 
when carrying out a step in the customer journey.

The painpoints of a group of young adults can concern the 
painpoint of agreeing, prices that are too high or the 
possibilities of accessing the vacation site.

 For more details, see Defining customer painpoints.

Identifying the touchpoints
The objective is to identify the organizational elements that are used during the
customer journey and that could have an impact on customer satisfaction.

 A touchpoint describes an interaction between a persona and an 
enterprise.

The touchpoints between the customers and the travel agency 
are by telephone and by email. A support center can thus be 
put in place.

 For more details, see Creating an involved resource in a customer 
journey.
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Each touchpoint can be linked to:
• One or more Involved Resources.

 A resource is a means used to perform certain actions.

An operator able to answer to questions about a specific 
holiday, is an Involved resource.

 For more details, see Creating an involved resource in a customer 
journey.

• One or more business opportunities.

 An opportunity characterizes an improvement action for one of the 
composite elements of the customer journey (steps, touchpoint).

To be able to offer another holiday if the holiday selected 
is no longer available constitutes a business opportunity.

 For more details, see Defining the business opportunities of a 
customer journey.

• One or more Painpoints.

Identifying moments of truth
 A moment of truth is a decisive step for the remainder of the 
customer journey. Either customers believe that they cannot obtain 
what they are searching for under the desired conditions and they are 
not satisfied; Or, on the contrary, they believe that they have found 
what they are looking for and continue the journey.

A reservation that is too late constitutes a moment of 
truth. The sports holiday is completed or, on the contrary, 
it was canceled due to low staff numbers.

 For more details, see Identifying a Moment of truth.

Following this last description step of your customer journey, you obtain a diagram
that looks like this.
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Assessing a Customer Journey
Customer satisfaction can be assessed at each Step of the customer journey on a
list of criteria by a number of people on different dates.

 A customer journey step is the basic elementary advancement unit 
of a customer via a customer journey phase.
 For more details, see Assessment of a customer journey.

The assessment criteria are presented in a questionnaire specific to each customer
journey. 

The results of the assessments filled in for the steps of a customer journey are then
consolidated and accessible from:

• Reports available on a customer journey,
 For more details, see The reports available on a customer journey.

• The shape of the steps in the diagram of the customer journey which is 
different depending on the results of the assessment,

• The Customer Journey > Assessments > Assessed Customer 
Journeys,

• The Assessment properties page of the customer journey.
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The following points are covered here:
• Describing persona and persona groups,
• Using Business Lines,
• Building a customer journey,
• Describing the Steps of a Customer Journey,
• Client Expectations and Painpoints,
• The Touchpoints of a Customer Journey,
• Creating an Action Plan for a Customer Journey.

Describing persona and persona groups
This phase consists of identifying the different customer segments according to their
needs and what they bring to the company. 

 A persona corresponds to a customer segment targeted by the 
experience of the client journey. The resources implemented to give 
customers the ability to interact with the enterprise and its 
environment, to acquire the expected results, are supported by the 
interaction channels.

Defining persona hierarchy
 A persona group is grouping of personas according to similar 
objectives on several customer journeys.

To create a Persona Group: 
1. Open the Customer journey navigation window.
2. Select Customers > Persona Groups.

The tree of persona group is displayed in the edit area.
3. Click on the tree root to display its pop-up menu and select New > 

Persona Group.
The Creation of a Persona Group window appears.

4. Enter the name of the group.
"Sports clientele" and "Young clientele", for example.

5. Click OK to close this dialog box. 
The persona group that you have just created appears in the tree of the
Persona Group.

Creating a persona
 A persona corresponds to a customer segment targeted by the 
experience of the client journey. The resources implemented to give 
customers the ability to interact with the enterprise and its 
environment, to acquire the expected results, are supported by the 
interaction channels.

You can create a persona from a persona group or from of the persona tree.
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You can create a persona from the persona tree. 
1. Open the Customer journey navigation window.
2. Select Customers > Persona.

The Persona tree appears in the Edit Area.
 With the HOPEX IT Business Management  solution, Personas 
are Business Partners.

3. Right-click the tree root to open its pop-up menu and select New > 
Persona.
The creation window opens.

4. Enter the name of the persona.
5. "Young adults", for example. Click OK to close this dialog box. 

The persona you have just created now appears in the persona tree.

Specifying the fulfillment of a persona
 The fulfillment of a persona enables to associate a persona to Org-
Units described in your repository.

To specify the fulfillment of a persona:
1. Open the Characteristics property page of the persona that interests 

you and expand the Realization of Persona section.
2. Click New.

The Creation of Realization of Business Agent window appears.
3. Select Org-Unit in the Object Type field.
4. Select the required Org-Unit in the Business Agent Realizer field.
5. Click Add.

The fulfillment of the persona is added.

Specifying the expectations of a persona
 A customer expectation is an enterprise result expected by the 
persona at the end of the journey.

To create a Customer Expectation from a persona: 
1. Open the Characteristics property page of the persona that interests 

you and expand the Customer Expectation section.
2. Click New.

The Creation of a Client Expectation window appears.
3. Enter the name of the customer expectation.
4. Click OK. 

The customer expectation is added to the list of persona expectations.

Using Business Lines

Creating a business line
 A business line is a high level classification of main enterprise 
activities. It corresponds for example to major product segments or to 
distribution channels. It enables classification of enterprise processes, 
organizational units or applications that serve a specific product and/or 
specific market.
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To create a business line: 
1. Open the Customer journey navigation window.
2. Select Customers > Business Lines.

The business line tree appears in the edit area.
3. Click on the tree root to display its pop-up menu and select New > 

Business Line.
The Creation of a Business Line window appears.

4. Enter the Name.
5. Click OK to close this dialog box. 

The business line appears in the business line tree.

Connecting a business line to a customer journey
Customer journeys connected to a business line are accessible from the
Characteristics property page of the business line, in the Customer journey
section.

 For more details, see Connecting a customer journey to a business 
line.

Building a customer journey

 A customer journey is used to describe and organize all interactions 
between the enterprise and a persona for a given result.

A customer journey is associated with a persona. Therefore, a customer journey can
be created in three different ways:

• From a persona or a persona group,
• From a customer journey group,
• Directly from the Customer Journey navigation pane.

Creating a customer journey
To create a Customer Journey from the Customer Journey navigation pane: 

1. Select Customer Journeys > Customer Journeys.
A list of customer journeys is displayed in the edit area.

2. Click the New button.
The Creation of a Customer Journey window appears.

3. Enter the Name.
4. Click OK to close this dialog box. 

The customer journey appears in the customer journey tree.

Connecting a customer journey to a persona

To connect a persona to a customer journey: 
1. Display the customer journeys list.
2. Select the Customer Journey line that interests you.
3. Click in the Persona column.

 With the HOPEX IT Business Management  solution, Personas 
are Business Partners.
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4. Select the persona (or the business partner) that interests you.
 The persona associated with a customer journey is accessible in the 
Characteristics property page of the customer journey.

Connecting a customer journey to a business line

To connect a business line to a customer journey: 
1. Open the Characteristics property page of the customer journey that 

interests you and expand the Business Line section.
2. Click Connect.

Select the business line that interests you.
 The customer journey is accessible in the Characteristics page the 
business line.

Creating a customer journey group
 A customer journey group consolidates the journeys that comply 
with similar criteria.

To create a  customer journey group: 
1. Open the Customer journey navigation window.
2. Select Customer Journey > Customer Journey Groups.

A list of customer journey groups  is displayed in the edit area.
3. Click on the tree root to display its pop-up menu and select New > 

Customer Journey group.
The Creation of a Customer Journey Group window appears.

4. Enter the name of the group.
“Sports holidays” and “cruises”, for example.

5. Click OK to close this dialog box. 
The Customer Journey group that you have just created appears in the
tree of the Customer Journey Group.

Using the Characteristics properties page of the customer journey, you can then
connect the customer journey to the group.

Creating a mapping of the customer journey in tabular entry mode
Mapping of the customer journey can be created and updated using tabular entry
mode.

 Tabular entry mode is available with the HOPEX Web Front-End 
product. For more information on using tabular entry, see the "Entering 
a diagram in tabular mode" in the HOPEX Common Features guide.
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To create a mapping of the customer journey:
 Select the customer journey that interests you and click Create 

Diagram.

The UI of the table input mode opens in the edit area. The tabs available
are Phases and Steps.

 If a mapping already exists for the selected customer journey, the 
preview button allows you to access it. 

Defining the customer journey phases in tabular input mode
 A customer journey phase is a time or experience-bound period 
within a Customer Journey.

A customer journey is described by several sequenced phases.
 The list of phases of a customer journey is accessed from the 
Characteristics properties page, in the Phases section.

Diagram of a customer journey connected to a persona and a business line with phases

Creating a customer journey phase in tabular input mode

To create a phase in tabular input mode for a customer journey:
1. Click the Phases tab.
2. Click New.

The Add Phase wizard allows you to create a new phase or connect an
existing phase.

3. Click on the name of the phase to update it.
If you are in Auto Refresh mode, the diagram is automatically updated,
otherwise click Refresh Diagram to display the new phase in the
diagram.

Ordering the customer journey phases in tabular input mode

By default, the phases are ordered in the order of creation. 

To modify the order of a customer journey using its diagram:
1. Click the Phases tab to access the list of diagram phases.
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2. Select the phase whose order you want to modify and click in the Order 
column.

3. Modify the value of the order of the phase.
 If you enter an order number that already exists, the order of 
creation remains the same in the diagram.

Create several customer journey phases simultaneously

To simultaneously create several ordered phase for a customer journey:
1. Click the Multiple Add button. 

A creation window appears.

2. Enter the Number of phases you wish to create.
3. If you wish to create phases with steps, specify the Number of Steps 

that you wish to create for each phase.
 The steps created in the same phase are sequenced.

4. Click OK.

Describing the Steps of a Customer Journey

 A customer journey step is the basic elementary advancement unit 
of a customer via a customer journey phase.

A customer journey is described by several sequenced steps.
 The list of steps of a customer journey is accessed from the 
Characteristics property page, in the Steps section.

You can, for example, proceed as follows:
1. Creating the customer journey steps in tabular input mode,
2. Organizing the customer journey steps in tabular input mode,
3. Defining the channels in a customer journey.
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Creating the customer journey steps in tabular input mode

Create a customer journey step

To create a step using tabular entry mode for a customer journey:
1. Click the Step tab.
2. Click New.

The Choose Object Type window appears. 
 A step can be associated to a Sub customer journey. The choice 
of the object type allows you to create a customer journey.

3. Select Steps and click OK.
The new step appears in the list of journey phases.

4. Click on the name of the step to update it.
The step created appears in the diagram outside of the phase area.

Create several steps simultaneously

To create several steps in tabular input mode simultaneously:
1. Click on the step starting from which you wish to create the other steps.
2. Click the Multiple Add button. 

A creation window appears.

3. Enter the Number of Steps you wish to create.
4. Choose Sequenced Steps or Independent Steps.
5. Click OK.

 The steps are created but are not connected to a phase.

Organizing the customer journey steps in tabular input mode
By default, steps are not associated with phases and they are not sequenced.

Defining the sequencing of a customer journey

To define the sequencing order of the steps of a customer journey, you must specify
the list of predecessors at each step.

To specify the predecessor of a step of a customer journey from its diagram:
1. Click the Steps tab to access the list of diagram steps.
2. Select the step concerned and click OK.

A window opens with the list of steps of the diagram that can be
connected.
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3. Select the step concerned.
 You can select several steps.

4. Click outside of the selection pane of the steps.
The organization of the steps in the diagram are automatically updated.
Connections are created between each other.

Specify the phase of a customer journey step

To specify that a customer journey step is performed within the context of a journey
phase: 

1. Click the Steps tab to access the list of diagram steps.
2. Select the step that you want to connect to a phase and and click Phase.

Use the down arrow to easily access the list of customer journey phases.
3. Select a phase in the list proposed.

The step is moved to the swimlane that corresponds to the phase.

Defining the channels in a customer journey
 A channel is used to identify the enterprise resources used by a 
persona to achieve a step. For example, a channel can be a phone or 
internet connexion.

The channels of a customer journey are also linked to the steps of the journey that
uses them.

To create a customer journey channel in tabular input mode 
1. Click the Steps tab of the mapping of the customer journey to access 

the list of steps of the customer journey.
2. Select the step that you want to connect to a channel and click Channel.

 Use the down arrow to easily access the list of customer journey 
channels and connect the step to a channel that already exists.

3. Click the right facing arrow and select the Create Channel command.
The Creation of Channel window appears.

4. Enter the Name.
5. Click OK to close this creation window.

The channel is created and appears in the list. The step is automatically
moved to the line that corresponds to the channel.

Diagram of customer journey with steps and channels
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Client Expectations and Painpoints
The expectations and painpoints are specific to each persona with respect to a
customer journey step.

Adding persona expectations to customer journey mapping
 An external org-unit is an external entity that exchanges flows with 
the enterprise. Example: customer, supplier, government office.

The expectations of a customer journey are also connected to personas and they
must also be connected to the steps in the customer journey that use them.

 The list of expectations of a customer journey is accessed from the 
Characteristics properties page, in the Customer Expectations 
section.
 The list of expectations of a persona is accessed from the 
Customer Journey properties page of the persona, in the Customer 
Expectations section.
 For more details, see Specifying the expectations of a persona.

To specify that a new customer expectation is connected to a customer journey: 
1. Select the mapping of customer journey that interests you.
2. Click the Steps tab to access the list of steps in the customer journey.
3. Select the step that you wish to connect to an expectation and click in 

the Expected Results.
 Use the down arrow to easily access the list of customer 
expectations of the customer journey.

4. Select the expectations that you want to connect to the step and click on 
the outside of the selection window pane.
The customer expectations selected appear in the swimlane of the step.

 To create a new customer expectation, enter its name. The new 
customer expectation appears in the list of customer journey 
expectations.

Defining customer painpoints
 A painpoint describes the difficulties encountered by a persona 
when carrying out a step in the customer journey.

To specify that a new painpoint is connected to a customer journey: 
1. Click the Steps tab to access the list of steps in the customer journey.
2. Select the step concerned and click in the Painpoint column.

The list of painpoints connected to the mapping of the customer journey
is displayed.

3. Select the painpoints that you want to connect to the step and click on 
the outside of the selection window pane.
The painpoints selected appear in the swimlane of the step.

 To create a new painpoint, enter its name. The new painpoint 
appears in the list of journey painpoints.
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The Touchpoints of a Customer Journey

 A touchpoint describes an interaction between a persona and an 
enterprise.

A touchpoint is used to identify the organizational elements, used during the
customer journey, that could have an impact on customer satisfaction. A touchpoint
is connected on the one hand to a step and its channels and painpoints, and on the
other hand to business improvement opportunities.

In the diagram, the touchpoints, the channels and the painpoints and the business
opportunities are in the same swimlane as the customer journey step.

 The list of touchpoints of a customer journey is accessed from the 
Characteristics property page of the customer journey, in the 
Touchpoint section.
 The list of painpoints of a customer journey is accessed from the 
Characteristics property page of the customer journey, in the 
Painpoint section.
 For more details on painpoints, see Defining customer painpoints.

Creating an involved resource in a customer journey
 A resource is a means used to perform certain actions.

An involved resource may be an actor, an application or an organizational process.

To create an involved resource in a customer journey: 
1. Click the Steps tab to access the list of steps in the customer journey.
2. Select the step that you wish to connect to an involved resource and click 

in the Involved Resource column.
The list of involved resources connected to the mapping of the customer
journey is displayed.
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3. Select the involved resources that you want to connect to the step.
The selected involved resources appear in the swimlane of the step inside
the touchpoint shape.

 To create a new involved resource, enter its name. A wizard opens 
prompting you to specify its type. The new involved resource appears in 
the list.

The touchpoint shape is modified.

Step connected to a touchpoint

Defining the business capabilities of a customer journey
 .A business capability is a set of features that can be made 
available by a system (an enterprise or an automated system).

To specify that a new business capability connected to customer journey step.  
1. Click the Steps tab to access the list of steps in the customer journey.
2. Select the step that you wish to connect to a business capability and click 

in the Involved business capability column.
The list of business capabilities connected to the mapping of the customer
journey is displayed.

3. Select the business capability that you want to connect to the step.
The selected business capabilities appear in the swimlane of the step.

 To create an business capability, enter its name. The new business 
capability appears in the list.

The selected business capabilities appear inside the paintpoint of the step
and their are automatically connected to the step.

 The list of business capabilities connected to a paintpoint can be 
accessed from the Characteristics property page of the painpoint, in 
the Customer journey section.

Defining the business opportunities of a customer journey
 An opportunity characterizes an improvement action for one of the 
composite elements of the customer journey (steps, touchpoint).

To specify that a new business opportunity is connected to a customer journey:  
1. Click the Steps tab to access the list of steps in the customer journey.
2. Select the step that you wish to connect to a business opportunity and 

click in the Opportunity column.
The list of opportunities connected to the mapping of the customer
journey is displayed.
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3. Select the opportunity that you want to connect to the step.
The opportunities selected appear in the swimlane of the step.

 To create an opportunity, enter its name. The new opportunity 
appears in the list.

The business opportunities selected appear in the swimlane of the step
directly under the touchpoints of the step and are automatically
connected.

 The list of opportunities connected to a touchpoint is accessed from 
the Characteristics property page of the touchpoint, in the 
Opportunities section.

Identifying a Moment of truth

 A moment of truth is a decisive step for the remainder of the 
customer journey. Either customers believe that they cannot obtain 
what they are searching for under the desired conditions and they are 
not satisfied; Or, on the contrary, they believe that they have found 
what they are looking for and continue the journey.

To specify the steps of a customer journey that constitute moments of truth: 
1. Click the Steps tab to access the list of steps in the customer journey.
2. Select the Moment of Truth column.

Check boxes appear on each row of the column.
3. Select the check box that corresponds to the step you wish to specify as 

a moment of truth.
The step shape is modified.

Step declared as a moment of truth

 In the Characteristics property page of the selected step, the 
check box Moment of Truth is checked.

Creating an Action Plan for a Customer Journey
Following the identification of possible improvements to a customer journey, it is
possible to create an action plan from a touchpoint.

 An action plan comprises a series of actions, its objective being to 
reduce risks and events that have a negative impact on company 
activities.

To create an action plan from a customer journey touchpoint: 
1. Click the Steps tab to access the list of steps in the customer journey.
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2. Select the step that you want to connect to an action plan and click in the 
Action Plan column.
The list of action plans connected to the mapping of the customer journey
is displayed.

3. Select the action plan that you want to connect to the step.
 To create an action plan, enter its name. The new action plan 
appears in the list.

The action plans selected appear in the swimlane of the step.
 The list of action plans of a customer journey is accessed from the 
Characteristics properties page, in the Action plan section.
 For more information on using action plans, see the “Using action 
plans" in the HOPEX Common Features guide.
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ASSESSMENT OF A CUSTOMER JOURNEY

The objective of the HOPEX Customer Journey product is to describe your
customer journeys with a view to improving efficiency. By performing assessments,
you can acquire valuated information and compare it.

With HOPEX Customer Journey, assessments are made using questions attached
to channels. It is therefore possible to measure improvements made through the
implementation of touchpoints on the sensitive steps of the journey.

HOPEX Customer Journey is based on assessment functionalities to define the
questions and obtain the assessments of the steps of your customer journeys.

The following points are covered here:
• Defining Questions for the Assessment of a Customer Journey,
• Assessing a Customer Journey,
• Consolidating results and assessments.

Defining Questions for the Assessment of a Customer Journey
With HOPEX Customer Journey , you assess the tools used by the persona for a
customer journey. As a result, the questions are connected to the channels of the
customer journey steps. The assessment of the customer journey takes place via
questions that concerns each channel-step pair.

To create a question:
1. From the Customer Journey navigation pane.
2. Select Assessment > Questions.

A tree with the list of channels appears.
3. Open the Assessment Instrument property page of the channel that 

interests you.
4. Click the New button.

The assessment template creation dialog box opens.
5. Enter the assessment template name and click the OK button.

 For more details on the management of specific questions, see 
"Presentation of the Questionnaire Builder” chapter in the HOPEX 
Common Features guide.


6. To be able to asses your customer journey, you have to create at least 
one Drop-down list question.

7. Then, you have to create the five items required for the customer 
journey assessment consolidation.

 For more details on calculating assessment values, see 
Consolidation rules

8. Click the Save and Close button .
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Assessing a Customer Journey
When the questions have been defined, the customer journey can be assessed.

Access the customer journeys for the assessments
Access to the customer journey is different depending on what you want to do:

To access the list of customer journeys that have never been assessed:
 Select Assessment > Non Assessed Customer Journeys.

To consult the results of the assessment consolidation of a customer journey:
 Select Assessment > Assessed Customer Journeys.

 For more details on calculating assessment values, see 
Consolidation rules

To assess a customer journey that has already been assessed:
 Select Customer Journeys > Customer Journeys.

Answering questions for the assessment of a customer journey
To assess a customer journey for the first time:

1. Select Assessment > Non Assessed Customer Journeys.
The list of non-assessed customer journeys is displayed.

 To access a customer journey that has already been assessed, 
select Customer Journeys > Customer Journeys.

2. Select the customer journey that interests you and, from the More 
button, select Evaluate.
The properties dialog box for the window appears.

3. Answer the questions by selecting the assessment level among the 
proposed itmes and click OK.

 For more details on calculating assessment values, see Defining 
Questions for the Assessment of a Customer Journey
 To assess a customer journey that has already been assessed: 
open the Customer journey navigation pane, select Customer 
Journeys and click More > Evaluate.

Consolidating results and assessments

Consolidation rules
Each answer to a question is associated with a value included between 1 and 5.

Overview

The assessment results presented in the diagrams, the lists and properties pages
are in general the values of the latest assessment.
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Only the reports present average results. The calculation rules for averages are
always the same irrespective of the object: 

 The average value of the assessments of an object is the average of the 
assessment values of the object for a given period.

For example, if for the question "Rapidity of web 
application" the first answer was "High" (value 5) and a 
second answer was "Too slow" (value 1), then the average 
value of assessments equals""(Value 3)

Value of the latest assessment of a question

The value of the latest assessment of a question is used to calculate the values of
the last assessment of the steps for which the answers were given.

Value of the latest assessment of a step

Each of the questions associated with a channel are asked for all steps that use the
channel.

For example, the web application channel is used for all the 
steps in the "Holiday reservation" phase.
The questions on the "Application web" channel can deal with 
its "Rapidity" and its "Conviviality"

The value of the latest assessment of a step is used to calculate the assessment
values of a channel if answers were given.

The value of the last assessment of a step is the average of the values of the latest
assessment of each of the questions relating to the step.

For example, the value of the "Proceed to payment" step is 
the average calculated using the value of the latest 
assessment given to the "Rapidity" and to "Conviviality".

Value of the latest assessment of a channel

The value of the latest assessment of a channel is the average of the values of the
latest assessment of each of the steps connected to the channel.

Value of the latest assessment of a customer journey

The value of the latest assessment of a customer journey is used to calculate the
assessment values of a customer journey group and a persona.

The value of the latest assessment of a customer journey is the average of the
values of the latest assessment of each of the steps in the customer journey.

Value of the latest assessment of a customer journey group

The value of the latest assessment of a customer journey group is the average of
the values of the latest assessment of the customer journey of the group.
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Value of the latest assessment of a Persona

The value of the latest assessment of a persona is used to calculate the assessment
values of a persona group.

The value of the latest assessment of a persona is the average of the values of the
latest assessment of the customer journeys connected to the persona for a given
period of time.

Value of the latest assessment of a Persona Group

The value of the latest assessment of a persona group is the average of the values
of the latest assessment of the group persona.

Consolidated results
The consolidated results on the customer journey are presented in:

• Diagrams,
 For more details, see Representation of consolidated results in the 
diagrams.

• Lists,
 For more details, see Representation of consolidated results in the 
lists.

• Dedicated reports.
 For more details, see The reports available on a customer journey.
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Representation of consolidated results in the diagrams

After assessment of a customer journey, the shape of the steps in the customer
journey diagram is modified to present the results of the latest assessment of steps.

 For more details on calculating the value of the assessment, see 
Value of the latest assessment of a step

Mapping a journey after assessment
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Presentation of the shape of steps differs according to the consolidated result of assessments.

Representation of consolidated results in the lists

After assessment of a customer journey, the consolidated results of the latest
assessment appears in the lists. For example:

• In the Assessment > Assessed Customer Journeys folder,
• In the properties page for the customer journey in the Assessments 

tab.
 For more details on calculating the value of the assessment, see 
Value of the latest assessment of a step

Journey step Comment

Customer satisfaction very low

Customer satisfaction low

Customer satisfaction neutral

Customer satisfaction high

Customer satisfaction very high

Customer satisfaction not assessed
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THE REPORTS AVAILABLE ON A CUSTOMER JOURNEY

This paragraph presents the list of reports available from the Report property page
of a customer journey.

• Global satisfaction
• Improved scope

Global satisfaction
This report presents the results of the satisfaction of persona with the various
customer journeys.

Report parameters

Persona satisfaction

The first chapter presents a summary view of the satisfaction of persona with the
customer journey for given dates.

• The x-axis carries the dates of the assessment period.
• The y-axis carries the value of the latest assessment of persona. 

The table under the curve indicates the value of the latest assessment of
each persona at different dates.

 For more details on calculating the satisfaction of a persona, see 
Value of the latest assessment of a Persona.

• The figure presents a curve by persona and a curve that presents the 
average.

Parameter Parameter type Constraints

Assessment 
values

"All assessment values" or 
"Latest assessment values"

Mandatory

From Date Date Today’s date by default.

To Date Today’s date by default.
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Satisfaction of  customer journey groups

The table is organized as follows:
• Each row is associated with a customer journey group assessed between 

the two dates given as a parameter. 
 The group expands to show the results of the customer journeys to 
which they are connected.

• Each column is associated with a persona
• The cells present the satisfaction of the persona with the corresponding 

journey group (or with the customer journey itself).
 For more details on calculating the satisfaction of the persona for a 
customer journey, see Value of the latest assessment of a customer 
journey and Value of the latest assessment of a customer journey 
group.

Improved scope
This report presents the assessment results with respect to the resources associated
with the touchpoints.
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Report parameters

Assessment of the scope

The first chapter of this report presents a bubble chart that is used to assess the
efficiency of the touchpoints with respect to the assessment period.

• Each bubble represents a touchpoint.
• The size of the bubble represents the number of customer journeys that 

use the touchpoint resource.
• The color of the bubble represents the average value of the assessment 

of the resource for the steps assessed.
• The x-axis shows the number of touchpoints to which the resource is 

connected.
• The y-axis presents the average value of the assessment of the resource 

for the steps assessed.
 The x-axis presents the same information as the colour of a bubble. 
Thus, the red bubbles are at the bottom of the diagram and the green 
bubbles are on top.

Parameter Parameter type Constraints

Assessment 
values

"All assessment values" or 
"Latest assessment values"

Mandatory

From Date Date Mandatory, today’s date by default.

To Date Mandatory, today’s date by default.
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The table under the bubble diagram specifies the value of the latest
assessment of each person at different dates.

 For more details on calculating the satisfaction of a persona, see 
Value of the latest assessment of a customer journey.
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The latest table of the report details the data presented in the bubble diagram.
• Each row is associated with a resource (if appropriate connected to a 

number of touchpoints).
• The first column specifies the average value of the assessment of the 

resource for the steps assessed.
• The second column specifies the number of touchpoints to which the 

resource is connected.
• The third column specifies the number of customer journeys to which the 

resource is connected.
• The name of the customer journey that uses the resource is specified in 

the fourth column.
• The fifth column specifies the percentage of steps noted as moments of 

truth that use the resource.
• The last column draws up the list of channels to which the resource is 

connected.

 For more details on calculating the satisfaction a persona for a 
customer journey, see Consolidation rules.
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SIMULATING A BPMN PROCESS

Simulation is a tool that aids decision-making, enabling analysis of company business process
operation and performance. By identifying relevant indicators, it enables indication of organization
improvements.

Complementing HOPEX Business Process Analysis, the HOPEX Process Simulation software
is edited by MEGA International to assist organizers and decision-makers in:

• Analyzing enterprise process performances.
• Improving existing processes or evolving processes.

HOPEX Process Simulation is used to:

• Describe the detailed organization of operations during execution of 
organizational or system processes, and the use of company resources 
by these processes.

 The simulation with the HOPEX Process Simulation product is 
only possible on processes respecting the BPMN formalism.
 The description of a process respecting the BPMN formalism can be 
derived from a Process Mining analysis. For more details, see Using 
the Process Mining.

• Associate quantitative information (processing time, costs) with 
operations executed and resources used.

• Create several optimization scenarios to build a comparative 
performance analysis of the different configurations.

The following points are covered here:

 Introduction to HOPEX Process Simulation.
 Connecting to HOPEX Process Simulation.
 Simulation Steps.
 Creating a Simulation Scenario.
 Using Simulation Schedules.
 Simulation Results.
 Using the Process Mining with HOPEX Process Simulation.
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INTRODUCTION TO HOPEX PROCESS SIMULATION

Why simulateing a process?
Simulation offers:

• An alternative viewpoint on the system, seen as a set of resources that 
must be shared by the different elements.

• Additional credibility supplementing traditional measures. 
• Obtaining performance indicators on configurations impossible in reality, 

or on quantities that cannot be measured.

There are therefore multiple reasons for simulating a process described with HOPEX
Business Process Analysis:

• Improving enterprise operation.
• Considering organizational changes from valuated based on quantitative 

data.
• Sizing resources.

Improving enterprise operation
Describing organization operation in order to simulate it can reveal:

• Possible reasons for performance deterioration. 
• Simple improvement solutions that have not been envisaged.

Considering organizational changes from valuatedquantitative data
Solutions envisaged to improve enterprise process performance can, by increasing
system productivity, highlight weaknesses that extend production deadlines.
Simulation enables anticipation of this type of problem: proposed scenarios are
tested and valuatedquantitative results can be compared.

Sizing resources
The description of the processes can be completed by the description of the means
(technology or other) required for them: 

• Equipment resources
• Applications
• Application services 

An estimate of quantities required can be obtained using simulation.
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Using the Process Mining
Process Mining is an approach that consists of analyzing files that trace the
execution of a process: start and end dates of completed tasks, identification of
resources used, identification of the activity in progress, routing of steps.

Depending on the quality of the trace files, this analysis can provide information
such as:

• The list of executed tasks and the average duration of each execution,
• Routing information: probability of activation of a task from another task.

From a trace file, a Process Mining tool is thus able to provide the BPMN
representation of the executed process as well as information about routing
probabilities and execution times. This information can be imported and analyzed
by HOPEX Process Simulation.

 For more details, see Using the Process Mining with HOPEX Process 
Simulation.

Using HOPEX Process Simulation
HOPEX Business Process Analysis is used to describe the organization of the
enterprise. This description can then be simulated and performance criteria can be
compared to identify the configuration that best meets enterprise objectives.

To this end you will use the following concepts:
• processes,
• operations,
• events,
• gateways,
• resources, 
• simulation scenarios.

This user guide is designed to help you quickly discover the main functionalities of
HOPEX Process Simulation and how to use them.
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CONNECTING TO HOPEX PROCESS SIMULATION

Prerequisites for the use of HOPEX Process Simulation
To use HOPEX Process Simulation, you must import the Simulation Engine
module in your environment. 

For import a module in HOPEX, see “Importing a module in HOPEX” chapter in the
HOPEX Administration guide.

In addition, to obtain process simulation results you must have purchased of
simulation product license.

Accessing HOPEX Process Simulation
To access HOPEX Process Simulation, you must log in with the Process
Manager profile, see Presenting the Process Manager space.
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SIMULATION STEPS

The BPMN model of a process represents an organized series of steps. For an
organizational process, the steps correspond to operations, events and gateways
encountered by an instance. 

The simulation consists in activating the different steps of the process while
respecting their sequence as well as the time constraints specified for each of them. 

Before being able to simulate a process, it must be represented graphically.
Simulation is based on the diagram that describes the different steps of the process.

Simulating a process consists of moving requests for work through the various steps
in the process. Each instance is introduced into the process model from a start event
and stops at an end event.

For example: in a purchase processing process, a purchasing request is triggered
by the sending of the instance and ends with the delivery of the order. In the
meantime, it goes through different steps (order recording, order processing, etc.).

The circulating instances thus make it possible to represent the sequencing of the
steps of a process.

From their respective BPMN diagrams, you can simulate the following concepts:
• Organizational process,
• Value streams,
• System process.

 These types of processes are proposed to you only if your options 
allow it.

Example of Running a Simulation
Let's take the organizational process of order processing as an example.
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Simulation start event
When a process has several entry points, the simulation editor asks you to choose
between the different possible start events.

The routing of the instances in the graph depends on the selected entry point.
 If you change the entry point of an already created scenario, the 
scenario must be updated, see Updating a simulation scenario.

Tasks
In a BPMN process, tasks are associated with processing steps requiring the
intervention of an enterprise participant (for example an org-unit). 

A task can be industrial (machining a component), 
logistical (receiving a delivery), or it can involve 
information processing (entering an order). 

During the simulation, the execution of a task is triggered by the arrival of an
instance that has taken the sequence flow that links the task to the other objects
describing the process flow. 

When an instance arrives at a task, the simulator checks that resources expected
for task execution are available. If this is not the case, the instance is placed in a
queue until the resource is free.

Participants represent resources needed to perform a task.
 If a task is described by a process, the simulation can take into 
account the detail of the process or remain at the task level, depending 
on the option selected in the simulation scenario. See Hierarchical 
description of the simulated process.
 The simulator does not take into account behaviors of tasks as 
defined specifically by the BPMN standard. For more details on these 
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behaviors, see Specifying Process Behavior. Behaviors Loop and 
Multiple must be described explicitly in the model. 

Resources
Performing the tasks requires the use of resources that can be human, software or
hardware, depending on the type of process described.
You can customize their quantity, cost and availability schedule for each simulation
scenario.

 A task is allowed to use only one resource which must be connected 
to the participant in charge of the task.

Using Gateways
A task may contain several input or output flows. To represent these situations, you
must use BPMN gateways and set probabilities. See Probabilities on the sequences
flows.

Managing task inputs

Several sequence flows can lead to the same task. In this case, you must define the
processing policy of the incoming instances in the task using a gateway Thus, an
instance can be the result of the merging of several instances coming from different
sequences, a Parallel gateway is then used.

For example, in an order delivery process, the various items 
that make up the order are processed separately. These items 
are then assembled to form a single order.

By default, each instance arriving in a sequence is taken into account as soon as the
resources required for its processing are available. Input policy is then an Exclusive
policy. 

 If the gateway is of the Parallel type, one instance must arrive via 
each of the different sequence flows to be grouped into a single instance 
which will execute the task.
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Managing task outputs

A task can produce different processings executed in parallel. There are basically
two output policies:

• A policy of Exclusive type: The instance is directed to one and only one 
sequence flow among the different possible outputs.

 By default, the output policy of a gateway is Exclusive.

• A policy of Parallel type: the instance is duplicated and directed to each 
of the output sequence flows.

In the case of a Parallel gateway, all output branches are processed
simultaneously.

 Although the BPMN standard covers other input and output 
management policies, only the Exclusive  policies are taken into 
account by the simulator.

Events
BPMN events enable representation of:

• The simulated process start point: this is the point from which processing 
instances are generated. Nature of these events must be Start or 
Catching,

• The point marking the end of the simulated process. Nature of these 
events must be End or Throwing,

• Occurrence of a particular fact that modifies behavior of the current 
process or another process. Events used in this case are of intermediate 
nature Catching or Throwing.
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CREATING A SIMULATION SCENARIO

A scenario enables definition of what you wish to simulate. It memorizes definition
of the process to be taken into account, as well as parameters specific to the
simulation.

Creating multiple scenarios for a process allows you to make comparisons between
the performance of several configurations. 

For example, by changing the number of org-units from one scenario to another,
you can analyze the impact of additional personnel on production.

Accessing the List of Simulation Scenarios
To access the list of scenarios from the Simulation navigation pane:

 Select Simulation Scenarios > All Simulation Scenarios.
The list of scenarios is displayed.
The Simulated process column indicates the name of the process
considered for the scenario.

Simulation Scenario Parameters
Parameters that must be managed in a scenario are:

• simulation and measurement conditions (start date, number of instances 
sent in the process, warmup and tail phases),

• conditions of arrival of instances sent to the simulated process,
• characteristics of the resources of the simulated process,
• characteristics of the steps of the simulated process,
• routing probabilities of the instances.

Creating a Simulation Scenario
To create a simulation scenario:

1. From the Simulation navigation pane, select Simulation Scenarios > 
My Simulation Scenarios.
The list of your scenarios is displayed.

2. Click the New button.
The window for creating a scenario opens.

3. Specify the Name of the simulation scenario.
4. Select the Process type you want to create.
5. Select the process you want to simulate from the Simulated Process 

field.
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6. (Optional) Check the box Import the exact arrival time of process 
instances from a CSV file.
The following fields are grayed.

 For more details on use of a CSV file of input flows, see Input flow 
CSV file.

7. Specify the number of Process instances that will activate the process 
as well as the Simulation start date.

 Those fields are grayed if you use a CSV file to describe the input 
flow.

8. Click the cells that interest you among the following:
• Infinite Resources,
• Simulate all processes levels,
• Simulation logfile.

 For more details on process resources, see Characteristics of a 
simulation scenario.

9. Click the Next button.
The simulated process diagram appears in the creation window.

10. Select the event that will mark the Scenario Input Flow.
11. If you don’t use a CSV file to describe the input flow, select the 

Schedule of instances that should activate the process as well as the 
inter-arrival Distribution Law and associated parameters.

 For more details on the input flow configuration in the simulated 
process, see Characteristics of a simulation scenario:

12. Click the Next button.
The task list of the simulated process is displayed.

 For more details on setting up the tasks of the simulated process, 
see Tasks of the simulated process.
 If you have chosen to simulate an organizational process more 
precisely, the Next  button allows you to set the parameters of its 
tasks. See Hierarchical description of the simulated process.
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13. Click the Next button.
The resource list of the simulated process is displayed.

 For more details on setting up the resources of the simulated 
process, see Input flow.

14. Click the Next button.
The sequence flow list of the simulated process is displayed.

 For more details on setting up the sequence flows of the simulated 
process, see Probabilities on the sequences flows.

15. Click OK.
The new simulation scenario appears in the list of simulation scenarios.

You can refine these settings from the scenario properties pages.

When all parameters are filled in, you can start the simulation: see Running
Simulation.

Characteristics of a simulation scenario
To access characteristics of a simulation scenario:

1. From the Simulation navigation pane, select Simulation Scenarios > 
All Simulation Scenarios.
The list of simulation scenarios is displayed.
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2. Select the simulation scenario that interests you and open its 
Characteristics properties page.

The following characteristics appear:
 Clicking the Update Scenario button allows to take into account 
the modifications made on the objects of the scenario or on their 
parameters. For more details, see Updating a simulation scenario.

• The Process Type and the name of the process you want to simulate in 
the scenario.

 The list of process types available to you depends on the options 
you have selected.

 The Open diagram button allows you to open the diagram of the 
simulated process in edit mode.

• The File location if you have checked the Import the exact arrival 
time of process instances from a CSV file box.
As a consequence, the following fields are grayed.

 For more details on use of a CSV file of input flows, see Input flow 
CSV file.

• The Process Instances as well as the Simulation start date which 
define the duration of the simulation. See Simulation duration.

• The Load increase and Tail to exclude periods which define the 
collection period for the statistical measures. See Measurement period.

• The Infinite Resources box is checked to simulate a situation where 
resources can't be bottleneck.

 For more details on process resources, see List of Resources.

• The Simulate all processes levels box enables taking into account the 
simulation data for all processes levels.
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 For more details on process simulation, see Hierarchical description 
of the simulated process.

• The Simulation logfile box provides access to the MXML file generated 
during the execution of the simulation scenario.

 For more information on the MXML file, see Scenario overall results.

Input flow CSV file

It is possible to define an input flow corresponding to the real system behavior. You
have to create a CSV file with a “start” colomn providing the list of dates in an ISO
8601 format type: YYYY-MM-DD'T'HH:MM:SS:SSSZ. 

For example :2021-07-28T15:50:03.000

Each date corresponds to a treatment requirement.

Such a file can be automatically generated by a Process Mining tool. For more
details, see Using the Process Mining.

Simulation duration

The quality of the statistical results you expect depends on the size of your sample
and the stability of the process you are simulating. The more unstable the behavior
of your process, the more measurements you will need to compose a representative
sample.

If you don’t use a CSV file for input flow, the duration of the simulation is therefore
defined by two parameters:

• The Number of instances that will be sent in the simulated process to 
make up the sample,

 The number of instances must be less than 1000.

• the Simulation Start Date which defines, according to the parameters 
of the input flow, the effective duration of the simulation. See Input flow.

Measurement period

A simulation can be divided into three periods:
• The warmup period during which the instances corresponding to the 

work requests progressively load the process resources.
• The steady-state period: the average number of instances being 

processed is stationary.
• The period of load reduction: depending on the processing conditions 

of the instances and schedules, it is possible that the number of 
instances being processed in the process will gradually decrease.

Depending on the statistical results you are interested in, you can restrict the
collection of results to one of these three periods. 
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The parameterization of the measurement period makes it possible, for example, to
exclude transitional periods that could distort the statistical results. You can
therefore exclude: 

• The percentage of instances that correspond to the WarmUp phase of 
the process,

• The percentage of instances that correspond to the phase of progressive 
decrease of load of the process: Tail to exclude.

Input flow
Since the process response times will be different depending on whether all work
requests are sent at once or if they are sent at regular time intervals, it is important
to specify the process load conditions.

To access the parameters that define the conditions of arrival of the instances in the
simulated process:

1. From the Simulation navigation pane, select Simulation Scenarios > 
All Simulation Scenarios.
The list of your scenarios is displayed.

2. Select the simulation scenario that interests you and open its Input 
Flow properties page.

The following characteristics appear:
• The Scenario Input Flow allows you to select the event that will mark 

the beginning of the treatment associated with the simulated process.
 If the simulated process has several Start or Waiting events or is 
described by several diagrams, you must specify which event is taken 
into account in the simulated scenario.

• The Schedule allows you to define the time slots during which the 
instances will be generated. See Using Simulation Schedules.

 This calendar is the default calendar also used for resources if no 
other calendar has been associated with them.
 Those fields are grayed if you use a CSV file to the input flow.

• The Distribution Law of the inter-arrivals of the instances in the 
process as well as the parameters of this distribution. See Distribution 
Laws and their Parameters.

 Those fields are grayed if you use a CSV file to the input flow.
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By default, instances are introduced continuously and at regular intervals. You can
enter the distribution law and the corresponding parameters to specify the mean
inter-arrival time. For more details, see Distribution Laws and their Parameters.

 To represent the fact that all instances are generated at the 
beginning of the simulation, set the value of the Mean to 0.

Tasks of the simulated process
All the tasks of the simulated process are detected during the construction of the
simulation scenario.

To access the tasks that will be simulated in the context of the simulation scenario:
1. Open the Tasks Simulation Data properties page of the simulation 

scenario that interests you.
The list of tasks specified in the BPMN diagram of the simulated process
is displayed.

2. Expand the section of a task.
The list of parameters for the selected task is displayed. 
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For each task you can indicate:
• The level of details of the simulated process by unchecking the  

Ignore Process Description box. For more details, see Hierarchical 
description of the simulated process.

• The Resource in charge of executing the task as defined in the 
simulated process diagram. See List of Resources. 

 This resource is not modifiable at the scenario level, the diagram 
must be modified.

• The Distribution law and the parameters that characterize the 
working time of the task. See Distribution Laws and their Parameters.

• The Default Performing Cost.
 For more details on how to calculate the cost of a task, see 
Simulation Results for a Scenario.

You can access to these informations in the Simulation Data property page of the
task.

 The characteristics of a task are carried by the task and not 
by the scenario. Thus, if you change the characteristics of a task 
for one scenario, these characteristics will be changed for all 
scenarios that take this task into account.

To access the tasks that will be simulated in the context of the simulation scenario:
 Open the Tasks Simulation Data properties page of the simulation 

scenario that interests you.
The list of tasks specified in the BPMN diagram of the simulated process
is displayed.

Hierarchical description of the simulated process
All the tasks of the simulated process are detected during the construction of the
simulation scenario.

If a task is described by a process, the simulation can take into account the detail
of the process or remain at the task level.

 The process components are automatically simulated if you have 
checked the  Simulate all processes levels box in the scenario 
parameters, see Characteristics of a simulation scenario.
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For example, the "Package Sending" operation is linked to the “Send Products
Simulation" process modeled by a BPMN diagram.

To specify that the simulation must take into account the tasks of a process linked
to an operation in the context of the simulation scenario:

1. Open the Tasks Simulation Data properties page of the simulation 
scenario that interests you. 

2. Unfold the section of the task you wish to simulate in detail.
3. Uncheck the Ignore Process Description box.
4. Fill in the task settings for the process described.

The results of the simulation will present in detail the results of the tasks
of the described process and the resources it uses. The results are
aggregated at the level of the process described.

 For more details on simulation results, see Results for tasks.

List of Resources
For a process to be simulated, all of its tasks must be assigned to resources.

All the resources assigned to the participants of the simulated process are detected
during the construction of the simulation scenario.

To access the resources available in a simulation scenario:
1. Open the Resources properties page of the simulation scenario that 

interests you.
The list of resources specified in the BPMN diagram of the process is
displayed. 
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For each resource you can indicate:
• Its available Quantity.

 The maximum quantity of resources is 1000, the resource is 
considered as infinite.

• The Used Schedule that specifies the periods of availability of the 
resource. See  Using Simulation Schedules.

 If no schedule is specified for the resource, the schedule defined for 
the input flow is taken into account for the resources.

• The Hourly rate of use. By default, this cost is assumed to be zero.
 For more details on how to calculate the resource costs, see Results 
for resources.

if you have checked the Infinite Resources option in the scenario parameters,
resources have no more impact on the performances of the simulated process.

 For more details on a scenario parameters, see Characteristics of a 
simulation scenario.

Probabilities on the sequences flows
Probabilities on the sequence flows determine the routing of the instances in the
simulated process.

 For more details on the different gateways, see  Using Gateways.

To define the routing probabilities on the sequence flows of the simulated process: :
1. Open the Sequence Flows Probability properties page of the 

simulation scenario that interests you.
The Sequence Flows section lists the process sequences at the output
of a gateway.

2. Select the sequence flow you are interested in and, in the Probability 
column, enter the value between 0 and 100 associated with the routing 
probability of the sequence flow.

 f no probability is defined, the simulator generates an error.

 The sum of the probabilities of the flows at the output of a gateway 
must be equal to 100. An error is signaled if this rule is not respected.
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Distribution Laws and their Parameters
Distribution laws are used to represent the random behavior of the processing time
of a task or the delay between the generation of two new instances injected in the
simulated process.

The distribution laws available in HOPEX Process Simulation are presented in the
table below

List of proposed distribution laws with their parameters

Running the Simulation

Updating a simulation scenario
Clicking the Update Scenario button allows to take into account the modifications
made on the objects of the scenario or on their parameters. 

If, for example, you have modified the diagram of the simulated process, you must
update the scenario so that this modification is taken into account during the next
simulation.

Distribution law Mean 1st parameter 2nd parameter

Fixed Fixed value

Exponential mean

Gamma mean variance

Log Normal mean variance

Normal mean standard deviation

Triangular mode minimum maximum

Uniform minimum maximum
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Running Simulation
Once you have entered the parameters of the process simulation scenario, you can
start the simulation.

To run the simulation:

 Click the Simulate button  in the simulation editor.

Simulation results are recorded in the scenario. 

Errors of a simulation scenario
Errors in the parameters of the simulation scenario or in the simulated process itself
may prevent the simulation from calculating the results.

In this case, you can display the Raw Simulation Data report to localize the source
of the error.

To access this option you must have access to the advanced user interfaces.

To activate this option:
1. On the  desktop, click Main Menu > Settings > Options.
2. In the left pane of the window, click Workspace > Desktop folder.
3. In the right part of the window, verify that Display advanced UI box is 

set to  “Yes”..
4. Click OK.
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To access the scenario error report:
1. Open the property page Simulation Outputs > Row Simulation Data.

2. The  Input Data section includes the XML file generated from the BPMN 
diagram of the simulated process and imported to run the simulation.

3. The  Output Data section includes three sub-sections:
• The simulation scenario Status,
• An Error message if the simulation  failed,
• If you have checked the option Simulation logfile in the scenario 

parameters, the Log MXML file is generated by the simulator. 
 For more details on a scenario parameters, see Characteristics of a 
simulation scenario.

All simulated events are traced in this MXML file.
 Because of its size, this file is compressed. To access it, select the 
file and click Open.
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USING SIMULATION SCHEDULES

The instance generator, which corresponds to the entry point of the process,
introduces the instances over periods defined by a Simulation Schedule. 

For example, you will indicate that customer calls are 
generated during opening hours, i.e. from Monday to Friday, 
from 9am to 6pm.

Schedules also allow you to define the period of activity of a resource.
For example, you will indicate that the resources 
responsible for handling customer calls are from 8:45 am to 
6:45 pm.

Example of schedule
You can create a schedule to indicate that a type of employee works Mondays from
9am to 7pm and Tuesdays and Wednesdays from 8am to 6pm.

Your schedule is defined from three Time slots: one on Mondays from 9am to 7pm
and two others for Tuesdays and Wednesdays from 8am to 6pm.
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Example of time slot

A time slot is defined by the day of the week and the time that mark the beginning
of the time slot as well as the day of the week and the time that mark its end.

Managing Schedules and Time Slots

Accessing the list of schedules
To access the list of schedules from the Simulation navigation pane:

 Click Schedules.
The list of available schedules appears.

Creating schedules
To create an simulation schedule from the Simulation navigation pane:

1. Click Schedules.
The list of available schedules appears.

2. Click the New button.
The window for creating a schedule appears.

3. Enter the Name of the schedule and click OK.
The new schedule appears in the list of simulation schedules.

4. You must then define the time slots in your schedule. See Creating time 
slots.

You can create a schedule from a scenario by associating it either to the input flow
or to a resource.

To create a schedule for an input flow from a scenario:
1. Open the Input Flow property page of the scenario.
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2. At the right of the Schedule field, click Create Schedule.
The window for creating a schedule appears.

3. Enter the Name of the schedule.
4. Click OK to complete the schedule creation.

 You must then define the time slots in your schedule. See Creating 
time slots.

Creating time slots
You can create a schedule from a scenario by associating it either to the input flow
or to a resource.

To create a time slot in a schedule:
1. From the Simulation navigation pane, click Schedules.

The list of available schedules appears.
2. Select the schedule that interests you and open its Characteristics 

properties page.
3. In the Time Slots section, click the New button.

The window for creating a time slot appears.
4. Enter the Name of the schedule.
5. In the Start section, from the From Weekday field, select the day on 

which the activity starts, and from the From Time field, specify the start 
time of the activity.

6. In the End section, from the To Weekday field, select the day on which 
the activity ends, and from the To Time field, specify the end time of the 
activity.

 The time format is <hh:mm:ss.ddd> and must be included 
between 00h00 and 23h59.

7. Click OK.
The new time slot appears in the list of time slots of the simulation
schedule.

Associating a schedule with the input flow of a scenario
To associate an existing calendar with a scenario:

1. Open the Input Flow property page of the scenario.
2. Click the arrow at the right of the Schedule field and select Connect 

Schedule.
3. In the selection window, select the schedule you are interested in.
4. Click Connect.

Associating a schedule with a resource
To associate an existing schedule with a resource:

1. Open the Resources properties window of the scenario.
The list of resources specified in the BPMN diagram of the process is
displayed.

2. Select the row of the resource you are interested in and, in the Used 
Schedule column, choose the schedule that corresponds to the activity 
period of the resource.
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SIMULATION RESULTS

Simulation Results for a Scenario
When the parameters of the various process objects have been entered, you can
run the simulation.

The Simulation Outputs property page displays:
• The Average Cost of processing an instance. It includes the cost of 

tasks and the cost of resources.
 This cost is obtained by dividing the Total execution cost of the 
process by the number of instances processed. The Total execution 
cost of the process is the sum of the resource costs plus the sum of 
the costs of each task. See Results for tasks.

• The Average performing time is the average task execution time for 
each instance. This time therefore includes the waiting time and the 
effective working time for each of the tasks performed by an instance.

Global Results
In addition to Average cost and Average actual work time, the overall results
show:

• The Average processing time corresponds to the average time spent 
by an instance to go through the whole process. This time therefore 
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includes waiting time, effective working time and downtime due to 
scheduling.

• The number of Instances processed.
 This result must be identical to the number of instances specified at 
the start of the simulation.

Results for tasks
The results for the tasks are given in seconds. They are also available in the form
of a report. See Scenario Reports.

The results of a simulation for each task are:
• The Average performing time is the average execution time for a task. 

This value includes the average time declared at the input to perform the 
treatment plus the average waiting time.

• The Average queuing time is the average time spent waiting for 
instances arriving earlier to be processed by available resources. This 
time does not include any possible interruption time.

• The Average interruption time is the time spent waiting for the 
resource performing the task to become available again after a schedule-
related interruption.

• The number of Instances processed by the task.
 Note that the Total cost of a task is the unit cost of the task 
multiplied by the number of instances it has processed.
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Results for resources
The Resources Results displays for each resource its Utilization.

 Utilization is the percentage of time a resource has been occupied 
out of the total time allocated to it. 
 Note that the Total cost of a task is the hourly cost of using the 
resource multiplied by the time the resource has been occupied.

Scenario Reports
You can view the scenario reports in the Reporting tab. 

Scenario overall results
You can view the scenario report in the Reporting > Mining & Simulation > 1-
Overall Results tab. 

The graphs below allow a comparison of the performance of the different
components of the simulated process.
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Detailed results and heatmap
This report displays a heatmap of the simulated process components performances.

You can view the scenario report in the Reporting > Mining & Simulation > 2-
Detailed Results and Heatmap tab. 

The Indicator parameter is used to compare components on the following criteria:
• the average cost,
• the utilization,
• the average queuing time,
• the average performing time.
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The first part of the report is a heatmap. The values represented by colors are based
on the maximum value achieved by the criteria. 

 The Average queuing time indicator is displayed below.

The second part of the report presents in the table an overall of performances. 

Process and Resource load
You can view the scenario report in the Reporting > Mining & Simulation > 3-
Process and Resource Load tab. 

The first part of this report presents the evolution of the mean number of instances
in the process per period of time. 
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You can see:
• the evolution of the mean number of instances waiting in the process 

components per period of time.
• the evolution of the mean number of instances using resources in the 

process components per period of time.
• Total number of instances processed during the period.

Simulated process performances

 The Average queuing time indicator is displayed below.

The second part of the report presents the evolution of the periodic utilization of
process resources. This graph helps to detect peak-loads that generate degraded
performances.

Load of an Org-Unit
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Scenario Comparison Report of a Process
From the Process Report property page, you can view the comparison report of two
process simulation scenarios. 

 The list of simulation scenarios available on the process is 
accessible from the Simulation - Simulation Scenarios property 
page.

To access the process simulation scenario comparison report:
1. Open the Reporting property page of the process that interests you.
2. Select Others > Process Simulation Scenarios Comparison.
3. In the Parameters select the Scenario A and the Scenario B.
4. In the Heatmap Indicator field, select the indicator that will be used for 

the presentation of the Indicator Map.
Indicators proposed are:
• the average cost,
• the average performing time,
• the utilization.

5. Click Refresh the report.
The graphs below allow a comparison of the performance of the different
elements of the simulated process.
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 The indicator presented above is resource Utilization.
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USING THE PROCESS MINING WITH HOPEX PROCESS 
SIMULATION

HOPEX Process Simulation allows you to analyze information from a Process
Mining tool.

Three types of information are taken into account by HOPEX Process Simulation.
This consists of:

1. The BPMN representation of the executed process;
 For more details on how to import a BPMN file, see the chapter 
"Importing BPMN files" in the HOPEX Common Features guide.
 You can compare the imported process diagram with a similar 
process diagram. For more details, see Conformité de diagrammes de 
processus.

2. CSV files containing treatment requests dates.
 For more details on use of a file to specify the input flows, see Input 
flow CSV file.

3. Data in XML format from the analysis of process execution data.
 For more details on how to import an Excel file, see Importing a 
Process Mining XML file.

When the data has been imported, HOPEX Process Simulation provides
facilities for analysis of this information.

 For more details on how to use this data, see Analyzing data from 
Process Mining.

Importing a Process Mining XML file
To import a Process Mining XML file, you must have already imported the BPMN
representation of the concerned process.

To import a Process Mining XML file:
1. Open the Simulation > Process Mining property page of the process 

that interests you.
2. Click Import.

An import window opens.
3. Select the simulation data XML file that interests you and click OK.

The imported file is added to the list. 
4. Click the map associated to the XML file to access to the list of tasks with 

their indicators.
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Analyzing data from Process Mining
You can use the imported data in a Process Mining map.

To access the process simulation scenario comparison report:
1. Open the Reporting property page of the process that interests you.
2. Select Others > Process Mining Heatmap.
3. In the Parameters section, select the Process Mining Map concerned.
4. Then select the Process Mining Indicator and click Refresh the 

report.
Indicators proposed are:
• the average cost,
• the average performing time,
• Instances processed.
The Process Mining Heatmap  report is generated.
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ASSESSMENTS WITH HOPEX BUSINESS 
PROCESS ANALYSIS

Questionnaires are used to obtain an assessment of the execution and performance of business and
organizational processes. 

HOPEX Business Process Analysis uses assessment features to carry out assessments of your
business and organizational processes based on answers to standard questionnaires. In this way
you can improve their real and perceived quality.

The following points are covered here:

 Assessment principles
 Assessing a process with HOPEX Business Process Analysis
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ASSESSMENT PRINCIPLES

Concepts Overview
Assessment is carried out using assessment questionnaires. In HOPEX Business
Process Analysis, these questionnaires are accessible  directly. Results are then
aggregates according to predefined rules to present results so they can be used.

Assessments relate to process execution and performance. 
 An assessment is a mechanism used to receive feedback 
(qualitative or quantitative) from an identified population on identified 
objects. The assessment is then supplemented by results analysis tools.

 An assessment questionnaire is a list of questions relating to a 
particular object and addressed to persons questioned.

The results of these assessments are then presented in reports. For more details,
see Execution and Performance Heatmap report.

Criteria assessed with HOPEX Business Process Analysis
These characteristics relate to attribute values linked to process performance and
execution.

List of characteristics linked to process execution:
• Specification: assessment of quality of description of the object in 

the repository.
• Knowledge: assessment of knowledge of the object by stakeholders.
• IT Support: assessment of application support of the object.
• Execution: this characteristic is a global assessment of object 

execution. It is calculated from assessment of object specification, 
knowledge and support.

List of characteristics linked to process performance:
• Effectiveness: characterizes effectiveness of object operation
• Business Value: characterizes business value of the object.
• Risk: characterizes risks concerning the object.
• Performance: this characteristic is a global assessment of process 

performance. It is calculated from assessment of process business 
value, effectiveness and risk.
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ASSESSING A PROCESS WITH HOPEX BUSINESS PROCESS 
ANALYSIS

Accessing the Process Assessment with HOPEX Business Process 
Analysis

The properties pages of an organizational process (or a business process), enables
access to different forms of Assessment.

The following choices are available:
• Global Assessment: to attribute values to the assessment criteria of 

the process.
See Global assessment.

• Direct Assessment (Execution) and Direct Assessment 
(Performance): enables expert users to assess the execution and 
performance criteria for a process in its different use contexts.
See Direct Assessment.

• Specific Questions (Execution) and Specific Questions 
(Performance): to add questions to existing assessment 
questionnaires.
See Specific questions.

Completed assessments are used to obtain summary reports.
 For more details on this summary report, see Process Assessment.
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Global assessment
The Assessment > Global assessment property page of an organizational
process allows an expert user to specify values of attributes linked to assessed
characteristics.

Direct Assessment
You can create new assessments to globally assess an organizational process  on all
the organizational contexts to which it is connected (i.e. entities).

This is an "expert view" assessment.

Creating direct assessments (Execution)
To create a direct execution campaign:

1. Open the Assessment > Specific Questions (Execution) property 
page of the process that interests you.

2. Click the Evaluate button.
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3. Select the context in which the process is to be assessed, then click 
Next.

 A context is defined by a use of the assessed process by an org-unit 
or another process.
 The contexts are available only if there is more than one.

The assessment questionnaire page appears.

4. Specify the values for the questionnaire characteristics:
5. (Optional) Add Attachments.
6. Check the Assessment Date.
7. Click OK.

An assessment is created. 
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Creating direct assessments (Performance)
You create an assessment of the performance of your process in the same way as
for an execution assessment (see Creating direct assessments (Execution)).

The standard questionnaire for the performance appears.

Specific questions
You can add new questions to your questionnaires for your processes.

Your question then appears in the associated questionnaire in the corresponding
section: "Process execution" or "Process performance".

Creating a specific question (Execution)
To create a specific execution question:

1. Open the Assessment > Specific Questions (Execution) property 
page of the process that interests you.

2. Click the Open an assessment template button.
The assessment template creation dialog box opens.

 For more details on the management of specific questions, see 
"Presentation of the Questionnaire Builder” chapter in the HOPEX 
Common Features guide.
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Creating a specific question (Performance)
You create a question specific to the performance of your process in the same way
as you do for an execution assessment (see Creating a specific question
(Execution)).

The question then appears in the direct assessment questionnaire (Performance). 
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MANAGING RISKS AND CONTROLS

Managing risks, assuring and maintaining compliance with new regulations provides a real
opportunity for those managing enterprise changes. In this perspective, HOPEX Risk Mapper
offers total visibility of operational risks, control points and value chains.

The HOPEX Business Process Analysis repository covers all enterprise resources, from global
value streams to IT resources. The HOPEX Risk Mapper approach allows managers to ensure
traceability of compliance controls across business and application layers. 

With HOPEX Risk Mapper, it is easier to integrate the risk management policy and the compliance
controls for corporate governance by, on the one hand, setting realistic goals, and on the other
hand, by supplying the deliverables and information required by all the org-units involved.
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RISK MANAGEMENT PROCESS

Associated with HOPEX Business Process Analysis, HOPEX Risk Mapper is
used to assess the risks, to mitigate them and finally to control them thanks to an
effective control policy.

The recommended risk management process is therefore composed of the following
steps:

• Modeling the environment,
• Identifying, analyzing and assessing risks,
• Remediating Risks,
• Risk Control Monitoring and Policy.

Modeling  the environment
Risks must be managed in the external and internal environments of the
organization, its strategic objectives and the specific objectives of the risk
management activity.

• The external environment defines the external environment in which the 
organization operates as well as its relationships with this environment.

 For more details, see External Environment.

• The internal environment describes the organization. This ensures that 
risk management acknowledges the major objectives and constraints of 
the organization. 

 For more details, see Internal Environment.

• The risk management context is essentially linked to the objectives that 
the enterprise pursues through its risk management process.

 For more details, see Risk Management Context.

Identifying, analyzing and assessing risks
It is necessary to identify the risks concerned, then analyze and assess them to get
the elements required for their treatment.

Identifies risks

It is necessary to determine where, when, why and how events might prevent,
degrade, delay or improve the achievement of the organization's objectives.

Internal and external events affecting the achievement of entity objectives must be
described with the distinction made between risks and opportunities. The
opportunities can then be used to form management strategy or in objective-setting
processes.
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More specifically, several risk identification methods can be proposed depending on
the context:

• Method based on organization objectives achievement
• Method based on lists of risk types, risk factors or controls applied to an 

appearance context
• Method based on historical data (databases of incidents, claims, faults, 

etc.)
 For more details, see Identifies risks.

Analyzing Risks

This consists of completing the identification of each risk by precisely indicating what
could occur, where, when, why, and how this could have arisen. This analysis could
reveal new risks that were not directly identified in the previous step. The
effectiveness of existing controls that could prevent this risk are also assessed.

 For more details, see Risk Analysis.

Assessing Risks

After having identified and analyzed the risks faced by the enterprise, the next step
is to estimate their importance so as to highlight the most important risks to be
remediated.

Risks are assessed taking into account:
• their occurrence frequency,
• their impact 

 For more details, see Assessing Risks.

Remediating Risks
Risk assessment is therefore an essential step in obtaining a list of risks requiring
remediation, indicating their priority.

The acceptable level for each risk is defined based on previous evaluations. 
 For more details, see Risk Treatment.

Remediating risks involves:
• identification of the various options possible 
• assessment of these options 
• preparation and implementation of remediation plans: 

• Specification of actions to be implemented
• Controls

Risk Control Monitoring and Policy
Policies and procedures are established and implemented to help ensure that risk
responses are effectively carried out.

Monitoring is accomplished through ongoing management activities or independent
assessments, or both.
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Information and communication
Relevant information is identified, collected, and communicated in a form and
timeframe that enable collaborators to carry out their responsibilities. Effective
communication should also occur in a broader sense, flowing downwards, across,
and upwards in the entity.

Communication and consultation are important considerations at each step of the
risk management process. They should involve dialog with stakeholders with efforts
focused on consultation rather than a one-way flow of information from the
decision-maker to other stakeholders.
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RISK ENVIRONMENT ANALYSIS

Analysis of the environment in which the risk management project will be carried
out enables definition of basic parameters according to which risks must be
managed, with an indication of project scope. This analysis includes the internal and
external environments of the organization, its strategic objectives and the specific
objectives of the risk management activity.

Internal Environment
The internal environment includes the culture and spirit of the organization. It sets
the basis for how risk is viewed and addressed by all entity co-workers, particularly
risk management philosophy and risk appetite, integrity and ethical values, and the
environment in which the organization operates.

At this stage it is possible to determine:
• the list of strategic objectives of the organization and the associated 

requirements
Objectives must exist before management can identify the events that
may affect their achievement. Risk management ensures that objectives
are in line with the mission of the organization and its risk appetite.

• What exists in the enterprise (Organizational Chart, processes, 
management rules, control systems, responsibilities, etc.)

Defining the internal environment ensures that risk management acknowledges the
major objectives of the organization.

Organization of internal org-units
The different org-units concerned must be involved at each step of the risk
management project via a communication and consultation process.

This enables building a solution that will be better accepted by the different
stakeholders.

To access all entities of the organization with the Process Manager profile from the
Processes navigation pane:

 Select Hierarchy and expand the Org-Units folder.

To define the list of org-units concerned, HOPEX Risk Mapper enables you to enter
the enterprise organizational chart.

 For more information on organizational charts, see Organizational 
Charts and Responsibilities.

You can also define objectives and requirements for each organization unit.
 For more information on defining objectives, see Organization 
objectives and requirements.
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Organization objectives and requirements
 To activate the option that allows you to view objectives and 
requirements: in the left pane of the Options window, select HOPEX 
Solution > Common Features on the left and check Objectives and 
requirements modeling box. 

Certain key documents, such as strategic plans, the business plan, annual reports,
economic analyses and other relevant documentation related to the organization
and its aims may be consulted to define its objectives and requirements.

 An objective is a goal that a company/organization wants to 
achieve, or is the target set by a process or an operation. An objective 
allows you to highlight the features in a process or operation that 
require improvement.

 A requirement is a need or expectation explicitly expressed, 
imposed as a constraint to be respected within the context of a project. 
This project can be a certification project, or an enterprise information 
system organization or modification project.

With HOPEX Risk Mapper, the objectives and requirements of your organization
are defined in the properties of the org-unit that represents the organization.

To define the objectives and requirements of each org-unit:
1. Open the Characteristics property page of the Org-Unit.
2. Expand the Strategy and Decisionssection,
3. Select the Achieved objectives tab or  Imposed Requirements tab.

Here you can create new objectives and requirements or connect those which
already exist.

 For more information on the definition of objectives and 
requirements, see "Objectives and Requirements" in HOPEX Common 
Features.

Organization Processes
To access the organization processes tree:

 From the Processes pane, select  Hierarchy and expand the 
Organizational Process folder.
If you expand the folder of a process, you can display the sub-processes
owned by the current process.

The specific property pages of a process

The process Characteristics property page presents the following sections:
•  Responsibilities: to present the persons responsible for the process. 

For more details, see RACI on a risk.
• Controls and Risks: lists the controls and the risks that relate to the 

process. For more details, see Assessing Risks.
• Strategy and Decisions, for more details, see Organization 

objectives and requirements.
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External Environment
This is the external environment in which the organization operates as well as its
relationships with this environment. For example, this can include:

• The business, social, regulatory, cultural, competitive, financial and 
political environments of the organization

• The list of regulations that impact the organization and the associated 
requirements

• The strengths, weaknesses, opportunities and threats of the organization
• External stakeholders and their requirements
• Key performance indicators

Establishing the external context ensures that external org-units and their
objectives and requirements are considered for the development of risk
management policies.

To describe the external environment in which the organization operates, HOPEX
Risk Mapper enables you to define:

• The list of regulations that impact the organization and the associated 
requirements, see Regulation Frameworks,.

• The list of external stakeholders of the organization and their objectives 
and requirements, see  External org-units: objectives and requirements.

Regulation Frameworks
 A regulation framework is a set of directives, compulsory or not, 
defined by a government in a law, by standard bodies as "best 
practices" or as an internal policy in an organization.
 To activate the option that allows you to view regulation 
frameworks: in the left pane of the Options, window, select on the letf 
Compatibility > HOPEX Solution and check the box “Regulation 
Frameworks” activation (Hopex V4 and lower). 

Accessing the regulation frameworks of the organization

To access the list of regulation frameworks from the Processes pane:
1. Select Control & Risks.
2. Click the Regulation Frameworks tile.

The list of regulation frameworks for the organization is displayed.
 You can import into your repository libraries containing description 
of a regulation framework with its associated requirements, risk types, 
risk factors and control types.
 There can also be regulation frameworks internal to the 
organization serving as a guide to governance. In this documentation, 
the terms "Regulation" or "regulation framework" are used to refer to 
both internal and external  regulations.

Create a regulatory framework

To create a regulation framework from the Processes pane:
1. Select Control & Risks > Regulation Frameworks.
2. Click the New button.
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3. Enter the regulation framework name and click OK.
The new regulation framework appears in the navigator menu tree.

Regulation framework characteristics

To access the general characteristics of a regulation framework:
 Open the Characteristics property page of the regulation framework.

The characteristics are as follows:
• The Regulation Code , which is internal,
• Application Begin Date of the regulation,
• Application End Date of the regulation

Regulation framework classifications

To access the classifications of a regulation framework:
 Open the Classification property page of the regulation framework that 

interests you.
• Risk types, see Risk types;

 A risk type defines a risk typology standardized within the context 
of an organization.
 If you select Risk Types, the list of risk types associated with the 
regulation framework appears.

• Risk factors, see Risk factors;

 A risk factor is an element which contributes to the occurrence of a 
risk or which triggers a risk. Several Risks can originate from a same 
Risk Factor Examples: the use of a hazardous chemical product, the 
complexity of an application, the size of a project, the number of 
involved parties, the use of a new technology, the lack of quality 
assurance, the lack of rigor in requirements definition…

• Control types, see Control Types.

 A control type allows the classification of controls implemented in a 
company in accordance with regulatory or domain specific standards 
(Cobit, etc.).
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Regulation framework requirements

To access the requirements of a regulation framework:
 Open the Requirements property page of the regulation framework that 

interests you.
 A requirement is a need or expectation explicitly expressed, 
imposed as a constraint to be respected within the context of a project. 
This project can be a certification project, or an enterprise information 
system organization or modification project.

Control systems of a regulation framework
 To activate the option that allows you to view control systems: in 
the left pane of the Options window, select Compatibility > HOPEX 
Solution on the left and check Activate ‘Control Systems’ box.

To access the control systems of a regulation framework:
 Open Control systems property page of the regulation framework that 

interests you.
 A risk and control system is a set of controls that enables the 
assurance of risk prevention and management, application of internal 
operating rules, respect of a law or regulation, or achievement of an 
objective as defined by company strategy.
 For more details on control systems, see Control Systems. 

Risk types
By grouping similar potential events, managers can improve their procedure for
identifying opportunities and risks.

Enterprises can also classify potential events to ensure that the efforts deployed for
identification are exhaustive. This classification can also contribute to subsequent
development of an overview of risks.

 A risk type defines a risk typology standardized within the context 
of an organization.

A risk type enables risk characterization. For example, a risk type can be regulatory,
legal, technical, etc.

Breakdown of risk types will be specific to activities and will depend on the particular
business line or activity. Generic risk types can be broken down to a greater or
lesser extent into specific risk type levels.

It is important to have a risk type definition framework that is identifiable,
measurable and manageable, and to limit the number of levels to assure usable
nomenclature.

Validation of nomenclature should ensure that a risk defined in two different entities
or activities will have the same definition and the same sense, therefore ensuring
system consistency.

In that the system installed should also meet regulatory requirements, it will also
be necessary to define a second nomenclature to meet declaration aspects and to
enable exchanges with control authorities.

For example, in the banking sector, risk types have been 
defined in the context of Basel II recommendations. For more 
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details, see http://www.bis.org/bcbs/ HOPEX enables 
handling of these risk types.

To create a risk types from the Processes pane:
1. Select Control & Risks > Hierarchy View.
2. Expand the regulation framework folder that interests you.
3. Click on the title bar of the Risk Types folder, select New > Risk Type..

4. Enter the name of the risk type and click OK.
The new risk type appears in the navigator menu tree.

 Similarly, you can create a sub-risk type from a risk type.

Risk factors
Many risk factors are defined within the framework of international, national or
inter-professional regulations, or within the enterprise itself. 

 A risk factor is an element which contributes to the occurrence of a 
risk or which triggers a risk. Several Risks can originate from a same 
Risk Factor Examples: the use of a hazardous chemical product, the 
complexity of an application, the size of a project, the number of 
involved parties, the use of a new technology, the lack of quality 
assurance, the lack of rigor in requirements definition…

To access the list of  risk factors from the Processes pane:
1. Select Control & Risks > Regulation Frameworks.

The list of regulation frameworks is displayed.
2. Expand the regulation framework folder that interests you.

The Risk factors folder appears.

With each risk, you can associate one or more risk factors, sources of risks that have
intrinsic potential to endanger organization operation. For example, dangerous
chemical products, competitors, governments, etc.

http://www.bis.org/bcbs/
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Control Types
Controls can be defined by referencing the control types defined in the risk and
control system concerned.

A control nomenclature frequently used is that defined by 
the COBIT.
COBITS stands for "Control Objectives for Information and 
related Technologies".
COBIT is a framework of best practices that now integrates 
numerous other frameworks and has the support of a large 
number of world experts. Of the 34 processes defined in 
COBIT there are 318 corresponding control objectives for 
which detailed control practices have been identified. The 
proposed verification guide describes elements necessary 
for correct understanding of each process, specifies 
controls to be carried out, provides elements for 
assessment of conformity to best practices and assessment 
of risk of non-achievement of objectives.

 A control type allows the classification of controls implemented in a 
company in accordance with regulatory or domain specific standards 
(Cobit, etc.).

To access the list of  control types from the Processes pane:
1. Select Control & Risks > Hierarchy View.
2. Expand the Regulation Frameworks folder.

The list of regulation frameworks is displayed.
3. Expand the regulation framework folder that interests you.

The control types folder appears.

External org-units: objectives and requirements
 An external org-unit is an external entity that exchanges flows with 
the enterprise. Example: customer, supplier, government office.

Defining the various parties concerned by risks faced by the enterprise is important
in the majority of activities. This analysis is generally necessary from the first steps
of a risk management project.

External org-units to be considered can be:
• Legislators
• Government agencies, ministries and local administrations
• Interest groups such as ecological lobbies
• Emergency services
• Financial institutions and other private sector fund suppliers
• Customers of the organization, including their managers, executives and 

personnel
• Suppliers and sub-contractors
• Persons who may be affected by enterprise activities due to their 

geographical location
• The media
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To access all the org-units of the organization, see Organization of internal org-
units. 

To specify that an org-unit is external to the organization: 
1. Open the Characteristics property page of the Org-Unit.
2. In the Internal / External field, select External Org-Unit.

The External Org-Units appear with a green icon in the diagrams and in
the navigation trees. 
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RISK MANAGEMENT CONTEXT

The risk management project must acknowledge the enterprise objectives that are
relevant to the project. It must also consider the necessity of balancing costs,
benefits and opportunities.

 A project consists of a set of tasks entrusted to a team, which 
transforms a system or part of a system with the aim of achieving a 
given objective.
 For more details on projects, see Risk Management Projects. 

The responsibility of management in relation to risks taken by their enterprise not
only imposes the installation of control systems to enable risk management, but also
their demonstration at audit and attachment to the corresponding paragraphs of
regulations.

Control systems imposed by regulations (Sarbanes-Oxley Act, etc.), by clients (ISO
9000 certification), or by sectorial control systems (Basel II in the banking sector,
etc.) can be superimposed on the control systems implemented in an enterprise

 A risk and control system is a set of controls that enables the 
assurance of risk prevention and management, application of internal 
operating rules, respect of a law or regulation, or achievement of an 
objective as defined by company strategy.

Last but not least, the description of the internal context in which the risk
management process operates can be supplemented by the description of existing
control systems.

During risk management projects, existing control systems will be reviewed and
new control systems may be created.

 For more details on control systems, see Control Systems. 

Risk Management Projects

 A project consists of a set of tasks entrusted to a team, which 
transforms a system or part of a system with the aim of achieving a 
given objective.

A risk management project must be approached by taking into account the company

objectives that are relevant to the project. It must also

consider the necessity of balancing costs, benefits and opportunities.
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Defining a risk management project involves:
• selecting the strategic objectives and requirements relevant to the 

project
• defining the objectives specific to the project
• determining the resources available for the project (capital, persons, 

systems, etc.)
• selecting from among existing control systems those that are 

concerned by this project
• defining the new control systems to be installed
• defining the project scope: org-units, sites, processes and systems 

concerned, for instance.

During risk management projects, existing control systems will be reviewed and
new control systems may be created.

 For more information on project management, see HOPEX 
Common Features.

Control Systems

 A risk and control system is a set of controls that enables the 
assurance of risk prevention and management, application of internal 
operating rules, respect of a law or regulation, or achievement of an 
objective as defined by company strategy.
 To activate the option that allows you to view control systems: in 
the left pane of the Options window, select Compatibility > HOPEX 
Solution on the left and check Activate ‘Control Systems’ box.

To access the list of control systems from the  Processes > Controls & Risks
navigation pane:

1. Expand Control Systems.
The list of control systems defined in the database appears.

With each control system can be associated requirements, risk types, etc.
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Creating a control system
To create a control system from the Processes pane:

1. Select Controls & Risks > Control Systems.
2. Click New > Control system.

A dialog box asks you to enter the name of the new control system.
3. Having entered the name, click OK.

The new control system appears in the navigator menu tree.

Control system characteristics
To access the characteristics of a control system:

 Open the Characteristics property page of the control system.
For a control system you can enter:

• the Control System Code.
• The Control System Audit Periodicity.
• The Regulation Frameworks to which the control system makes 

reference.

Control System scope
In the Scope property page of the Control System, you can indicate the business
functions, processes, org-units, sites, etc. concerned by the control system.

Control system requirements
 A requirement is a need or expectation explicitly expressed, 
imposed as a constraint to be respected within the context of a project. 
This project can be a certification project, or an enterprise information 
system organization or modification project.

From among the requirements associated with regulation frameworks to which the
control system refers, you can select those relevant to this control system.

You can also add requirements specific to the particular control system.
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Control system objectives
You can find objectives and requirements of the control system in the Objectives
and Requirements property page.

 An objective is a goal that a company/organization wants to 
achieve, or is the target set by a process or an operation. An objective 
allows you to highlight the features in a process or operation that 
require improvement.

Classifications
The different classifications (risk factors, risk types, control types) associated with
a control system are accessible from the control system page.

As for requirements, you can select from among the classifications associated with
regulation frameworks those that are relevant to this control system.
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IDENTIFIES RISKS

When the control internal environment has been defined and enterprise objectives
in terms of risk have been specified, the step of identification of events at risk starts.

Identification of risks is generally carried out within the framework of a specified
control system.

 A risk and control system is a set of controls that enables the 
assurance of risk prevention and management, application of internal 
operating rules, respect of a law or regulation, or achievement of an 
objective as defined by company strategy.

This control system can be defined as the implementation of a regulation within the
framework of one of the enterprise business functions, such as application of an
enterprise financial policy in the purchasing field.

Risk Identification Methods
The identification of risk events involves the inventory of the internal and external
events that could compromise the achievement of objectives. A distinction must be
made between those that represent risks, those that constitute opportunities and
those that result from both simultaneously. Opportunities are integrated in the
strategy of the organization or in the objective setting procedure.

Risk events can be identified using several approaches that involve operational
management to differing degrees.

Method based on risk type or risk factor lists
It is possible to start by defining a list of generic risks faced whatever the activity.
In particular, this includes natural disaster, IT system failure, human error, fraud,
etc.

An initial list drawn up by a central team will avoid a complete analysis of risks with
business function operational managers, to concentrate on risks that are specific to
their activity. This list could be based on regulatory texts and lists provided by
professional partners (professional associations, insurance companies, etc.).

This list can then be completed during interviews with operational managers of
processes who can define the types of risks to which they are vulnerable to give a
precise definition.In this case you identify the processes and the stakeholders or
org-units of the organization concerned by these risk types or these risk factors.

A risk identification questionnaire is prepared, from which each stakeholder selects
risk types and risk factors of particular concern.

A questionnaire can therefore be produced and sent to the various stakeholders to
enable them to identify risk events that concern them.

 See HOPEX Common Features for more information on 
questionnaires.
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Replies to these questionnaires are then analyzed by experts in each of the subjects
concerned, in consultation with the stakeholders concerned if necessary, to finalize
risk identification.

It is then possible to remove from this generic list, which has been supplemented
by risks specific to the activity, those risk events that do not apply to the particular
field (example: a purely manual activity that does not require the services of an IT
system.

Method based on enterprise objectives and business process diagrams
It is possible to determine the risks of not achieving organization objectives or not
satisfying regulatory or organization internal requirements using the description of
organization business processes.

To do this, we select the processes that contribute to achieving these objectives or
satisfying these requirements. Next, determine the risks by analyzing the flows
exchanged between the org-units participating in these processes as well as the
operations executed by these org-units. From among these flows and operations,
determine which ones could, in the event of malfunction, prevent the achievement
of objectives or the satisfaction of requirements of the organization.

This approach can be supplemented by using other risk identification criteria such
as risk type or risk factor lists if these are available.

If enterprise business process diagrams already exist, they can help to identify risks.

Risk events can be associated with each of the modeled processes.

Risks associated with a process are visible in the Control & Risks section of the
process Characteristics property page.

 Risks can be linked to other concepts such as org-units, business 
processes, etc.

Method of identification from incidents repository
All types of stored history can be used, such as repositories of incidents, faults,
claims, etc.
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Identification consists of analyzing repositories to determine risk events. You should
then specify for each risk its appearance context (business process, organization
org-unit, enterprise site, etc.).

 See the HOPEX LDC user guide for more information on incidents 
(events) repository management.

Accessing risks
To access the list of risks from the Processes pane:

 Select Controls & Risks and click Risks.

Creating risks
To create a risk associated to an organizational process:

1. Open the Characteristics property page of the process that interests 
you.

2. Expand the  Controls & Risks section,
3. Select the Risks tab.
4. Click the New button.

The new risk is added to the list of risks associated to the process.

To create an independent risk from the Processes pane:
1. Select Control & Risks> Risks.
2. Click the New button.

The new risk is added to the list of risks.

Risk characteristics
In the Characteristics property page of a Risk you can specify characteristics
below:

• the risk identification Code
• the risk Name
• the fact that the risk is high level by selecting the Major Risk check box,
• the risk Owner.

 By default the owner is the risk creator.

• the risk Identification Mode
The risk could have been identified from:
• an "Incident database" 
• a "Workshop"
• a "Survey"
• a "Mission audit"

• the risk Description
 the Risk Status appears grayed and cannot be modified since it is 
managed by the workflow associated with the risk. For more 
information, see HOPEX Enterprise Risk Management.
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Risk scope
Risk scope enables definition of risk location. It relates to several component types: 

• Business Processes and Organizational Processes exposed to the 
risk. For more details, see Organization Processes.

 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
implementation of the business process in the organization. A business 
process can also be detailed by a functional view.

 An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is 
depicted as a sequence of operations, controlled by events and 
conditions.

• Entities concerned by the risk. For more details, see Organization of 
internal org-units.

 An entity can be internal or external to the enterprise: an entity 
represents an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
entity represents an organization that exchanges flows with the 
enterprise, Example: customer, supplier, government office.

• Objectives and Requirements expected related to risk 
management. For more details, see Organization objectives and 
requirements.

 An objective is a goal that a company/organization wants to 
achieve, or is the target set by a process or an operation. An objective 
allows you to highlight the features in a process or operation that 
require improvement.

 A requirement is a need or expectation explicitly expressed, 
imposed as a constraint to be respected within the context of a project. 
This project can be a certification project, or an enterprise information 
system organization or modification project.

• Applications,

 An application is a software component that can be deployed and 
provides users with a set of functionalities.

• Business Lines 

 A business line is a high level classification of main enterprise 
activities. It corresponds for example to major product segments or to 
distribution channels. It enables classification of enterprise processes, 
organizational units or applications that serve a specific product and/or 
specific market.

RACI on a risk
A risk Characteristics property page includes a RACI section to define the different
persons responsible for risk management. 

 RACI is the acronym of Responsible, Accountable, Consulted, 
Informed.



227

Managing Risks and Controls
Identifies risks

Responsibility levels
The proposed responsibility levels are as follows:

HOPEX Risk Mapper enables specification of the responsibility level of the various
persons:

• on a risk,
• on a control.

Specifying Responsibilities
With HOPEX Risk Mapper, persons are represented by (system persons).

 A person (System) represents a person in the enterprise. This 
person can be assigned a login and a role (or a profile depending on the 
connection mode). The login provides access to the HOPEX Application. 
The role (or the profile) defines the access to product functions and 
repositories. A system person, if assigned a login, has a specific desktop 
in each database, and can connect to this desktop from any workstation 
in a given environment.

To specify the persons responsible for a specific object:
1. In the risk Characteristics property page, expand the RACI section..
2. Connect the persons (system) in each of the following tabs:

• Responsible
• Accountable
• Consulted
• Informed.

 In some solutions, RACI information can be redundant with roles 
defined in the object property dialog box or can supplement them.

For example, in HOPEX Enterprise Risk Management, the 
process responsible user can be specified directly in the 
Responsible field of the process property dialog box and not 
in the RACI section. In this case, it is important to 
specify one responsible user only.

Responsibility Explanation

Responsible Persons responsible for execution of required actions.

Accountable Persons reporting on progress of planned actions and making 
decisions. 
There is only one "Accountable" for each action. 

Consulted Persons consulted as first priority before an action or deci-
sion.

Informed Must be informed after an action or decision.
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RISK ANALYSIS

The aim of risk analysis is to obtain a good understanding of risks. It offers elements
that help to decide on whether treatment of a risk is necessary, and to select the
most appropriate and cost-competitive treatment strategies. Risk analysis must
take risk sources into account as well as positive or negative risk consequences.

The analysis phase associates a risk with:
• risk types
• risk factors (or causes)
• consequences
• objectives

Contextualization of a risk enables risk classification by:
• on the one hand their type 
• on the other the objects to which they relate.

The same risk can relate to several component types specified in the risk scope: 
• an entity,
• a process,
• a business line,
• a site.

 These components are specified in the risk characteristics, in the 
Scope section. For more details, see Risk scope.

Risk analysis
To analyze a risk:

1. Select a risk and open its Characteristics property page.
2. Expand the Analysis section.

A risk is characterized by:
• Control System(s): for handling risk management, see Control 

Systems.
• Risk Types: for more details, see Risk types.

 A risk type defines a risk typology standardized within the context 
of an organization.

• Risk Factors: for more details, see Risk factors.

 A risk factor is an element which contributes to the occurrence of a 
risk or which triggers a risk. Several Risks can originate from a same 
Risk Factor Examples: the use of a hazardous chemical product, the 
complexity of an application, the size of a project, the number of 



229

Managing Risks and Controls
Risk Analysis

involved parties, the use of a new technology, the lack of quality 
assurance, the lack of rigor in requirements definition…

• Risk Consequences: for more details, see Risk consequences.

 A risk consequence can be positive or negative. It is associated with 
a type, which enables its characterization, for example: image, 
environment, employees.

• Related Risks

Risk consequences

 A risk consequence can be positive or negative. It is associated with 
a type, which enables its characterization, for example: image, 
environment, employees.

To define consequences associated with a risk:
1. Open the Characteristics properties page of a risk, 
2. Open the Analysis section. 
3. Select the Risk Consequence, and cliick the New button.

The consequence creation page appears. 
 Since a risk consequence can relate only to a single risk, the Risk 
field is already entered with the current risk.

Cause-and-Effect Diagram
Analysis of the most important risks can be completed with the help of a cause-and-
effect diagram to describe the sequence of its causes and/or its effects. This study
could reveal new risks or risk factors.
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A Cause-and-Effect diagram, also called a "Ishikawa Diagram" or a "Fishbone
Diagram" enables description of a sequence of causes and effects for problem or
issue analysis.

Cause-and-effect diagram

In the above example, we analyze possible causes of the 
"Supplier delivery non-conform to purchase order" risk.
We list possible causes of the problem, and for each cause 
we specify the corresponding risk factors. At this point it 
is possible to identify new risks.

 For more information on the cause-and-effect diagram, see "Cause-
and-Effect Diagram" in the chapter "Objectives and Requirements" in 
HOPEX Common Features.
 For more information on the cause-and-effect diagram, see “Cause-
and-Effect Diagram” in the chapter in the HOPEX Common Features 
guide.
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ASSESSING RISKS

After having identified and analyzed the risks encountered by the enterprise, it is
essential to highlight the most important of these in order to remediate them. 

In HOPEX Risk Mapper, risk assessment is qualitative: the impact of a risk is
described by terms corresponding to a predefined scale (for example 1 to 4). In this
way mapping of risks can be established to quickly identify the most critical risks.

HOPEX Risk Mapper offers the possibility of a direct assessment, which allows an
expert to specify global assessment of a risk on a given date,

If you have the HOPEX Enterprise Risk Management  solution and you have
imported the associated framework, you have additional assessment facilities.

Results of risk assessment can be displayed in dedicated reports whick make it
easier to analyse the assessed risks. 

 For more details on the reports about risks, see Risk related 
reports.

Assessing risks directly
Direct assessment provides, at a given date, assessment of a risk on an entity of
the organization. 

You can carry out:
• direct assessment from a risk,
• multiple assessment from a table.

Creating direct assessments
You can create new assessments to globally assess a risk on all objects of the
organization to which it is connected (ie. entities).

This is an "expert view" assessment.

To create an assessment:
1. Select a risk,
2. Open the Assessment property page of the risk.
3. Click the Evaluate button.
4. Select the entities for which the risk is to be assessed, then click Next.

 The contexts are available only if there is more than one.
5. Specify characteristics values:

• Impact: the impact of the risk when it occurs.
• Likelihood: the probability that the risk will occur.
• Control levels

6. Specify the assessment date.
7. Click OK.

An assessment is created. 
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Representation in a Diagram
You can represent risks  and controls in a process diagram or an organizational
chart.

 You can easily represent risks and controls in a diagram using 
tabular entry mode. See Tabular entry mode principles.

To display risks in a process diagram with their likelihood:
1. Select Views and Details button.
2. In the right pane of the window, select “Risks and Controls” view.

Risks can be displayed in the diagram with colors that indicate their impact and
likelihood.

The colors vary according to the values resulting from the risk assessments.

Impact: medium, Likelihood: possible

Impact: very low, Likelihood: possible

Risk Summary

HeatMap by Entity/Risk Type/Process
When the likelihood and the impact of a risk have been specified, you can obtain a
summary view of risks to highlight the risks to be treated as a matter of priority.

 For more details on the reports about risks, see Heatmap report.
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RISK TREATMENT AND CONTROLS

The assessment of risks produced a list of risks that could require treatment, with their estimation
and order of priority.

Treating risks involves the identification of the various options possible, assessment of these options
and the preparation and implementation of treatment plans.

Before determining the appropriate treatment actions, it can be useful to review the risk analysis
and extend it to obtain the information required for identifying the different treatment options. The
design of risk treatment measures should be based on a perfect understanding of the risks
concerned; this understanding is obtained from an appropriate level of risk analysis. It is particularly
important to identify risk causes so that the risks themselves will be treated and not just their
symptoms.

It is not generally profitable, or indeed desirable, to implement all possible risk remediations. It is
however necessary to select and implement a combination of the most appropriate of these.

 Risk Treatment
 Controls

Risk Treatment
When risks have been analyzed and assessed, management determines how each
of these risks should be treated. 

To specify risk remediation choices:
 Open the Treatment property page of the risk.
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Target risk
For a given risk, you can define the level of risk acceptable for the organization.

 The target risk presents the residual risk value expected by the risk 
manager after treatment of the risk.

If this risk level is higher than or equal to the previously assessed risk, the
organization can accept the risk as it stands.

For each risk identified, a level of risk acceptable to the organization must be
defined. 

If the risk cannot be accepted as it stands, various solutions for facing the risk can
be proposed.

• Acceptance
The risk is accepted and no action is taken to try to reduce the risk.

• Reduction
Risk likelihood can be reduced by installing additional controls, or the
severity of its consequences can be reduced if the risk occurs.

• Transfer (sub-contractor)
The risk can also be shared with other partners, in particular when they
have greater skills in controlling the risk. For example, you can sub-
contract a dangerous activity to a partner specialized in the particular
field. In such cases, it should be noted that it is often necessary to carry
out a new risk study, since the introduction of a new partner can bring
additional risks.

• Insurance
To supplement all the above approaches, it is often necessary to resort to
insurance, in particular for risks of low likelihood but with high severity.
In such cases, the insurer will generally request that risk prevention and
reduction measures also be implemented.

We analyze the different possible scenarios, weighing up their positive and negative
aspects, so as to select a scenario compatible with the desired risk control level.

Depending on the solution adopted, the effect of the different solutions in terms of
likelihood and impact should be considered, as well as costs and benefits.
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The choice should be the solution that reduces residual risk to within the tolerance
limit required by management. 

A Detailed description field allows you to specify the risk treatment method.

Specification of actions to be implemented
Management draws up a set of actions matching risk levels with risk tolerance level
and risk appetite for the organization.

For each risk, the selected scenario is described in detail, with the various risk
factors and the controls implemented to counter them highlighted. Also specify
which controls are installed to warn of risks, as well as the curative business
processes to be implemented if the risks occur.

In the case of transfer to partners or assurance, we can specify contracts to be
agreed with them, as well as the predicted impact on organization processes.

Implementation of prevention controls to reduce risk frequency and impact can be
a solution for risk reduction.

To indicate the Controls and Action Plans enabling risk prevention:
 In the Treatment property page of a risk, expand the Controls and 

Action Plans section.
• The Action Plans tab contains the list of action plans installed: for 

example for creation or improvement of a control, management of a 
crisis linked to occurrence of an incident, or revision of a process with 
a view to its improvement. See Implementing Action Plans.

 An action plan comprises a series of actions, its objective being to 
reduce risks and events that have a negative impact on company 
activities. 

• The Controls tab lists controls planned for risk reduction. See Risk 
prevention controls.

 A control is a set of rules and means enabling the assurance that a 
legal, regulatory, internal or strategic requirement is respected. 

Risk prevention controls
Installation of prevention controls to reduce risk likelihood and impact can be a
solution for risk reduction.

To indicate the controls that enable risk prevention:
1. Open the Treatment property page of the risk that interests you and 

expand the Controls and Action Plans section.
2. Select the Control tab.
3. Click the Connect button and select a control.

 For more details on implementation of controls, see Controls.
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Implementing Action Plans
The use of action plans is available with the HOPEX Risk Mapper product. 

 An action plan comprises a series of actions, its objective being to 
reduce risks and events that have a negative impact on company 
activities. 
 For more information on use of action plans, see HOPEX Common 
Features. 
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CONTROLS

Control activities comprise policies and procedures that enable assurance that risk
treatment required by management has been effectively implemented. Control
activities are present throughout the organization, at every level and in every
function. They also include a range of varied activities such as validation,
authorization, verification, data mapping, operational performance review, assets
security and task assignment.

Risk identification and analysis previously described highlighted a certain number of
risks against which it is important to be protected. It is therefore necessary to define
the control activities that will prevent these risks and reduce their potential
consequences. 

These controls must be formally defined in order to respond to regulatory
requirements such as the Sarbanes-Oxley Act, or Basel II agreements in the
banking world.

 A control is a set of rules and means enabling the assurance that a 
legal, regulatory, internal or strategic requirement is respected.

In HOPEX Risk Mapper, there are different object types linked to controls:
• the object types enabling indication of the framework within which the 

control is installed (control system, control type, associated 
requirement or risk).

• the object types enabling indication of control implementation means 
(process, operation, service, constraint or resource, etc.).

• the object types enabling indication on responsibilities of control 
implementation (org-unit, person).

 Operation and service object types are available with HOPEX 
Business Process Analysis.

Identifying controls
It is generally preferable to inventory existing controls before implementing new
ones.
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To do so, controls can be identified in various ways:
• From risks

Certain controls are installed to meet a particular risk.
• From control type lists

Control type lists are associated with certain regulations (eg.: COBIT).
• From diagrams of existing business processes

Similarly to risk identification, it is possible to examine the operation of
each step in the business process from its diagram, if this exists, to
discover the controls installed.

• From specialist expertise
A specialist in a particular field is often able to describe controls which are
or should be implemented.

• From incident databases
By consulting past events, controls that could have prevented them or
reduced their consequences can be proposed.

Access to Controls
To create a control from the Processes pane:

 Click Controls & Risks > Controls.

As with risks, associated controls can be numerous. To improve control
management, HOPEX Risk Mapper proposes several control classification criteria.

 The controls covered by a control system can be viewed in the 
Treatment section of the Control System. For more details, see Control 
Systems.

Control characteristics
In the Characteristics property page of a control, you can specify:

• its Code enabling unique identification of the control
• Name
• Owner

 By default the owner is the control creator.

• control importance if required, by selecting the Key Control check box.
• Level
• Control Nature
• Execution Mode
• Frequency
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Control level
Control level enables the distinction to be made between "operational" and
"organizational" controls.

• level 1 - operational
Operational level controls are those executed during the normal operation
of enterprise business processes.

• level 2 - organizational
Organizational level controls are then carried out periodically by
management to check that operational processes have been correctly
executed and that their results comply with requirements.

Control nature
This characteristic concerns the motives of the control:

• Correction
• Detection
• Prevention

Control Execution Mode
This characteristic enables the specification of the way in which the
control is executed:

• Observation,
• Control by survey,

The control is executed on random samples.
• Systematic control

The control is executed systematically and exhaustively on all objects
treated.

Control Execution Mode
Control execution periodicity can be systematic, daily, weekly, monthly, etc.

RACI on a control
A control properties page includes an RACI section to define the different persons
responsible for control management. For more details, see RACI on a risk.

Control scope
You can define the control more precisely by indicating the risks, processes, entities
and requirements that are attached to it.

To define control scope:
1. Open the Characteristics properties page of a control.
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2. Expand the Scope section.
The following tabs are available:
• Risks covered by controls. For more details, see Assessing Risks.
• Business Processes and Organizational Processes exposed to 

risks covered by the control. For more details, see Organization 
Processes.

• Entities concerned by controls. For more details, see Organization of 
internal org-units.

Analyzing Controls
You can define the control more precisely by indicating the control systems that are
attached to it.

The control types enable specification of regulation frameworks that apply to a given
control. 

 For more details, see Risk types.

 A control type allows the classification of controls implemented in a 
company in accordance with regulatory or domain specific standards 
(Cobit, etc.).

This control system can be defined as the implementation of a regulation within the
framework of one of the enterprise business functions, such as application of an
enterprise financial policy in the purchasing field.

 For more details, see Control Systems.

 A risk and control system is a set of controls that enables the 
assurance of risk prevention and management, application of internal 
operating rules, respect of a law or regulation, or achievement of an 
objective as defined by company strategy.

Control Objectives and Requirements
The Objectives and Requirements property page of a control provides indication
of the organization objective or regulatory or legal requirement met by the control.

 An objective is a goal that a company/organization wants to 
achieve, or is the target set by a process or an operation. An objective 
allows you to highlight the features in a process or operation that 
require improvement.

 A requirement is a need or expectation explicitly expressed, 
imposed as a constraint to be respected within the context of a project. 
This project can be a certification project, or an enterprise information 
system organization or modification project.
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Control Implementation
Installation of a control frequently consists of checking that a management rule
(constraint) is effectively applied, either manually or by an IT program.

 A constraint is represented by a check or a business rule that must 
be applied during processing.

You can specify the management rules associated with a control in its Management
Rules property page.

It is possible to specify processing that will implement the control or the
management rules associated with the control. You can specify control
implementation means in the Characteristic tab, Scope section.

The control can be implemented by:
• a process: this can be the business process on which the control is 

implemented or it can be a risk preventive business process (example: 
"Account manager training" to prevent the "Overselling" risk)

 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
implementation of the business process in the organization. A business 
process can also be detailed by a functional view.

• an operation: this is the operation on which the control is executed.

 An operation is an elementary step in an organizational process 
executed by an org-unit. It cannot be broken down. An operation can be 
industrial (manufacturing a component), logistical (receiving a 
delivery), or can involve information processing (entering an order).
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RISK CONTROL POLICIES OPERATIONAL MONITORING

Policies and procedures are established and implemented to help ensure that risk responses are
effectively carried out.

Monitoring is accomplished through ongoing management activities, independent assessments, or
both.

 Control System Ongoing Improvement
 Control Efficiency Assessment
 Incident and Loss Monitoring

Control System Ongoing Improvement
Malfunctions identified via permanent operation monitoring or during periodic
reviews are referenced and analyzed. Corrective actions are then planned and
implemented.

• Malfunction identification
The malfunctions to be examined are identified using a number of
available sources: the initial remediation plan, feedback on risk
remediation and incidents in installed control systems, and periodic
reviews by operational management.

• Malfunction analysis
Malfunctions are studied to deduce risks faced by the organization. These
are then analyzed as previously discussed by determining risk factors with
the possible help of a cause-and-effect diagram.

• Risk treatment implementation
When the risk treatment actions to be undertaken, the control data
storage requirement, and the risk measurement indicators to be
implemented have been determined, an action plan including the
necessary resources, budgets, deadlines and implementation managers is
defined.

• Risk treatment action plan monitoring
The frequency and terms of risk treatment plan monitoring are
established.

The HOPEX Business Process Analysis repository enables the definition of
controls carried out during enterprise business process execution, and the
specification of which organizational, IT or human resources will implement them
(see Risk Treatment and Controls).

Control Efficiency Assessment
In addition to the continuous monitoring of risks during normal operation of
organization business processes, periodic reviews of risk management are carried
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out by operational managers to verify that new risks have not appeared and that
the risk treatment strategies applied are still suitable and effective. To determine
this, control self-assessment questionnaires can be used.

In addition to the operational management reviews, audits that are internal or
external to the activity offer an outside view of organization operation, and can
reveal new malfunctions. 

Audit findings will usually indicate systemic weaknesses of the risk management
system. Actions taken in response to audits should be focused on remedying the
system and not just the symptoms. 

 For more information, see HOPEX Internal Control.

Incident and Loss Monitoring
After implementing a risk management policy, continuous monitoring of risks
incurred using regular measurement of a number of parameters (eg: pollution
levels, available budget, etc.) must be established to verify its efficient operation.

This can be done in particular through incident database management. Each
incident is listed here and the resulting losses are evaluated. In certain cases, it is
enough to ensure that the incident monitoring activity has been correctly executed
and that it has not produced results exceeding anticipated tolerance thresholds.

If new risks are identified at this point, they should be added to the list of risks
managed by the organization. Operational managers or the risk management
manager within the organization must take these into account at the next risk
review.

 For more information, see HOPEX LDC.
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RISK RELATED REPORTS

This paragraph presents the list of reports available with HOPEX Business Process
Analysis and dedicated to  risks handling.

• Heatmap report.

Heatmap report
This report inventories risks incurred by a set of processes as well as the controls
implemented. It presents, in the form of a matrix, distribution of risks and controls
associated with a list of processes in relation to these criteria.

Report parameters

Subject of this report type is a set of processes.
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MANAGING QUALITY

HOPEX Business Process Analysis  offers functions that simplify creation and
maintenance of a quality system conforming to ISO 9000 standards. You can:

• Draw up your organizational processes graphically using organizational 
process diagrams.

• Enter the characteristics specific to the quality problem.
• Synchronize your processes and the various chapters or themes of the 

quality repository on which you are based (ISO 9001 standard, 2015 
edition, etc.).

• Generate a quality manual automatically

Prerequisites to Use of Quality
An option is used to display the properties dedicated to the management of
processes quality.

To activate this option:
1. In the workspace, open the Options navigation window.
2. In the tree on the left, select HOPEX Solutions > Business Process 

Analysis. 
3. Select the check box Quality Modeling.
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ORGANIZATIONAL PROCESS PROPERTIES

In the properties dialog box of an organizational process, the Quality tab allows you
to:

• enter quality characteristics specific to processes.
• indicate to which section of which repository the process you are 

describing refers. In this way, the processes are associated with chapters 
or themes so as to indicate their field of application. 

Indicating Organizational Process Quality Characteristics 
From the Quality tab and the Details section, you can define characteristics that
are specific to the quality issue.

Organizational process types and classes
Two types of organizational process are managed: 

• "General" organizational processes: involve the entire enterprise or 
organization.

• "Specific" organizational processes: specific to a part of the enterprise or 
to a product. 
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Organizational process classes proposed are: 
• "Normal" organizational processes: describe the typical operations of the 

enterprise. 
• "Urgent" organizational processes: describe a fast track such as 

providing speedier service to a customer. 
• "Special" organizational processes: used for exceptional events such as 

accidents. 

Other organizational process characteristics
The QA-Organizational Process field allows you to specify if the procedure forms
part of the Quality Assurance (external) or Quality System (internal) documentation
of the organization. 

 This option concerns the 1994 version of ISO 9001 standard.

The Frequency of the process can be: 
• “On Request”: the process is applied when the event that triggers it 

occurs.
• Daily, Weekly, Monthly, Twice a Month, Quarterly, or Annually.

The Application date and End of validity date of the process can also be
indicated.

 The application and validity end dates are displayed using the 
Windows default format. You can change this format in the Regional 
Settings properties dialog box (short date). 
To enter a date beyond the year 2000, you should select short date 
format of type dd/MM/yyyy with four characters for the year.
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Entering the texts of an organizational process
The Quality property page of an organizational process includes a Texts section
that allows you to enter different types of text (standard): “Application domain”,
“process object”, “references”, “definitions”, etc. 

Specifying Context of the Quality Approach
The Quality property page of an organizational process includes a Chapters
section that allows you to specify the standard on which you are based for your
quality approach or certification.

 To have access to data relating to the standard ISO 9001 2015, you 
must have imported the "ISO" module. For more details, see “Importing 
a module in HOPEX" in HOPEX Administration guide.
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The subtabs ISO 9001 and Other chapters correspond to different repositories
serving as the basis for your quality approach:

• ISO 9001
This sub-tab presents the 20 chapters (or requirements) of the ISO 9001
standard. 

• Other chapters
This sub-tab concerns you if you are using another standard for your
quality approach or certification. The chapters that you may have created
will appear here.

 To create new chapters you must use the explorer.
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The Quality properties page allows you to specify characteristics of a message flow
related to quality.

The Message-Type list box enables characterization of the message flow: "External
Data", "Quality Record" or "Instruction". 

The other fields allow you to enter additional indications for messages of “Quality
record” type that are particularly important in documentation of your quality
system. Here you can define the controls needed for identification, storage,
retention time, etc. 

 According to the ISO 9000 standard, a "Record" is a “document 
stating results achieved or providing evidence of activities performed”. 
It can document traceability and provide evidence of the verification, 
preventive action, and corrective action. It can consist of a form, report, 
list of actions, etc. It can be written or saved on any data carrier. 
Generally records need not be under revision control.
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ACTION PLANS WITH HOPEX BUSINESS 
PROCESS ANALYSIS

HOPEX Business Process Analysis allows you to specify, implement and follow up action plans
defined for managing, for example, a Customer Journey.

 An action plan comprises a series of actions, its objective being to 
reduce risks and events that have a negative impact on company 
activities.

The following points are covered here:

 Managing Action Plans with HOPEX Business Process Analysis
 Managing actions with HOPEX Business Process Analysis

Managing Action Plans with HOPEX Business Process Analysis
An Action plan can be set up, for example, to improve the efficiency of a process.

 An action plan comprises a series of actions, its objective being to 
reduce risks and events that have a negative impact on company 
activities.

Creating Action Plans with HOPEX Business Process Analysis
With HOPEX Business Process Analysis, an action plan is connected to a process.

To create an action plan from an organizational process, for example:
1. Open the Action Plans property page of the process that interests you.
2. Click New.
3. Enter the Name and the dates (Planned Begin Date and Planned End 

Date) and click OK.
The new action plan is created in the list of action plans of the process.

 To create an action plan from a Customer Journey, see Creating an 
Action Plan for a Customer Journey.
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Characterizing Action Plans
 For more details on action plans characteristics, see chapter 
"Entering Action Plan Information" in the HOPEX Common Features 
guide.

Accessing the list of action plans with HOPEX Business Process Analysis
To access the list of action plans from the Projects navigation pane:

1. Select Corrective Action Plans .
2. Expand the Action Plans folder.

The list of action plans appears.

Action Plans execution with HOPEX Business Process Analysis
During the execution, an action plan takes different states. Passage between states
is submitted for the approval of the action plan owner or the action plan approver.

 For more details on an action plan execution, see the, chapter 
"Action plan execution" in the HOPEX Common Featuresguide.

With HOPEX Business Process Analysis, actions can be created as long as the
action plan is not closed.

 For more details, see Managing actions with HOPEX Business 
Process Analysis.

Having specified the characteristics of a new action plan, the creator can: Send the
action plan to the “Approver” user. 

The action plan "Approver" user can: Reject or Start the action plan. 

When the action plan actions are closed, the “Owner” user must Close the action
plan.

After having consulted action plan follow-up reports, the "Approver" user can: Close
or Reopen the action plan for complementary actions.

Preparing the action plan progress follow-Up

Action plan progress is specified at periodic dates by the action plan responsible
user. 

HOPEX Business Process Analysis offers the opportunity to regularly remind the
action plan owner user by email to update the progress of his action plan using a
steering calendar.

 For more details on an action plan execution, see the, chapter 
"Action plan execution" in the HOPEX Common Featuresguide.

Managing actions with HOPEX Business Process Analysis
With HOPEX Business Process Analysis, the action plan Owner can propose and
assigning actions corresponding to the execution of the action plan.

 An action is included in an action plan and represents a 
transformation or processing in an organization or system.
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Action Plans with HOPEX Business Process Analysis

To create actions, the action plan status must be "In progress", that is it has been
validated by the “Approver” user.

 For more details on the actions management, see "Managing 
action” chapter in  guide HOPEX Common Features.



254



255

CONVERSATIONS

This chapter presents how to describe conversations between process architecture components.

 A conversation describes an exchange of several message flows 
between two roles.

 A composite conversation is described by an exchange contract. 
This exchange contract uses other exchanges or exchange contracts.

 Conversations Example
 Managing Conversations
 Managing Exchange Contracts
 Summary of Concepts
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CONVERSATIONS EXAMPLE

The Conversation concept is introduced in standard BPMN 2.0.

In HOPEX Business Process Analysis, a conversation is implemented by an
Exchange.

 An exchange specifies message flow exchanges between two 
participants.

The example of purchase request processing involves several 
exchanges between the requester and the "Purchasing 
Assistant".
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At the highest level, these exchanges can be represented by 
the same message flow.

A conversation is described by a set of message flows with content.

An exchange diagram can be built presenting the sequence of message flows
exchanged.

The "Purchase Request" exchange diagram is shown below.
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A conversation represents the exchange of information between architecture
components.

 A conversation describes an exchange of several message flows 
between two roles.

Creating Conversations

Creating Conversations with an Existing Exchange
A conversation is described by an exchange representing an information exchange
channel between architecture components.

 An exchange specifies message flow exchanges between two 
participants.

To create a conversation from an existing exchange:

1. In the process diagram insert toolbar, click the Conversation  
button.

2. Draw a link between the two entities in communication.
3. In the conversation creation window, specify the Exchange you wish to 

use.
 You can also create a new exchange, see Creating Conversations 
with a New Exchange..

4. Click OK.

Creating Conversations with a New Exchange
You can create an Exchange from a library or a process diagram.

To create an exchange from a process diagram:

1. Click the Conversation button  and create a link between the two 
communicating entities.
The conversation creation dialog box appears.

2. Click the arrow at the right of the Exchange field and select Create 
Exchange.
The Creation of Exchange dialog box appears.

3. Enter the Name of your exchange.
4. Click OK to close this dialog box.

The exchange is automatically created.
5. Click OK.

The conversation appears in the diagram.
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Describing Conversation Message Flows
The message flows exchanged in a conversation are described in the exchange
associated to the conversation.

 A message flow represents circulation of information within an 
exchange contract. A message flow transports its content.

Exchange is described by message flows and their content which are exchanged
between the two roles representing the stakeholders in the conversation.

 The content designates the content of a message or an event, 
independent of its structure. This structure is represented by an XML 
schema linked to the content. A content may be used by several 
messages, since it is not associated with a sender and a destination. 
There can be only one content per message or event, but the same 
content can be used by several messages or events.

To describe message flows exchanged in a conversation:
1. Open the Characteristics property page of the Conversation that 

interests you.
2. From Exchange field, you can access to the pop-up menu of the 

exchange used.
3. Open the Message Flow  property page of the exchange.
4. Click the New button.

The Creation of Message Flow - Content dialog box opens.
5. From the Content drop-down list, select the content you wish to 

associate with the message flow.
The message flow with its content is displayed in the list of conversation
contents.

 You can associate several contents with the message flow.
6. Specify the direction of each message flow.
7. Click OK.
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Creating an exchange diagram (BPMN)
The sequence of flows exchanged during a conversation can be described by an
exchange diagram.

"Customer Identification Service" Exchange Diagram

The customer identification service protocol begins by 
sending information enabling identification of the 
customer. An error message appears if the customer is not 
found, otherwise customer information is sent (customer 
identification, status of orders, etc.).

To create an exchange diagram:
1. Open the Characteristics property page of the Conversation that 

interests you.
2. From Exchange field, you can access to the pop-up menu of the 

exchange used.
3. In the pop-up menu of the exchange, select New  > Exchange 

Diagram (BPMN).

The diagram opens. The exchange frame is positioned and the two roles (Consumer
and Supplier) are created. The message flows associated with the exchange are also
positioned in the diagram.
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Creating a composite conversation
A composite conversation is described by an exchange contract. This exchange
contract uses other exchanges or exchange contracts.

 An exchange contract is a model of a contract between 
organizational entities. This contract is described by exchanges between 
an initiator role and one or several contributor roles.
 For more details on exchange contracts, see Managing Exchange 
Contracts.

To create a composite conversation from an existing exchange contract:
1. In the diagram insert toolbar, click the Composite Conversation 

button.
2. Draw a link between the two entities in communication.
3. In the composite conversation creation window, specify the Exchange 

contract you want to use.
 You can also create a new exchange contract. 

4. Click OK.

Replacing a conversation

As standard, a conversation is connected to an exchange. However, from its pop-up
menu, you can replace a conversation with a composite conversation or by the
message flows of the exchange to which it is associated.

Replacing a conversation with an exchange contract

To replace a conversation:
1. Right-click on the conversation to open its pop-up menu.
2. Select Replace Exchange by an Exchange contract.

A new exchange contract is created and the conversation becomes a
composite conversation.

 A composite conversation is described by an exchange contract. 
This exchange contract uses other exchanges or exchange contracts.

Replacing a conversation with flows

To replace a conversation:
1. Right-click on the conversation to open its pop-up menu.
2. Select Replace by Message Flows.

The conversation is replaced by the messages flows of its associated
exchange.
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MANAGING EXCHANGE CONTRACTS

An Exchange Contract represents the exchange of information between
architecture components of the process.

 An exchange contract is a model of a contract between 
organizational entities. This contract is described by exchanges between 
an initiator role and one or several contributor roles.

With HOPEX Business Process Analysis, an exchange contract can be built using
exchanges or using exchange contracts.

Exchange Contract Example

Example of exchange contract using exchanges
The "Customer Identification" exchange starts with a 
customer search step. If the customer is found, the protocol 
returns customer information, if not, a "Customer Creation" 
protocol is activated. The result of the "Customer 
Identification" exchange contract is a "Customer 
Information" message.

Exchange contract diagram (BPMN)

Progress steps are represented by Exchange Uses.
 An exchange use represents the usage of an exchange in another 
exchange contract.
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Example of exchange contract using exchange contracts
With HOPEX Business Process Analysis, a protocol is described by a sequence
flow of steps which are represented:

• by Exchange Uses,
• by Exchange Contract Uses.

 An exchange contract use is associated with an exchange contract. 
It enables representation of complex exchanges.

The protocol roles, presented at the border of the frame, represent participants
invoker or invoked.

An exchange can be described by involving more than two participants. In this case,
a role is consumer of the exchange contract and the others are providers.

"Information Requirement" Exchange Contract Diagram (BPMN)

The "Information Request" exchange contract is used by the 
supplier call center to take account of a customer request 
online. There are therefore three participants in this 
contract: the customer, the IT applications and the 
customer representative who is the effective requester of 
the service (in this case the call center). 
This contract consists of identifying the customer, then 
analyzing the request. The request is then processed as a 
purchase request or as another request if it is an 
information request for example.
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Using Exchange Contracts
An Exchange Contract is described by a Composite Conversation which
represents the information exchange channel between architecture components.

 An exchange contract is a model of a contract between 
organizational entities. This contract is described by exchanges between 
an initiator role and one or several contributor roles.

 A composite conversation is described by an exchange contract. 
This exchange contract uses other exchanges or exchange contracts.

To create a composite conversation:

1. In the diagram insert toolbar, click the Composite Conversation  
button.

2. Draw a link between the two entities in communication.
3. In the add composite conversation dialog box, specify the name of the 

conversation and the exchange contract you want to use.
 You can also create a new exchange contract, see Creating 
Conversations with a New Exchange..

4. Click OK.

Creating an exchange contract from a composite conversation
To create an exchange contract from a composite conversation:

To create an exchange contract from a composite conversation:

1. In the diagram insert toolbar, click the Composite Conversation  
button.

2. Draw a link between the two communication entities.
3. In the composite conversation creation dialog box, click the arrow on the 

right of the Exchange Contract field and select Create Exchange 
Contract.
The Creation of Exchange Contract dialog box opens.

4. Select the Creation Mode. Standard Creation.
 You can create an exchange contract from an exchange contract 
model. For more details, see chapter “Creating an exchange contract 
from an exchange contract model” in the  HOPEX IT Architecture 
guide.

5. Enter the name of the contract in the Name box.
6. Click OK.

The composite conversation and exchange contract are created.
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Describing Exchange Contracts
An Exchange Contract can be supported by Exchanges or Exchange Contracts
representing information exchanges between architecture components.

 An exchange contract is a model of a contract between 
organizational entities. This contract is described by exchanges between 
an initiator role and one or several contributor roles.

 An exchange use represents the usage of an exchange in another 
exchange contract.

 An exchange contract use is associated with an exchange contract. 
It enables representation of complex exchanges.

To describe that an exchange is used by an exchange contract:
1. Open the exchange contract properties dialog box.
2. Select the Exchange tab.
3. Click the New button.

A selection dialog box opens.
4. Select Exchange Use, which is the type of exchange you want to use, 

and click OK.
The creation dialog box opens.

5. Click the arrow at the right of the Specification box.
6. Select List in the drop-down list and select the exchange to be 

associated with the exchange use.
The name of the exchange appears in the Specification field.

7. In the From field, select the described exchange role connected to the 
Invoker role of the exchange used.

8. In the To field, select the described exchange role connected to the 
Invoked role of the exchange used.

9. Click OK.
 You can associate several exchanges with the exchange contract.

10. Click OK.

Creating an Exchange Contract Diagram
With HOPEX Business Process Analysis, an exchange contract is represented by
an Exchange Contract Diagram (BPMN).

To create an exchange diagram:
1. Right-click the conversation containing the exchange.
2. In the pop-up menu of the exchange, select New  > Exchange 

Contract Diagram (BPMN).

The diagram opens with the exchange contract frame and the two roles representing
invoker or invoked.
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Defining exchange and exchange contract uses
In an Exchange Contract Diagram (BPMN), operations are described by:

• Exchange Uses
• Exchange Contract Uses

 An exchange use represents the usage of an exchange in another 
exchange contract.

 An exchange contract use is associated with an exchange contract. 
It enables representation of complex exchanges.

To create an exchange contract use:

1. Click the Exchange Contract Use button  and click in the diagram 
within the exchange contract frame.
The creation dialog box opens.

2. Click the arrow at the right of the Specification box.
3. Select List in the drop-down list and select the exchange contract 

associated with the exchange contract use.
4. In the From field, select the described exchange role connected to the 

Invoker role of the exchange used.
5. In the To field, select the described exchange role connected to the 

Invoked role of the exchange used.
6. Click Finish.
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SUMMARY OF CONCEPTS 

Exchange Exchange contract

Definition An exchange specifies message flow 
exchanges between two participants.

An exchange contract is a model of a 
contract between organizational entities. 
This contract is described by exchanges 
between an initiator role and one or sev-
eral contributor roles.

Use in a Process 
Diagram

 A conversation describes an 
exchange of several message flows 
between two roles.

 A composite conversation is 
described by an exchange contract. This 
exchange contract uses other exchanges 
or exchange contracts.

Use in an 
Exchange Con-
tract Diagram

 An exchange use represents the 
usage of an exchange in another 
exchange contract.

 An exchange contract use is associ-
ated with an exchange contract. It 
enables representation of complex 
exchanges.
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DESCRIBING A PROCESS PORTFOLIO

Creating a portfolio with HOPEX Business Process Analysis allows you to define all the
information that will then enable you to select initiatives to be implemented. 

 A portfolio enables representation of all investments of an 
enterprise (or department) necessary to carry out changes required to 
achieve strategic objectives. It comprises a set of initiatives to be 
compared based on comparison criteria associated with the portfolio.

 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

You will begin by:

 Creating a process portfolio
 Defining Criteria
 Defining Portfolio processes
 Using Scenarios
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INTRODUCTION TO PROCESS PORTFOLIO USE

By means of portfolio management, HOPEX Business Process Analysis enables
planning over time of development of organizations and more generally all
enterprise architecture. 

Describing and Analyzing Portfolios

HOPEX Business Process Analysis, portfolio concept allows to compare
processes on criteria standard such as costs, benefits or risks. You can also define
criteria specific to your context.

Reports dedicated to portfolios allow you to create charts enabling analysis of
portfolios on different comparison criteria you have defined.

Analysis reports can be grouped in a HOPEX book or integrated in an Internet site.

Developing portfolios
Your enterprise processes, will without doubt be developed. So that representation
of your organization remains updated, your models will be modified. 

The process portfolios allows you to plan and follow up these developments.
• You can quickly access processes of which development is planned.
• You can transfer the impacts of development of a process to other 

programs in which this element appears.
• You can regenerate all reports in which this process is involved.

The aim of this chapter is to introduce you to the main use of Process Portfolio
facilities.
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CREATING A PROCESS PORTFOLIO

Creating a process portfolio consists of defining the processes and the comparison
criteria relating to the portfolio.

 A portfolio enables representation of all investments of an 
enterprise (or department) necessary to carry out changes required to 
achieve strategic objectives. It comprises a set of initiatives to be 
compared based on comparison criteria associated with the portfolio.

Creating a process portfolio
HOPEX Business Process Analysis allows you to define process portfolio.

To create a process portfolio from the Projects navigation pane:
1. Select Process portfolios.
2. Click the Process portfolios tile.

The list of process portfolios is displayed.
3. Click New.

A creation dialog box opens.
4. Enter the Process Portfolio name and click OK.

The new portfolio appears in the list.

Creating a Process Sub- Portfolio
To be able to closely study development hypotheses, you can divide a portfolio into
sub-portfolios, each subject to different scenarios.

To create a sub-portfolio:
1. Open the Characteristics property page of the portfolio that interests 

you.
2. Expand the Sub-Portfolios section and click New.
3. Modify the name of the sub-portfolio. 

 If a scenario is associated with a main portfolio, it is not inherited 
by the sub-portfolio.
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Process portfolio characteristics
A portfolio  is described by the Characteristics property page.This page describes

• the general characteristics of a portfolio are: 
• name, 
• Portfolio type, 
• Project start and end dates, 
• description.
• As well as:

• The list of Owned Scenario: see Creating a Scenario.
• The list of Sub-Portfolios: see Creating a Process Sub- Portfolio.
• The list of Criteria of the process portfolio, see Defining Criteria.

The Processes property page enables listing of portfolio processes to evaluate their
criticality. See Defining Portfolio processes.
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DEFINING CRITERIA 

You can compare processes of a portfolio based on common criteria associated with
the portfolio.

 A criterion is a reference element used to compare initiatives in a 
portfolio. Criterion values can be predefined.

To view criteria associated with a portfolio: 
 Open the Characteristics property page of a portfolio and expand 

Criteria section.

Example 

To define portfolio criteria, you can:
• Use criteria already existing in the repository.
• Create new criteria and associated values.

 Criteria are defined from the MetaClass (object type) 
TaggedValue. Certain dialog boxes use this term rather than Criteria.
 For more details on the assessment of a portfolio criteria, see 
"Defining Portfolio Assessment criteria" in the HOPEX IT Portfolio 
Management guide.
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DEFINING PORTFOLIO PROCESSES

Several processes can be grouped in a group to simplify portfolio management.

Associating a process to a portfolio
To associate, for example, an organizational process to a portfolio:

1. Open the Processes > Inventory page of the portfolio that interests 
you.

2. Select the Organizational processes List tab.
3. Click Add Organizational Process button.

The search window appears.
4. Select the process that interest you.
5. Click Connect.

Creating a Processes Group
To create a processes group from a portfolio:

1. Open the Processes > Group page of the portfolio that interests you.
2. Click the New button.

The Create group dialog box opens.
3. In the Name field, enter the name of the group.
4. Click OK.

The group appears in the list of portfolio processes groups.

To connect an organizational process to a group:
1. Open the Processes property page of the group.
2. Select the Organizational processes List tab. 
3. Click Add Organizational Process button.

The search window appears.
4. Select the process that interest you.
5. Click Connect.

Modeling costs from a process portfolio
To view costs defined on a process associated to a portfolio from the Projects pane:

1. Select Process portfolio.
2. Click the Hierarchical view tile.

The hierarchy of process portfolios and reports is displayed.
3. Expand the folder of the process portfolio that interests you.

The list of processes appears.
4. Open Cost property page of the process that interests you.
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Evaluating Process portfolios
Pprocess portfolio are assessed related to different portfolio criteria.

Accessing objects to be evaluated
To access and assess all portfolio objects:

1. Open the  Processes > Assessment properties page of the process 
portfolio.
The matrix for assessment of all objects connected to portfolio initiatives
according to different criteria is displayed. 

2. To define a criteria value on an application, such as a Priority level, select 
the process concerned and click in the criteria column.

Generating an instant report on evaluation data
Instant reports allow you to carry out drill-down analysis on evaluated objects. They
provide greater detail depending on specific analysis perspectives (quantitative,
time, etc.).

To generate an instant report on a list of process:
1. In the list of processes, select those to be analyzed.

If you do not select any process, by default the report covers all
processes.

2. Click theInstant Report button.
3. Select the required analysis type, for example "Bubble 

(Multidimensional)". 
4. Click OK. 
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5. In the list of possible grouping criteria, select “Costs”.
For all the selected processes, you obtain the breakdown of
implementation risks according to their level. 

 For more information on instant reports, see the paragraph 
"Running instant reports on a list of objects" in the chapter "Generating 
Documentation" of the HOPEX Common Features guide.

Creating a Process Assessment Report
This report is a matrix that presents the value of the criteria presented in columns
related to portfolio processes in rows.

To generate this matrix from the Report navigation pane: 
1. Select Other Reports then the Reports tile.
2. In the My Reports tab, click New.

The report creation dialog box opens.
3. In the list of report templates, select “Portfolio Initiative Assessment 

Sheet”, then click Next.
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4. Select the process portfolio that interests you and the associated criteria.
You obtain a result like this:

Report parameters

Parameter Parameter type Constraints

Portfolio (in 
line)

Portfolio One object mandatory.

List of critera 
(in column)

Portfolio criteria At least one mandatory criteria.
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USING SCENARIOS

Several initiatives can relate to the same object, in the same portfolio, to represent
different hypotheses (exclusive between themselves) of the same object.

Then, some Scenarios can be created by selection of a set of processes. The
different scenarios created can be compared by means of specific reports:

 A scenario is a projection in time of development of real objects 
through initiatives.

 Creating a Scenario
 Accepting or Rejecting Scenario Processes

Creating a Scenario
A scenario is a coherent set of processes enabling the cost of a hypothesis in process
portfolio.

To create a scenario on a portfolio:
1. Open the Characteristics property page of the portfolio that interests 

you.
2. Expand the Scenario section and click New.

The scenario is created with a default name. It is also automatically
connected to processes of the portfolio.

You can open the scenario properties to modify its name if necessary or to define
its properties.

Accepting or Rejecting Scenario Processes
A process must be accepted in order to be taken into account in a given scenario.
Conversely, a process must be rejected if you want the scenario to ignore it.

To define processes be taken into account in a scenario:
1. Open the Characteristics properties page of the portfolio you want to 

study.
2. In the Scenario section, select the scenario you are interested in.

The list of processes connected to the scenario appears in the matrix.
3. In the matrix, click the cells at intersections of processes and scenarios 

and select one of the following values:
• In progress: the process is under study, it is integrated in the 

scenario
• Rejected: the process is not taken into account in the scenario
• Accepted: the process is integrated in the scenario
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Using Scenarios
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HOPEX BUSINESS PROCESS ANALYSIS 
REPORTS

HOPEX Business Process Analysis
 offers analysis and follow-up of implementation of the business architecture evolutions of your
enterprise. HOPEX Suite uses reports to group sets of repository objects and study their
interactions. 

 For more details on operation of reports, see the HOPEX Common 
Features guide, "Generating Reports".

Report templates proposed as standard by HOPEX Business Process Analysis offer various
analysis presentation possibilities.

The following points are covered here:

 Organization management 
 Managing Processes 
 Business and IT Ressources 
 Process deployment 
 Process Assessment
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ORGANIZATION MANAGEMENT

This paragraph presents the list of reports available from Organization.
• Org-Units Analysis.
• Managing RACI (BPMN).
• Org-Unit RACI Matrix (BPMN).
• Org-Unit and owned org-units RACI Matrix (BPMN).

Org-Units Analysis
This report details the organizational structure, the responsibilities and the sites
associated to the org-units specified as parameters.

This report is broken down into three parts:
• The first part details organizational structure of each org-unit specified 

as parameter. In this part, the org-units analyzed are listed with their 
type, parent, sub-org-units, persons involved in execution of the tasks 
associated with the org-unit, including other information related to these 
persons. This part also displays statistical data: number of org-units, 
number of persons.

• The second part describes responsibilities of org-units. It presents detail 
of operations executed by the org-units and the processes for which it is 
responsible. This part also displays statistical data: maximum, minimum 
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and average value of operations executed per org-unit, as well as 
equivalent values for assigned processes.

• The final part presents geographical distribution of org-units on sites.
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Report parameters

 Org-units can be distributed in sub-groups. In this case, statistical 
values are calculated for each of these.

Org-Unit RACI Matrix (BPMN)
Like report Organizational Process RACI Matrix (BPMN), this report describes a
matrix presenting the RACI value of org-units presented in columns related to
operations and organizational processes presented in rows.

 For more details on managing RACI, see Process responsibilities.

This report automatically specifies matrix rows and columns with objects connected
to objects specified as parameters.

 To generate a matrix to search for organizational processes and 
operations in depth, you must use report Org-Unit and owned org-units 
RACI Matrix (BPMN).

Report parameters

Org-Unit and owned org-units RACI Matrix (BPMN)
Like report Organizational Process and sub-processes RACI Matrix (BPMN), this
report describes a matrix presenting the RACI value of org-units presented in
columns related to operations and/or organizational processes presented in rows.

 For more details on managing RACI, see Process responsibilities.

The second parameter of this report indicates the number N of the depth level of
search for sub-org-units. If this number is not indicated, the complete hierarchy of
sub-org-units is specified.

The report searches for all sub-org-units of the given org-unit given as parameter
to N levels and adds this org-unit. It presents in columns the org-units found, and

Parameter Parameter type Constraints

Org-units ana-
lyzed

Org Unit Not mandatory. If no value is given, 
all org-units are analyzed.

Parameter Parameter type Constraints

Org-unit (in 
columns)

Org Unit At least one object mandatory.
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in rows the operations or organizational processes associated with these org-units,
with the RACI value in the cell.
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MANAGING PROCESSES

This paragraph presents the list of reports available from a process.
• Comparaison de diagrammes BPMN. 
• Conformité de diagrammes de processus ;
• BPMN Organizational Process.
• Inconsistency of Message Flows in a Process.
• Managing RACI (BPMN).
• Organizational Process RACI Matrix (BPMN).
• Organizational Process and sub-processes RACI Matrix (BPMN); 
• Graphe d’impact du processus.

Comparaison de diagrammes BPMN
 For more details on the use of a diagram comparison report, see 
“Comparing diagrams” chapter in the HOPEX Common Features 
guide.

This report can be accessed from the Reports > Processes Follow-up navigation
pane.

To activate this report:
1. Click on Diagram comparison tile.

An edit window opens.
2. For the diagrams that interest you, select the Source object  and 

Target object.
 The comparison is based on the hypothesis that the target object 
has been created from a source object version.

3. Select, for each object, the diagram to be be compared.
4. Click the Refresh Report button.

The report is displayed providing the following informations:
• The list of deleted objects: name and type of objects existing in the 

diagram of the older object (source object) but not in the diagram of the 
most recent object (target). 

 If the target object is in a version less recent than the source 
object, HOPEX automatically manages the error correction.

• The list of new objects: name and type of objects existing in the 
diagram of the most recent object (target) but not in the diagram of the 
older object (source).

• The list of modified objects that provides:
• The name and the type of each object whose name has been modified 

in the target object.
• The name and the type of objects connected to different participants 

in the target and the source diagram.
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Conformité de diagrammes de processus
This report enables comparison of the diagram of two different processes. This
report is based on the diagram comparison report principle, but there is no
constraint on the diagrams defined as parameters.

 For more details on the use of a diagram comparison report, see 
“Comparing diagrams” chapter in the HOPEX Common Features 
guide.

This report can be accessed from the Reports > Processes Follow-up navigation
pane.

To activate this report:
1. Click on Diagram Conformance  tile.

An edit window opens.
2. Select the Object Type of the diagrams owners.
3. Select the Source Object and the Source Diagram.
4. Select the Target Object and the Target Diagram.

 The comparison is based on the hypothesis that the target object 
has been created from a source object version.

5. Click the Refresh Report button.

The report is displayed providing the following informations:
• The list of Deleted objects: name and type of objects existing in the 

source diagram but not in the target diagram. 
• The list of New objects: name and type of objects existing in the target 

diagram but not in the source diagram.
• The list of modified objects that provides:

• The name and the type of each object whose name has been modified 
in the target object.

• The name and the type of objects connected to different participants 
in the target and the source diagram.

BPMN Organizational Process
Like report Support of Processes by Applications Table (Statistics), this report
describes an organizational process, its template and its participants, as well as the
activities for which each participant is responsible. This analysis also presents
exchanges, systems used to support activities and the risks encountered during
process execution.

Report parameters

Parameter Parameter type Constraints

Object Organizational 
Process

One object mandatory.
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Inconsistency of Message Flows in a Process
This report provides a detailed view of the inconsistencies on the flows exchanged
by a process with the outside. The flows, and associated content, exchanged with
the outside must be described in the process diagram.

 For more details, see Defining Message Flows.

Report parameters

This report only details the flows in error.

Managing RACI (BPMN)
Like report Organizational Process RACI Matrix (BPMN), this report describes a
matrix presenting the RACI value of org-units presented in columns related to
operations and organizational processes presented in rows.

 For more details on managing RACI, see Process responsibilities.

Parameter Parameter type Constraints

Object Organizational 
Process

One object mandatory.
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Report parameters

Organizational Process RACI Matrix (BPMN)
This report is a matrix presenting the RACI value of org-units presented in columns
related to organizational processes presented in rows.

 For more details on managing RACI, see Process responsibilities.

 To generate a matrix to search for organizational processes and 
operations in depth, you must use report Organizational Process and 
sub-processes RACI Matrix (BPMN).

To generate A RACI matrix from the Reports navigation pane: 
1. Select Other Reports then the Reports tile.
2. In the My Reports tab, click New.

The report creation dialog box opens.
3. In the list of report templates, select “Business Process RACI Matrix 

(BPMN)”, then click Next.

Parameter Parameter type Constraints

Org-unit (in 
columns)

Org Unit At least one object mandatory.

Process (in 
rows)

Organizational process or 
operation

At least one object mandatory.
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4. Then select the organizational process that interests you.
You obtain a result like this:

Cells of this matrix are filled with a letter representing responsibility of the org-unit
in the process (or operation):

• (A) for Accountable
• (R) for Responsible
• (R/A) for Responsible/Accountable
• (C) for Consulted
• (I) for Informed

This value can be automatically proposed when a participant assigned to the org-
unit executes the operation or organizational process. It can be modified or
confirmed by the user.
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If you click button , the context of the responsibility of the org-unit is indicated.
You can view: 

• the name of the participant to which the org-unit is assigned
• the name of the process that is owner of the participant

Report parameters

Organizational Process and sub-processes RACI Matrix (BPMN)
Like report Organizational Process RACI Matrix (BPMN), this report describes a
matrix presenting the RACI value of org-units presented in columns related to
operations and/or organizational processes presented in rows.

 For more details on managing RACI, see Process responsibilities.

The second parameter of this report indicates the number N of the depth level of
search for sub-processes. If this number is not indicated, it takes into account the
entire sub-process hierarchy.

The report searches for all sub-processes of the process given as parameter to N
levels and adds this process. It presents in columns the org-units found, and in rows
the organizational processes associated with these org-units, with the RACI value in
the cell.

Parameter Parameter type Constraints

Process (in 
rows)

Organizational process or 
operation

At least one object mandatory.
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Process Impact Graph
This report is a dendrogram. It displays the link between an organizational process
and different object types.  

 See Handling a Dendrogram for further information. 

Access path 

Property page of the organizational process > Reporting > Process Description >
Process Impact Graph. 

Object types

Prerequisites to linking a project to a process

You need to use HOPEX Project Portfolio Management.

To display the link between an organizational process and a project:
 Fill the organizational process in the section Project Deliverables. 

 For further details, see Project deliverables.

Prerequisites to linking a concept to a process

You need to use HOPEX Information Architecture.

To display the link between an organizational process and a concept:
1. In the diagram toolbar, click Data Object.
2. In the Creation of Data Object window, select a Content.
3. Access the property page of the content and expand the Business 

Information Used section. 

Object type For further details

Value chain See Representing the value stream fulfillment with HOPEX Business 
Process Analysis.

Business capa-
bility

See Describing Fulfillment of a Business Capability.

Catégorie de 
processus

See Managing Business processes.

Customer jour-
ney 

See Creating an involved resource in a customer journey.

Project See Prerequisites to linking a project to a process.

Risk See Creating risks.

Concept See Prerequisites to linking a concept to a process.

Application See Creating a System Used in an organizational process diagram.

Participant See Creating a Participant.
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4. Click New. 
5. In the Add Concept window, select an existing concept or create a new 

one.  
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BUSINESS AND IT RESSOURCES

This paragraph presents the list of reports relating to functional and technical
aspects.

• Support of Processes by Applications Table (Statistics).

Support of Processes by Applications Table (Statistics)
This report describes which business applications support business or organizational
processes.

An organizational process is considered as supported by an application if this
process or one of its sub-processes or one of their operations is connected to this
application or to one of its sub-applications or to one of their application services.

A business process is considered as supported by an application if this business
process or one of its sub-processes or one of their organizational processes (or sub-
processes) or one of their operations is connected to this application or to one of its
sub-applications or to one of their application services.

In a report of this type, applications are broken down into several categories: 
• A process can be supported by zero (Orphan), one (Unique) or several 

(Mule) applications.
• An application can support zero (Gap), one (Supported) or several 

(Pivot) processes.
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The number of components of each category is presented: 
• as stacked bars.
• as pie charts.

Report parameters

Parameter Parameter type Constraints

Processes Business
processes

At least one object mandatory.

Application Application At least one object mandatory.
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PROCESS DEPLOYMENT

This paragraph presents the list of reports about deployment of processes.
• Contextualization Matrix (BPMN).
• APQC Value Chain Analysis;

Contextualization Matrix (BPMN)
This report enables identification of contextualizations representing the
implementation of organizational processes (specified as parameters and presented
in rows) between functional processes (presented in columns).

When an organizational process is the implementation of a functional process in a
particular context, this is displayed in the cell.

If a contextualization exists between a functional process and an organizational
process, it is presented in the corresponding cell.

 For more details on the use of contextualizations, see the  guide 
HOPEX Business Process Analysis, "Defining Contextualizations" 
chapter. 
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Report parameters

APQC Value Chain Analysis
You can use the APQC - Process - DataSet Definition report DataSet to display
the structure of the valuye chains imported in in APQC libraries.

 For more détails on APQC elements import, see Prerequisites to 
using APQC libraries.

Parameter Parameter type Constraints

Organizational 
Process

Organizational 
Process

At least one process mandatory.

Functional process Functional process 
Activity
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Report parameters

Parameter Parameter type Constraints

List of Value 
chains

Value chain Mandatory to access to instant 
reports:
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PROCESS ASSESSMENT

This paragraph presents the list of reports dedicated to Process Assessment.
• Execution and Performance Heatmap report,
• Execution and Performance Heatmap report.

Execution and Performance Heatmap report
This report presents, in the form of a matrix, the assessment results of processes. 

 For more details on process assessment, see Assessments With 
HOPEX Business Process Analysis.

Assessed criteria
These characteristics relate to attribute values linked to process performance and
execution.

List of characteristics linked to process performance:
• Business Value: characterizes business value of the object.
• Effectiveness: characterizes effectiveness of object operation
• Risk: characterizes risks concerning the object.
• Performance: this characteristic is a global assessment of process 

performance. It is calculated from assessment of process business 
value, effectiveness and risk.

List of characteristics linked to process execution:
• Specification: assessment of quality of description of the object in 

the repository.
• Knowledge: assessment of knowledge of the object by stakeholders.
• Support: assessment of application support of the object.
• Execution: this characteristic is a global assessment of object 

execution. It is calculated from assessment of object specification, 
knowledge and support.

The results of this report can have two origins: 
• the values of attributes linked to the characteristics assessed on objects 

directly specified as "expert view" by the user
 For more details, see Expert view assessment.

• the questionnaires results aggregation that enable to get a value for 
each attribute connected to assessed characteristics of each object 
((Performance, Execution, for example).

 For more details, see Assessment by questionnaire.
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Report presentation
This report is broken down into three parts:

• The first part details the performance assessment heatmaps.

• The second part details the execution assessment heatmap.
 The values used for these reports can be obtained in different ways. 
For more details, see Expert view assessment and Assessment by 
questionnaire.

• The final part presents geographical distribution of org-units on sites.

Report parameters

Expert view assessment
In the properties of an organizational process or a business process, the
Assessment tab allows an expert user to specify values of attributes linked to
assessed characteristics.

 The values used for such reports are obtained from the process 
Assessment property pages. For more details, see Assessing a process 
with HOPEX Business Process Analysis.

Parameter Parameter type Constraints

Object Business
processes
Organizational 
Process

At least one object mandatory.
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Assessment by questionnaire
Assessment is carried out using assessment questionnaires. Assessment
questionnaires are sent to the appropriate addressees using customizable
deployment modes. Results are then aggregates according to predefined rules to
present results so they can be used.

Questionnaires

Questionnaires relate to characteristics to be assessed for all processes determined
as objects of assessment. 

Execution and Performance Heatmap (with contexts)
Like Execution and Performance Heatmap, this  report presents, in the form of
a matrix, the assessment results of processes in the context of entities and
processes. 

 For more details on this report, see Execution and Performance 
Heatmap report.
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APPENDIX - HOPEX BUSINESS PROCESS 
ANALYSIS WORKFLOW

This chapter presents the HOPEX Business Process Analysis workflow.

 HOPEX Business Process Analysis Review Workflow
 Organizational Process review workflow
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 HOPEX BUSINESS PROCESS ANALYSIS REVIEW 
WORKFLOW

 For more details on workflows, see chapter "Using Workflows" in 
the HOPEX Common Features guide.

Roles on Objects

Object owners
The Owner is responsible for the following tasks:

• Risk identification
• Replying to questionnaires, 
• Defining and implementing action plans,
• Validating modifications made by the Business Architect in the context 

of object review workflows.
Owners exist for:

• Capabilities
• organizational processes
• value stream
• business processes
• Organizational units

 To specify the owner of a process for example, open the properties 
of the process, select the Characteristics tab and complete the Owner 
field.

Business architect
The business architect is the main user of the solution. Intervenes on the process
architecture at each project phase. 

Activating process review workflows
Depending on the status of the workflow associated with the object, the object
appears in the desktop of the user who must intervene to modify or validate it.

Commands enabling activation of the different steps of a workflow can be accessed
from the Collaboration > My workflows button:

1. Select the My active workflows tab.
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HOPEX Business Process Analysis Review Workflow

2. Click on the object that interests you to display its pop-up menu.
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 ORGANIZATIONAL PROCESS REVIEW WORKFLOW

Review workflow steps
The steps in the organizational process review process are described by the diagram
below.
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Organizational Process review workflow

Organizational Process Review Workflow Mails

Submit review request

Request modification

Notify validation

From Business architect

To Organizational process owner

Subject Organizational process to be validated - [Organizational process name]

Content Sir, Madam,
Please validate organizational process: [Organizational process name]
To access the application and execute this task, [click here]   
Comment: [Comment]

From Organizational process owner

To Business architect

Subject Organizational process to be reviewed - [Organizational process name]

Content Sir, Madam,
Please review organizational process: [Organizational process name]
Comment: [Comment]

From Organizational process owner

To Business architect

Subject Organizational process validated - [Organizational process name]

Content Sir, Madam,
This organizational process has been validated: [Organizational process name] 
Comment: [Comment]
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